NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously ensure a secure connection between the product and the system network and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs, and so on, to protect the system, its products and networks, against security breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately responsible to ensure that any system update (including but not limited to code changes, configuration file changes, third-party software updates or patches, hardware change out, and so on) is compatible with the security measures implemented. The system/product owners must verify that the system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2016 by ABB.
All rights reserved.

Release: September 2016
Document number: 3BSE030322-600 C
Table of Contents

About This User Manual
User Manual Conventions ........................................................................................................9
Warning, Caution, Information, and Tip Icons .........................................................................9
Terminology ..................................................................................................................................10
Released User Manuals and Release Notes .............................................................................10

Section 1 - Introduction and Workflow
The Operator Workplace ..............................................................................................................13
Create and Configure an Operator Workplace ........................................................................15
   Settings ..............................................................................................................................17
   Workplace Shortcut on Desktop ........................................................................................21
   Autostart of Workplace ......................................................................................................22
   Autostart of Default Workplace .......................................................................................22
   Configuring Workplace Mode ..........................................................................................24

Section 2 - Workplace Configuration
Workplace Layout .....................................................................................................................27
   Application Bar .................................................................................................................30
   Status Bar .........................................................................................................................35
   Combined Toolbar ..........................................................................................................35
   Panels ...............................................................................................................................42
   Configure the Default Startup Display ...........................................................................43
   Configure Shortcuts to Displays ......................................................................................45
Multiple Screens .....................................................................................................................55
   Large Workplace .............................................................................................................64
View Class Configuration .......................................................................................................67
### Table of Contents

- Configuring Workplaces .................................................................................................. 80
- Configuration of Safe Areas .......................................................................................... 81
- Extended Operator Workplace ........................................................................................ 83
  - Display Ratio and Resolutions .................................................................................. 84
  - Basic Node Setup ...................................................................................................... 84
  - EOW System Extension ............................................................................................. 85
  - Adding EOW Nodes .................................................................................................. 85
  - Workplace Configuration .......................................................................................... 87
- Window Handling ........................................................................................................... 92
  - View Class Values .................................................................................................... 97
  - Group Display ......................................................................................................... 103
  - Quad Display .......................................................................................................... 106
- Tabbed Workplace .......................................................................................................... 112
  - Tabbed Workplace Concepts .................................................................................. 114
  - Configuring Tabbed Workplace ............................................................................... 118
  - Resources ................................................................................................................ 127
  - Using Hotkeys in Tabbed Workplace ........................................................................ 127
- Favorites ........................................................................................................................ 131
  - Adding a Favorite ..................................................................................................... 131
- Hot Keys ........................................................................................................................ 132
  - How to use the Hot Keys Aspect .............................................................................. 132
- Configuring Color Settings with Logical Colors ............................................................. 138
- Configuring Context Menu ............................................................................................ 142
  - Configuring Aspect Filters ...................................................................................... 152
  - Submenu Configuration ............................................................................................ 154
- Workplace Settings Profile Configuration ...................................................................... 158
- Workplace Settings Icon Configuration ......................................................................... 160
- User Profile Configuration ............................................................................................ 165
  - Settings in the Profile Values Dialog Box ................................................................. 165
- Configuring User Access to Structures .......................................................................... 170
- Import/Export of Workplace .......................................................................................... 172

### Section 3 - Alarm and Event
Table of Contents

Configuration..........................................................................................................................173
  Changing the Presentation of an Alarm and Event List ..............................................175
  Configuring Alarm Response Navigation .................................................................189

Section 4 - Trend
  Trend Template..............................................................................................................198
  Trend Display..............................................................................................................201
  XY-Plot ......................................................................................................................206
  Trend Configuration Details......................................................................................208
  Trend Display Configuration Details ......................................................................225

Section 5 - Creating Reports
  Report Building Applications ..................................................................................229
  Example Reports .......................................................................................................231
  Basic Steps for Building and Executing a Report .......................................................235

Section 6 - Process Graphics

Section 7 - Plant Explorer
  General User Interface..................................................................................................239
    The Plant Explorer Workplace Window .................................................................240
    Change User ...........................................................................................................241
    Structures ..............................................................................................................242
    Basic Navigation ....................................................................................................242
    Using the Context Menu .........................................................................................242
    Using Drag-and Drop ............................................................................................242
    Search Function .....................................................................................................243
    Working with Aspect Objects ...............................................................................243
    Working with Aspects ............................................................................................260
  Find Tool ..................................................................................................................270
    User Interface ........................................................................................................271
    Find Query Definition Area ...................................................................................271
    Find Attribute Item .................................................................................................273
Table of Contents

Search Tasks Area...........................................................................................................274
Result List .....................................................................................................................283
Quick Find Tool ...........................................................................................................288

Appendix A - Property Translation Aspect
Property Translations Aspect ..........................................................................................292
Property Translation Extended Aspect ...........................................................................294

Appendix B - Alarm and Event List Attributes

Appendix C - Toolbar in the Workplace

Revision History

Index
About This User Manual

Any security measures described in this User Manual, for example, for user access, password security, network security, firewalls, virus protection, etc., represent possible steps that a user of an 800xA System may want to consider based on a risk assessment for a particular application and installation. This risk assessment, as well as the proper implementation, configuration, installation, operation, administration, and maintenance of all relevant security related equipment, software, and procedures, are the responsibility of the user of the 800xA System.

The System 800xA is used for monitoring and controlling a process plant. This user manual describes the configuration of an Operator Workplace.

Information in this user manual is intended for the operators of a process plant.

User Manual Conventions

Microsoft Windows conventions are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, etc.

Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

Electrical warning icon indicates the presence of a hazard that could result in electrical shock.
Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

**Terminology**

A complete and comprehensive list of terms is included in *System 800xA System Guide Functional Description (3BSE038018*)*. The listing includes terms and definitions that apply to the 800xA System where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely apply to this User Manual are listed in the following table.

**Released User Manuals and Release Notes**

A complete list of all User Manuals and Release Notes applicable to System 800xA is provided in *System 800xA Released User Manuals and Release Notes (3BUA000263*)*.

*System 800xA Released User Manuals and Release Notes (3BUA000263*)* is updated each time a document is updated or a new document is released. It is in pdf format and is provided in the following ways:
• Included on the documentation media provided with the system and published to ABB SolutionsBank when released as part of a major or minor release, Service Pack, Feature Pack, or System Revision.

• Published to ABB SolutionsBank when a User Manual or Release Note is updated in between any of the release cycles listed in the first bullet.

A product bulletin is published each time System 800xA Released User Manuals and Release Notes (3BUA000263*) is updated and published to ABB SolutionsBank.
Section 1  Introduction and Workflow

The 800xA System includes different predefined workplaces such as Operator Workplace, Plant Explorer Workplace, Two Screen Plant Explorer Workplace, and so on.

The Operator Workplaces are intended for operators and the Plant Explorer Workplaces are intended for application engineers.

The Operator Workplace

The Operator Workplace screen is divided into four main parts (see Figure 1):

- Application Bar - contains the information that must be visible at all time, and it provides a fast and easy way to switch between information areas.

- Display Bar - used for controlling and identifying the contents of the Display Area.

- Display Area - used for presenting information such as process displays, trend displays and alarm lists.

- The Status Bar - shows information about operator messages and currently logged in user.
Before You Start

Consider the following before configuring the workplace.

- Using the monitor(s).
- Appearance of Application Bar, Status Bar and Panel.
- Displays to be listed in shortcuts.
- Tools available in the toolbar.
- Using the color settings.
- Number of large graphic displays to be used.
- Appearance of alarm and event lists.
Create and Configure an Operator Workplace

To create new Operator Workplace follow the steps below:

1. Launch Plant Explorer Workplace.
2. Expand the Workplace Structure.
3. Add a new aspect object under Web System Workplace.
4. In the New Object dialog box (see Figure 2), type a name and a description for your new Operator Workplace (of the type Plant Workplace) and click Create.
The new Operator Workplace will include the aspects shown in Figure 3.
Section 1  Introduction and Workflow

5. You can change the configuration settings for your new Operator Workplace, see Settings on page 17.

Settings

At a minimum you should configure your new Operator Workplace according to the steps in Minimum Settings on page 17. If you want to make extended configuration settings to your Operator Workplace follow the steps in Extended Settings on page 18.

Minimum Settings

The following are the minimum settings to be configured for an Operator Workplace:

1. Modify the Workplace layout (see Workplace Layout on page 27).
2. Add an Application Bar.
3. Add a Status Bar.
4. Modify the Logical Colors if you want other colors than the ones specified for the system in the Web System Workplace.

An easy way of creating an Application Bar and a Status Bar is to copy the default Application Bar and Status Bar from the default Operator Workplace to the new Operator Workplace. To do this, follow the steps below:

1) Copy the Status bar aspect and the Application bar aspect from the default Operator Workplace to the new Operator Workplace object.

2) In the new Operator Workplace object, right-click the Workplace Layout aspect and select Config View.

3) Configure the Application bar aspect and Status bar aspect to the Top Band and Bottom Band items of the screen layout. For more information, refer to Workplace Layout on page 27.

**Extended Settings**

1. Add an Application Bar and a Status Bar. Think about the height of the bars, so the graphic displays will fit in between.

![Application Bar](image1)

*Figure 4. Application Bar*

![Status Bar](image2)

*Figure 5. Status Bar*

For detailed description see Application Bar on page 30, Configure the Default Startup Display on page 43 and Status Bar on page 35.
2. Add required tools and displays. The toolbar’s size is limited, so if you add too many tools, all of them might not be visible. Application shortcuts will also be located on the same row as the tools. Favorites on the other hand, can be placed on a new row in the bar. An example of a toolbar in an Operator Workplace is displayed in Figure 6. See also the section Application Bar on page 30.

![Operator Workplace Toolbar](image)

**Figure 6. Operator Workplace Toolbar**

<table>
<thead>
<tr>
<th>Legend</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Find</td>
</tr>
<tr>
<td>2</td>
<td>All Process Alarms</td>
</tr>
<tr>
<td>3</td>
<td>All Process Events</td>
</tr>
<tr>
<td>4</td>
<td>System Alarms</td>
</tr>
<tr>
<td>5</td>
<td>System Event List</td>
</tr>
<tr>
<td>6</td>
<td>System Status</td>
</tr>
<tr>
<td>7</td>
<td>External Alarm Silence</td>
</tr>
<tr>
<td>8</td>
<td>Replacement Strategy Tool</td>
</tr>
<tr>
<td>9</td>
<td>Toggle Browser</td>
</tr>
<tr>
<td>10</td>
<td>Aspect Menu (Favorites)</td>
</tr>
<tr>
<td>11</td>
<td>Print Screen</td>
</tr>
<tr>
<td>12</td>
<td>Close All Overlaps</td>
</tr>
<tr>
<td>13</td>
<td>Show Help</td>
</tr>
</tbody>
</table>
3. Select panel, see Panels on page 42.

4. Create a test graphic display in the respective object in Functional Structure. For more information on building graphic displays, refer to System 800xA Engineering, Process Graphics (3BSE049230*).

5. Add alarm aspects if the default ones are not sufficient.


7. Add appropriate Display shortcuts and Application Bar shortcuts. See Shortcuts in the Application Bar on page 45 and Shortcuts in the Display Bar on page 47.

8. Add favorites and hot keys. See Favorites on page 131 and How to use the Hot Keys Aspect on page 132.

9. Configure the context menu by adding submenus, default aspects and filters. See Configuring Context Menu on page 142.

10. Add your own color settings, for example change the background color. See Configuring Color Settings with Logical Colors on page 138.

11. Add users and configure the profiles according to User Profile Configuration on page 165.

12. When you are ready with your configuration, set up:
   - Default Start-up Workplace (see Workplace Shortcut on Desktop on page 21).
   - Autostart of Workplace (see Autostart of Workplace on page 22).
   - Startup Display (see Configure the Default Startup Display on page 43).
   - Workplace Mode (see Configuring Workplace Mode on page 24).
Workplace Shortcut on Desktop

It is possible to create a desktop shortcut to a specific workplace for easy access. Select **Workplace** from the **ABB Start Menu**. This opens the **ABB Workplace Login** dialog as shown in **Figure 7**.

For information on accessing the ABB Start Menu, refer to **System 800xA Tools (2PAA101888*)**.

![Figure 7. ABB Workplace Login Window](image)

You can open two or more instances of the **ABB Workplace Login** dialog by executing one of the following in the **ABB Start Menu**:

1. Right-click **Workplace** and click **Open new window**.
2. Middle-click **Workplace**.
3. Press <Shift> and click **Workplace**.

In **Available workplaces**, select the required workplace from the available list. Click **Create Desktop Shortcut** to create a shortcut on the desktop for the selected workplace.
Double-click the shortcut to open the selected workplace.

Select a workplace in the ABB Workplace Login dialog and click Open to open the selected workplace.

**Autostart of Workplace**

To enable autostart of the selected workplace:

1. Go to ABB Start Menu > ABB Industrial IT 800xA > System > Workplace.
2. Right click on Workplace and select “Run as administrator”
3. Select the workplace from the Available workplaces list
4. Click Set as autostart as shown in Figure 7

**Autostart of Default Workplace**

To launch the default workplace that was configured using the Workplace Profile Values aspect in the User Structure, follow the procedure below:

For information on setting Default Workplace in WorkplaceProfileValues, refer to “Configure the Operator Workplace” in System 800xA Administration and Security (3BSE037410*)
1. Right-click on the desktop and select **New > Shortcut**.

![New Shortcut Selection](image)

**Figure 8. New Shortcut Selection**

2. In the Create Shortcut dialog box, enter the following and click **Next**:

   AfwWorkplaceApplication{space}-{no space}DefaultWorkplace or AfwWorkplaceApplication{space}-{no space}DW.

   AfwWorkplaceApplication{space}-{nospace} DW{space}-{nospace}WS{space}-{nospace}S=SystemID or AfwWorkplaceApplication{space}- {nospace}WS{space}-{nospace}S=SystemID.

   Using flags -DW (default workplace) with -WS (wait for system) or only -WS, always use -S (system) flag.

   For example, AfwWorkplaceApplication.exe -S = "{8F156F76-4810-4095-AACA-F7FA44CA3075}" -DW -WS.
3. Place the shortcut in the all users startup folder.

Now the default workplace will be launched upon user login.

**Configuring Workplace Mode**

The User Profile values are set on the Workplace Profile Values aspect for each user in the User Structure.

There are two Workplace Modes available:

- **Windows Workplace Mode**
  
  In Windows Workplace Mode means the application runs as normal Windows applications. This mode is suitable for all users of the System.

  If you are using your workplace in Windows Mode, the Full Screen Toolbar check box must be selected in the Tool Collections tab, see Application Bar on page 30.
• Operator Workplace Mode

The Operator Workplace Mode is a full screen mode and the title bar is not visible. Overlap windows are always placed on top. The Application Bar and the Status Bar cannot be covered by a overlap window.

In Windows Client Operating System, the Charms bar appears when the mouse pointer is moved either to the top-right corner or bottom-right corner of the screen. The Charms bar provides quick access to the following five Charms: Search, Share, Start Screen, Devices and Settings.

In Operator Workplace mode, the Workplace application hides the visibility of the Charms bar. However, there can be situations where the workplace application has limited control over a presented window causing the Charms bar to appear again. The Charms bar reappears for the following conditions where the Charms bar would reappear:

- Online help window
- A CLS License related popup messages
- Excel / Word / PDF opened from FileViewer.

In order to protect the underlying Operating System file system and features it is important that the right level of Windows access control is configured via Windows Security Policies for the logged in user.

It is highly recommended to set auto hide on the taskbar in the Operator Mode.

It is highly recommended not to select Keep the taskbar on top of other windows option.

To configure Workplace Mode for a user:

1. Select the user object in the User Structure and select the Workplace Profile Values.
2. Select **Local** in the **Datasource** area and choose one of the Workplace Modes in the drop-down list. See **Figure 10**. Click **Apply**.

**Figure 10. Workplace Mode**
Section 2  Workplace Configuration

This is a reference section where the configuration steps in Section 1, Introduction and Workflow are described in detail.

Workplace Layout

To select an Application Bar, Status Bar, Combined Toolbar, and a Panel for a Workplace, you need to modify the Workplace object. Follow the steps below:

1. Select the Workplace Structure.
2. Click on the Workplace object you want to customize.
3. Select the Workplace Layout aspect. The Workplace Layout dialog box in Figure 11 will appear.
4. Select the required layout by selecting the Enabled check box corresponding to required Item. Select Yes in the Visible drop-down menu if you want the item to be visible.

5. Click the ... button in the Aspect field to bring up the Aspect Selection dialog box.

Select the Large Workplace check box if you only want one configuration, stretching over several screens. The Number of Screens options will then be disabled. One configuration is valid for each screen and up to four screens are supported. The Large Workplace check box will be disabled if the number of screens are more than one.

In the Replacement Strategy drop-down menu you can select Replace or Preserve to be the startup value for the workplace.
The Replacement Strategy can be configured for each user through User Structure > Current User > Workplace Profile Values > Replacement Strategy.

To change the configuration of Replacement Strategy, select Local and then modify the value to Preserve. Click Apply to save the changes.

The value in the Workplace Profile when set, will override the value selected in Replacement Strategy in Workplace Layout.

In the Selection Strategy drop-down menu (Figure 12) you select what action the workplace should perform when the selection is set on the workplace.

Figure 12. The Selection Strategy drop-down menu
If **Perform default action** or **Update target and default action** is selected, and the selection is an object, the default aspect will be shown. If the selection is an aspect, the default aspect view will be shown or the default verb will be executed.

How to create and configure the Application and Status Bar, is described in the following sections. Selection of Panel is described in **Panels** on page 42.

### Application Bar

To configure the Application Bar from the Workplace Layout aspect, see Figure 11:

- Select the **Enabled** check box belonging to the **Top Band** item.
- Select **Yes** in the **Visible** drop-down menu to make the Application Bar visible.
- Click the **... button** in the **Aspect** field and select the Application Bar aspect in the dialog box.
- Click **Apply**.

An Application Bar aspect is placed on the Workplace object. To modify the Application Bar layout, open the configuration view of the Application Bar aspect, (see Figure 13).

If you modify an existing Application Bar, all workplaces that use this Application Bar will be affected by the changes.

The Workplace has to be restarted for any changes in the Application Bar to take place.

You have now opened the configuration dialog box for the Application Bar (see Figure 13), and can customize it.

The dialog box has three tabs which are described below.
**Main Tab:**

The **Main** tab has four settings, see Figure 13.

![Figure 13. Application Bar - Main Tab](image)

If the check box is selected, the item will appear in the Application Bar. If not, it is hidden.

Select the **On new row** check boxes if you want the selected setting to be displayed on a new row in the Application Bar.

**Fixed Displays Tab:**

In the **Height in pixels** box type the height that you want the Fixed Displays to have. The default value is 80 pixels.

There are no default Fixed Displays defined at start. Under this tab you can select which Fixed Displays you want to add to the Application Bar, see **Figure 14.**
Each Fixed Display is identified by its Object Name, Aspect Name and Display Width, expressed in % of the total width of the Workplace window.

Figure 14. The Application Bar - Fixed Displays Tab

To add a Fixed Display, click Add and select the aspect you want to show as a Fixed Display. Type the width of the Fixed Display in the Display width in percent box.

Figure 15. Add/Edit Fixed Display Dialog Box
Section 2  Workplace Configuration  Application Bar

The sum of percentage of all Fixed Displays must not exceed 100%. The configuration tool will automatically calculate the highest value allowed if you try to exceed this.

To edit a Fixed Display, select the display and click Edit. See Figure 14.

**Tool Collections Tab:**

Under the **Tool Collections** tab, shown in Figure 16, you can select which toolbars you want to appear in the Application Bar.

---

![Figure 16. The Tool Collections Tab](image-url)
If you are using your workplace in Windows Mode, the Full Screen Toolbar check box must be selected in the Tool Collections tab.

Do not use the Toggle Navigation Toolbar (Old). Instead, use Toggle Browser Toolbar for the same functionality.

If the New collections default included check box is selected, new created Tool Collection’s will be checked by default in the Included list and shown in the Application Bar.

**Configure the Workplace Clock Tool and Workplace Date & Time Tool**

It is possible to add and configure a Clock Tool in the Fixed Displays area of the Application Bar. The clock shows the current date and time in a specific format. Default date and time format is default user locale.

To configure the Clock Tools follow the steps below:

1. In the Library Structure select **Tools > ScreenBar Tools**.
2. Select the Workplace Clock Tool aspect or the Workplace Date & Time Tool and open the configuration view.
3. Click **Properties** to configure the tool.

![Properties](image)

*Figure 17. Properties*

**Status Bar**

The Status Bar selected in **Workplace Layout** on page 27, will appear at the bottom of the workplace. The Status Bar aspect is placed on the Workplace object.

It is possible to reconfigure the Status Bar in the same way as the Application Bar.

To modify the layout of the existing Status Bar, select the Status Bar aspect and its configuration view.

If you modify an existing Status Bar, all workplaces that use this Status Bar will be affected by the changes.

The configured Workplace has to be restarted for any changes in the Status Bar to take place.

**Combined Toolbar**

The Combined toolbar is a collection of tools from the Display bar, the Application bar, and the Status bar. This toolbar appears at the top of the workplace.

This toolbar provides:

- More workplace area for the operator.
- One toolbar for the required tools.
To customize the toolbar, follow the steps:

1. Select the workplace from **Workplace Structure > Web System Workplace, System Workplace**.

2. Right-click the **Application Bar** aspect and select **Config View** from the context menu.

3. Ensure **Show Fixed Displays** check box is selected and the other options are cleared. This step retains Alarm Band, Alarm line, System Alarm band, and Workplace Date & Time tool and to avoid other toolbars in the workplace.

4. Click **Apply** and close the Config View.

5. Create or select an existing **Standard Workplace Frame** object from the **Library Structure > Workplace Frames**.

*Figure 18. Application Bar - Fixed Displays*
6. Create an aspect of **Tool Collection** category in the web frame object, for example, Demo Tool aspect.

7. Right-click the **Demo Tool** aspect and select **Config View** from the context menu.

8. Click to add the required tools available in the **Library Structure > Tools**. See Figure 19.

![Tool Collection](image)

**Figure 19. Collection of tools**

Refer to Figure 20 to view the list of **Combined Appbar** tools under the **Library Structure > Tools > Combined Appbar Tools** object.

Refer to Adding Additional Tools to the Display Bar on page 52 for more information on managing tools.
9. Click **Apply** and close the Config View.

10. Right-click the **Web Frame Category** aspect from the **Standard Workplace Frame** object (see Step 5) and select **Config View** from the context menu.
11. Select **Demo Tools** and click **Add**.

![Demo Tools added to the Web Frame Category aspect](image)

*Figure 21. Demo Tools added to the Web Frame Category aspect*

12. Click **Apply** and close the Config View.

13. Select the workplace panel, configured in the workplace layout (for example, GraphicPanelLayout aspect), from the **Library Structure > Workplace Panels**.
14. Right-click the selected panel layout aspect, for example GraphicPanelLayout aspect, and select Config View from the context menu.

15. Add the Frame attribute to refer to the configured web frame object. See Figure 22.

Enter the values in the format, Frame="{ObjectID}:{AspectID}".

For example:
Frame="{E5FB9B98-CFDE-11D3-9EE2-0008C7DF859A}:{E99BA457-0580-11D4-95CA-0008C7DF852A}"

Where,
E5FB9B98-CFDE-11D3-9EE2-0008C7DF859A is the Standard Workplace Frame object ID.
E99BA457-0580-11D4-95CA-0008C7DF852A is the Web Frame Category aspect ID.

Figure 22. GraphicPanelLayout aspect
16. Click **Apply** and close the Config View.

17. Launch the workplace to view the Combined Toolbar. See **Figure 23**.

---

**Figure 23. Operator Workplace with Combined Toolbar**

---

**Panels**

You can select panel to your workplace in the Workplace Layout aspect, see [Workplace Layout on page 27](#) and **Figure 11**. Existing panels are located in the
Library Structure and are displayed in Figure 24.

Figure 24. Workplace Panels

To select Panel, do as follows:

1. Follow step 1-5 in Workplace Layout on page 27.
2. Expand the Library Structure and select the Workplace Panels object.
3. Select Standard Workplace Panel object and the Panel Layout aspects. The StartupDisplayPanelLayout aspect shows the Startup Display aspect available in the workplace object. See also Configure the Default Startup Display on page 43. As panel it is possible to use a Group Display aspect.

Configure the Default Startup Display

The Operator Workplace has a default Startup Display. It is possible to change the startup display for the workplace or for a specific user. How to do this is described below.

It is recommended to use a Graphic Display as Startup Display.
Configure the Default Startup Display

There are two ways to specify a startup display for a workplace:

- Add the aspect you want to use as startup display to the Workplace object in the Workplace Structure. Change the name of the aspect to “Startup Display”. If you already have an aspect named Startup Display, you must delete or rename it. Start the workplace to verify the changes.

- Open the StartupDisplayPanelLayout aspect from Library Structure > Workplace Panels > Operator Workplace Panel (see Figure 24). Type the path to the display that the workplace should start-up with (see Figure 25 for an example). Start the workplace to verify the changes.

If you are using multiple screens you can configure different startup displays for the different screens. See Multiple Screens on page 55.

The Startup Display aspect is not supported by NLS.
Figure 25. Panel Aspect - Path to the Startup Display

All pane names in a workplace should be unique because some applications depend on unique names. The pane names should be unique in all screens throughout the workplace.

The pane names should be prefixed with 'Base'.
For example, if the pane on screen 1 is called "Base1" the pane on screen 2 should have another name for example "Base2".
Changing the Startup Display for a User

Follow the steps below to change the Startup Display for a user:

1. Expand the User Structure.
2. Select the user you want to define a startup display for.
3. Select the Workplace Profile Values aspect and the property Workplace Start Object in the Names list.
4. Set Datasource to Local.
5. Click Browse and select the object you want to have as startup object.
   The name of the selected object is presented in the ObjectName field. The default aspect will be displayed. Give the object a default aspect, which preferably is a graphic display.
6. Click Apply.
7. Start the workplace logged in as the specific user to verify the changes.

Note that the Workplace Start Object has the highest priority, which means that possible Startup Display aspects will be ignored.

Configure Shortcuts to Displays

Shortcuts can be configured in:

- Application Bar (see Shortcuts in the Application Bar on page 45)
- Display Bar (see Shortcuts in the Display Bar on page 47)
- Graphic Displays (see System 800xA Engineering Process Graphics (3BSE049230*)).

Shortcuts in the Application Bar

A shortcut in the Application Bar is created to get fast access to any viewable aspect associated with a particular object. When you have added a shortcut to a workplace, it will be displayed as a button with a drop-down menu. It will appear on the left-hand side in the Application Bar the next time you open the Workplace window.

To create a shortcut, follow the steps below:
1. Create an **Application Bar Shortcuts** aspect on the Workplace object.
2. Open the configuration view and click **Add**. See **Figure 26**.

![Figure 26. Dialog Box for Edit of Application Bar Shortcut](image)

3. Select structure, object and aspect in the Add/Edit Display Shortcut dialog box, see **Figure 27**. Click **OK**. The shortcut is now added to the shortcut list.

![Figure 27. Application Bar Shortcuts Dialog Box](image)
4. Click **Apply** and the shortcut is created the next time you start up the Workplace.

![Graphic Display - Overview](image)

*Figure 28. Workplace Window with Application Bar Shortcuts*

Click **Edit** to edit a Shortcut through the configuration view of the aspect. By deleting its aspect you delete all shortcuts.

**Shortcuts in the Display Bar**

The Display Bar is connected to a specific Display. *Figure 29* shows an example of a Display Bar.
You customize the Display Bar by configuring the shortcuts.

**Creating Display Shortcuts in the Display Bar.** A Shortcut in the Display Bar is a shortcut button you can create to get fast access to any viewable aspect associated with a particular object and its descendents. The difference between a shortcut in the Application Bar and a shortcut in a Display Bar, is that shortcuts in the Application Bar are associated with the Workplace and are available at all times (no matter which Display you have selected), while shortcuts in a Display Bar are visible only when you have selected the Display that has that Display Bar.

By using shortcuts you can make displays related to, and of importance to, a certain display accessible by a simple click. This can be useful if you often look at a number of displays in sequence. Then you only have to click on the shortcut icon to go to the next display in the sequence.

To add a shortcut to the Display Bar, follow the steps below:

1. Add a Shortcut aspect to the object from which the aspects should be linked.
2. Open the configuration view for the aspect and click Add.
3. Select structure, object and aspect in the Add/Edit Display Shortcut dialog box, see Figure 30. Click OK, and the shortcut will be added to the Shortcut list.

![Add/Edit Display Shortcut Dialog Box](image)

Figure 30. Add/Edit Display Shortcut Dialog Box

4. A Display Shortcut will be displayed in the Display Bar, to the right of the other tools. See Figure 29.

**Edit/Delete a Display Shortcut in the Display Bar.** To edit or delete a Display Shortcut, follow the steps below:

1. Go to the Shortcut aspect you want to edit/delete, and double click on it.
2. The Display Bar Shortcuts dialog box opens.
3. Select the Display Shortcut you want to edit/delete.
4. Click **Delete** or **Edit**.
Display Shortcut Inheritance. Display shortcuts can be inherited in the Functional Structure. This means that an aspect object with the Structure Inheritance option set can “see” the defined Display Shortcuts of parent objects, up to the root or until finding a parent object for which the Structure Inheritance option is not set. If the Structure inheritance check box is selected (see Figure 31), the Display Shortcuts will be inherited.

By default the Structure Inheritance option is selected.

An aspect object with the Structure Inheritance check box cleared cannot “see” and inherit display shortcuts defined in any parent object.

The following example explains the purpose of inheritance.

In Figure 32, all objects “down” to the “A1 area” have the Structure Inheritance option set. This means that they inherit the Shortcuts defined in objects above.

The A2 Area object has two inherited shortcuts from the objects above. The Inherited Shortcuts tab (see Figure 32) displays the inherited shortcuts.
In Table 1 you can see the result of a small configuration example, using a structure similar to the one in Figure 32.

Table 1. Shortcut Inheritance Example

<table>
<thead>
<tr>
<th>Functional Structure</th>
<th>Structure Inheritance Option</th>
<th>Defined Shortcuts</th>
<th>Result (Inherited)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant, Site</td>
<td>Selected</td>
<td>A1, Alarm List</td>
<td>A1, Alarm List</td>
</tr>
<tr>
<td>A1, Area</td>
<td>Selected</td>
<td>MU1, Overview</td>
<td>A1, Alarm List MU1, Overview</td>
</tr>
<tr>
<td>MU1, Mixing Unit</td>
<td>Selected</td>
<td>M2, Motor</td>
<td>A1, Alarm List MU1, Overview</td>
</tr>
</tbody>
</table>

Figure 31. Structure Inheritance Option Example
Adding Additional Tools to the Display Bar

A set of additional tools are available to add in the Display Bar. Recommended tools to add are; the **Print Aspect View Tool** (prints the display area), the **Target Tool** (makes the display area main target for navigation) and the **Zoom Tool** (enlarges the display area). For more information about the tools, see *System 800xA Operations (3BSE036904)*.

To add a tool follow the steps below:

1. Go to the Library Structure and expand the Workplace Frames object.

### Table 1. Shortcut Inheritance Example (Continued)

<table>
<thead>
<tr>
<th>Functional Structure</th>
<th>Structure Inheritance Option</th>
<th>Defined Shortcuts</th>
<th>Result (Inherited)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M2, Motor</td>
<td>Cleared</td>
<td>AI137, Dialog</td>
<td>AI137, Dialog</td>
</tr>
<tr>
<td>AI137, AI</td>
<td>Selected</td>
<td>Plant, Overview</td>
<td>AI137, Dialog</td>
</tr>
</tbody>
</table>

*Plant, Overview*
2. Select the Standard Frame object and open the Config View of the Standard Tools aspect.

![Image of Standard Frame configuration](image)

Figure 32. The Standard Tools Aspect

Table 2. Tool Operation Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Add Tool Icon]</td>
<td>Adds a tool to the Standard Tools Aspect.</td>
</tr>
<tr>
<td>![Delete Tool Icon]</td>
<td>Deletes a tool from the Standard Tools Aspect.</td>
</tr>
<tr>
<td>![Replace Tool Icon]</td>
<td>Replaces the selected tool with another tool.</td>
</tr>
</tbody>
</table>
3. Click the Add Tool button and select Browse in the Tool Reference dialog box.

4. In the Select Aspect dialog box browse to the Library Structure and expand the Tools object.

5. Select the Display Bar Tools aspect and select the tool to add in the right-hand view. See Figure 33.

### Table 2. Tool Operation Buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Moves the selected tool one tool below in order.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Moves the selected tool one tool above in order.</td>
</tr>
</tbody>
</table>

**Figure 33. Add Display Bar Tools**
Using multiple screens means that applications can be moved from one monitor to another, or be displayed simultaneously on more than one monitor.

System 800xA provides a set of pre-configured Operator Workplaces using multiple screens.

To use multiple screens in System 800xA, a client should be equipped with additional hardware. The user must have graphic cards that support the number of monitors to be used. Each output on the graphic card is connected to one monitor. The 800xA System supports up to four monitors connected to one PC. Contact ABB for correct information about supported graphic cards.

In System 800xA, the monitors can be configured to behave as separate screens, called Multi-Screen Workplace, or as single screen expanding to all monitors, called Large Workplace.
The user can configure the monitors side-by-side, or in a row-column. Monitor 1 must always be located to the left (or top-left), and all monitors should have the same resolution. When using the row-column configuration the monitors must be placed in numeric order from top-left to bottom-right, see Figure 34.

**Multi-Screen Workplace**

Additional configuration is needed when using a Multi-Screen template (side-by-side or row-column configuration). To configure the Multi-Screen template:

1. Right click the Desktop and click on **Screen Resolution** to configure the physical layout of the monitors.

2. Click the drop-down list next to **Multiple Displays**; select **Extend desktop to this display** from the list and click **OK**.

   Repeat **Step 2** for all monitors except the Primary.

![Screen Resolution](image)

*Figure 34. Multi-Screen Example with Four Monitors Side-By-Side and Row-Column*
3. Configure the Alarm Line by opening the **Alarm and Event List Configuration** aspect (located in the **Library Structure** below the Wide Screen Configurations object) and make your settings. See Figure 35.

![Figure 35. Common Alarm Line Wide-Screens - Alarm and Event List Configuration](image)

4. The template provides one System Alarm Band aspect. If you want to have more than one System Alarm Band in your Workplace, add desired number of System Alarm Band aspects to your Multi Screen Workplace object in the Workplace Structure. See **System 800xA Configuration (3BDS011222*)** for more information regarding Alarm Bands.
5. To configure the Workplace Date & Time Tool aspect, see Configure the Workplace Clock Tool and Workplace Date & Time Tool on page 34.

6. Add the aspect links you want to have in your Fixed Display Navigation aspect. See System 800xA Engineering Process Graphics (3BSE049230*) on how to configure aspect links.

7. Configure the Operator Message Line by opening the Alarm and Event List Configuration aspect (located in the Library Structure below the Multi Screen Configurations object) and make your settings. See Figure 36.

Figure 36. Common Operator Message Line Wide-Screen - Alarm and Event List Configuration
8. The template provides predefined panels for the different multi-screen workplaces. These are located in the Library Structure below the Workplace Panels object. See Figure 37.

Figure 37. Workplace Panels in the Library Structure - Multi-Screen Workplace

In each Panel Layout aspect you can type the path to your Startup Display aspect. See Figure 38.

Figure 38. Panel Aspect - Multi-Screen Example
9. The four Application Bar aspects (located on your Multi Screen Workplace object) have a Fixed Display tab where you can decide which aspects should be visible in the Application Bar for each screen. The set of visible aspects can be set individually for each monitor by configuring the width.

![Application Bar Example for Operator Workplace 1x4 and 2x2 - Fixed Displays Tab](image)

*Figure 39. Application Bar Example for Operator Workplace 1x4 and 2x2 - Fixed Displays Tab*
10. Below the Tool Collections tab in the Application Bar aspect you select which tools to include in the Application Bar. It is not recommended to have all tools included in all four Application Bars, but the Close All Overlaps Toolbar should always be selected. See Figure 40.

Figure 40. Tool Collections Tab for Multi-Screen Operator Workplace 1x4
11. Open your Multi-Screen Workplace to see the result. An example of an Operator Workplace Four Screen 1x4 (side-by-side configuration) and is shown in Figure 41. An example of an Operator Workplace Four Screen 2x2 (row-column configuration) is shown in Figure 42.

**Figure 41. Operator Workplace Four Screen 1x4 Side-By-Side Configuration**

**Figure 42. Operator Workplace Four Screen 2x2 Row-column Configuration**
Configuration of multiple screens

The workplace determines the number of system monitors with respect to the X- and Y-position of the monitor. This enumeration starts from the top-left corner continuing along the X-axis and then from top to bottom towards the Y-axis.

This enumeration does not affect the numbering of monitors through the Display Properties dialog as shown in Figure 34.

Figure 43 shows a workplace that uses monitor 2 as the first screen and monitor 1 as the second.

Figure 43. Enumerating the X-Y coordinates of system monitors

This method of enumeration is used while configuring workplace layout for a system that utilizes virtual monitors, that is, Remote Graphics Software used in Workstation Blades and conventional workstations. If there is a virtual monitor, this will also be included in the enumeration. It is important to observe the coordinates of the virtual monitor. If the virtual monitor covers the monitors as shown Figure 44, the top-left coordinate of the virtual monitor will be the same as the top-left coordinate of the first monitor. The virtual monitor is considered as the second workplace screen.
Large Workplace

Configure the second screen as empty if the virtual monitor should not be used by the workplace. The 800xA System Version 5.0 SP1A RU3 and later versions support the process of configuring empty screens. Refer to Configuring Workplaces on page 80 for more information on configuring the workplaces.

Large Workplace

If you are using a Large Workplace template, some additional configuration is needed:

1. Follow Step 1 to Step 5 in Multi-Screen Workplace on page 56.

2. Add the aspect links you want to have in your Fixed Display Navigation aspect. The Fixed Display (see Figure 45) can be used for display navigation to large overview displays, normal sized overlap displays and separate display navigation menus (see Navigation Displays on page 74). See System 800xA Engineering Process Graphics (3BSE049230*) on how to configure aspect links. For reference to size and width of large overview displays and overlap displays, see Display Parameters for Process Graphics 2 on page 75.

Figure 44. Virtual monitors

Figure 45. Example of a Fixed Navigation Display
3. Configure the Operator Message Line by opening the Alarm and Event List Configuration aspect (located in the Library Structure below the Multi Screen Configurations object) and make your settings. See Figure 36.

4. The Application Bar aspect (located below the Large Workplace object) has a Fixed Display tab where you can decide which aspects should be visible in the Application Bar. The width of the aspects shown in the Application Bar can be set individually by configuring the “width%” column in the aspect view, see Fig 38.

![Application Bar Example for Large Workplace](image)

Figure 46. Application Bar Example for Large Workplace

5. Below the Tool Collection tab in the Application Bar aspect you select which tools to include in the Application Bar. The Close All Overlaps Toolbar should always be selected. See Figure 40.
6. Open your Large Workplace to see the result. Figure 47 shows an example of a Large Workplace.

![Large Workplace Example](image)

**Figure 47. Large Workplace Example**

The 800xA system includes a set of default workplaces to support Extended Operator Workplaces (EOW). The templates cover the different range of resolutions, for example, 1920x1080 screen resolution for EOW.

The default workplaces are located in **Workplace Structure > Web System Workplace**.
With the View Class configuration you can for example configure at which position on the screen an overlap window will appear, what size the overlap window should have and how many overlap windows of a certain type that should be allowed to be open on the screen.

For complete configuration possibilities, see Window Handling on page 92.
In multi-screen navigation, the aspect view is displayed on the current screen until an explicit target is specified in the navigation. The current screen is the screen specified by view class of the aspect view. When the current screen is determined, the aspect view is displayed in the panel section if possible. If the aspect view cannot be displayed in the panel section, the overlaps on the available screens are examined to verify if they can display the aspect view. The least recently changed overlap that can display the aspect view will be used.

If the Replacement Strategy is Preserve, existing overlaps will be used only if the maximum number of overlaps is attained (except in case of Base Display). If panel content or overlap cannot be used, a new overlap is created on the current screen. The overlap present in any other screen is also considered during navigation.

**Example:**

The View Class configuration for different aspect windows is done in the **Library Structure > Default View Class > Custom, View Class** by creating a new view class object and adding **Viewclass Values** aspect for views such as Main View, Default View, and so on. See **Figure 49**.
You can configure different information to be presented on different screens, for example you may want alarm lists to appear on one screen, trend displays on another screen and documentation on yet another screen.
Select **Screen**, select **Local** in the **Datasource** area, and then type the screen number in **Value** (0 means the active screen). See **Figure 50**.

![Figure 50. Main View - Screen](image)

The size of the aspect window can be configured by selecting **Window Height** and/or **Window Width** and type the value in the **Value** text field. See
Figure 51. Main View - Window Height and Width

To configure at which position on the screen the aspect window should appear you select the **X Position / Y Position** and type the value in the **Value** text.
field. See Figure 52.

Figure 52. Main View - X Position and Y Position
If the **Position at Cursor** value is set to **Yes** the overlap window will appear at the current cursor position. See Figure 53. This option should always be defined for Faceplate aspects.

![Custom Viewclass Values](image)

**Figure 53. Main View - Position at Cursor**

It is possible to limit the number of open overlap windows of a given view class on the available screens, where the workplace runs. See Figure 54. This will limit the number of overlaps of that view class to the number defined by the user.
Navigation Displays

A Navigation Display is an advanced navigation menu. It is useful when you want to have fast access to different aspect links, for example overview displays. A navigation display is especially useful when using the Large Workplace.

The Navigation Display can be configured to be accessed through an aspect link in the Fixed Display area of the Operator Workplace. It can be configured to include

![Custom View Class Config](image)

*Figure 54. Max Number of Windows on Screen*
aspect links and thumbnails. See Figure 55.

![Image of Navigation Display Example]

**Figure 55. Navigation Display Example**

### Display Parameters for Process Graphics 2

Ensure to use the exact size of the graphic display while creating graphic displays using Graphics Builder. The Height and Width properties should be set according to Table 3 and Table 4.

The size to be used for a graphic display is determined by the actual workplace configuration and the size available for graphic displays. The graphic display **Size Display** in **Functional Structure > New Graphics Demo** (see Figure 56) shows the actual available size to be used for graphic displays when opened in a workplace. Refer to **System 800xA Engineering Process Graphics (3BSE049230*)** for more information on accessing the New Graphics Demo.
Figure 56. Size Display where the available size on workplace is 667 x 473 pixels
Figure 57 shows a single screen in a 1 x 2, 1 x 3, 1 x 4 arrangement and overlap displays for a large workplace with resolution 1280 x 1024 pixels.

![Properties panel](image)

**Figure 57. Single screen for a workplace with resolution 1280 x 1024 pixels**

A set of predefined aspect categories for large workplace displays are available in Aspect System Structure > Process Graphics 2 > Graphic Display PG2. These aspect categories simplify the work when building displays for large workplaces, for example to secure that the displays are built in the correct size. See Figure 58.
The parameter values in Table 3 can be used for Multi-screen workplaces and Large workplaces with basic resolution 1280 x 1024 using Process Graphics.

Table 3. Parameter Values for Basic Resolution 1280 x 1024 (Process Graphics)

<table>
<thead>
<tr>
<th>Display Size</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single screen in a 1x2, 1x3, 1x4 arrangement and overlap displays for Large Workplace</td>
<td>1272</td>
<td>841</td>
</tr>
<tr>
<td>Single screen in a 2x2 arrangement</td>
<td>1272</td>
<td>905</td>
</tr>
<tr>
<td>Display for Large Workplace 2560x1024</td>
<td>2560</td>
<td>875</td>
</tr>
<tr>
<td>Displays for Large Workplace 3840x1024</td>
<td>3840</td>
<td>875</td>
</tr>
</tbody>
</table>
The parameter values in Table 4 can be used for Multi-screen workplaces and Large workplaces with basic resolution 1600 x 1200 using Process Graphics.

Table 4. Parameter Values for Basic Resolution 1600 x 1200 (Process Graphics)
Configuring Workplaces

The configuration of a Workplace is performed in the "Workplace Layout" aspect for every workplace in the Workplace Structure.

To display the panel and Application Bar workplace on screen 1, enable one item on Screen 1 tab.

To display the workplace on Screen 2 tab, define two screens in the Workplace layout view. Disable all the items in Screen 1 (see Figure 59) and navigate to the Screen 2 tab. In the Screen 2 tab, enable at least one item. For example, panel item (see Figure 60).

To display the workplace on Screen 3 tab, the number of screens should be three. Disable both Screen 1 and Screen 2. Enable one item in Screen 3 tab, for example, a panel.

The same procedure shall be repeated for each Workplace and its screens.

Figure 59. Configuration of Screen 1 on a two screen workplace where Screen 1 is empty and Screen 2 shows the Workplace.
Configuration of Safe Areas

Screen configuration (1 x N)

Figure 61 shows an example on how to configure Safe Area configuration when screens are placed in one row, e.g. 1x4.

Definitions:

SafeTop = Fixed Display + Application Bar

SafeBottom = Fixed Display + Application Bar + Workplace Base Area
Alternatively, the SafeBottom is Screen Height - Status Bar - TaskBar (if visible)

Figure 61. Example of a safe area configuration when screens are placed in one row, e.g. 1*4

Screen configuration (2 x N)

Figure 62 shows an example of a Safe Area configuration when screens are placed in two rows, e.g. 2x2.

Definitions:

SafeTop = Fixed Display + Application Bar.

SafeBottom = Fixed Display + Application Bar + Workplace Base Area on screen 1 + Workplace base area on screen 2.

Alternatively, the SafeBottom is Screen height of screen 1 + Screen Height of screen 2 - Status Bar on Screen 2.
Extended Operator Workplace

System 800xA Extended Operator Workplace (EOW) provides an interactive, high-resolution display, full and easy-to-read information, an intuitive interface and ergonomics that ensures safety, comfort, and efficiency. EOW is a combination of the technology, best practice of physical operator environment and pre-configured 800xA multiple screen workplaces and tools.

The operator desk system is ergonomically designed for multiple console-mounted monitors with motorized height-adjustable console and large screens.

*Figure 63* shows the Extended Operator Workplace environment for the operators.

---

**Figure 62. Example of a safe area configuration when screens are placed in two rows, e.g. 2*2**
Display Ratio and Resolutions

EOW supports wide screen resolution 1920x1080 for 16:9 display ratio.

Basic Node Setup

An EOW consists of three computers being client nodes to 800xA system. On each node of an EOW log in as an administrator and run the setup tool EOW Visual Config (see Figure 64). This will configure Windows settings such as visual effects.
and desktop.

![Figure 64. EOW Visual Config - Start menu option](image)

**EOW System Extension**

The EOW System Extension is installed using the **Configure System** task in the **System Configuration Console** (SCC).

**Adding EOW Nodes**

All the nodes of an EOW have to be added to the system and to their respective node groups in the **Node Administration Structure**.
To add an EOW node, run the **Configuration Wizard**.

*Figure 65. Configuration Wizard - Add EOW*
In EOW-X3 (3 screens), the overview display is added to the node group EOW-X3 Center, while the left and right nodes are added to the node group EOW-X3 Desk. The corresponding node groups exist for EOW-X2. Additionally, all three nodes of an EOW are added to a new node group for this EOW.

Enter the name of this node group in the **EOV Name** text box in the **Configuration Wizard**.

**Workplace Configuration**

For each workplace to be used, copy one of the template workplaces found in the **Workplace Structure**. Using a copy ensures that modifications made to the workplaces will not be lost when the system is upgraded and the updated template workplaces are loaded.

Recommended template workplaces for EOW are:

- X3 Center- EOW-X3 5760x1080
- X3 Desk- Operator W-13 Tab 1920x1080
• X2 Center- EOW-X2 3840x1080
• X2 Desk- Operator W-12 Tab 1920x1080

To change the default startup display edit the src property in the Panel Layout aspect of each workplace. For more information on Panels, refer to Panels on page 42. There is one panel layout for each screen in a workplace.

Figure 67. Panel Layout for an EOW-X workplace (EOW-X center node)
If the default startup display is not specified for a tabbed workplace then the graphic display on the tabbed workplace root object will be used as the startup display.
**Default Workplace**

Each Operator user must have a profile value with a rule for each of the node groups EOW-X3 Center and EOW-X3 Desk, or EOW-X2 Center and EOW-X2 Desk that determines which workplace to launch when an operator logs in.

In the **Workplace Profile Values** aspect of an operator user, click the **Add** button to create new rules for the Default Workplace. For each type of EOW, X2 or X3 there should be two rules, one for the center node and one for both the desk nodes.

![Figure 69. Workplace Profile Values - Rules](image)
In the rule for EOW-X3 Center group select a workplace based on EOW-X3 5760x1080, and in the rule for EOW-X3 Desk group select a workplace based on Operator W-13 Tab 1920x1080.

In the rule for EOW-X2 Center group select a workplace based on EOW-X2 3840x1080, and in the rule for EOW-X2 Desk group select a workplace based on Operator W-12 Tab 1920x1080.

**Operator Workplace Mode**

The base rule for **Workplace Mode** has to be set to **Operator Workplace Mode** for each Operator user.
Window Handling

Aspect Views Introduction

A view is a display of an aspect of an object. Each aspect may have several different views, for example Main View for presentation and Config View for configuration.

Figure 71. Workplace Profile Values - Base Rule
Configuring Aspect Views

There are View Classes that hold information about the appearance of different views. You can use the default View Class values, create new View Classes as well as add new views to existing View Classes. You can find the View Classes in the Library Structure under Default View Class. See Figure 72.

For each Aspect Type and Aspect Category, you can set which View Class it belongs to by setting a reference to the View Class you want to use.

What you really do, is that you specify that the views of this type or category of aspects are to be shown in the way specified in the corresponding View Class.

Follow the steps below to, for example, configure the Main View for an alarm list:

1. Expand the **Library Structure**.
2. Create a new View Class object under the Custom object and name it for example MyAE List.

3. Create a new aspect of the ViewClass Values category. Give it the same name as the view (Main View), see Figure 73.

![Figure 73. New Aspect - Main View](image)

4. Double-click the Viewclass values aspect. The Profile Definition Selection dialog appears (see Figure 74). Select View Classes/View Class Item Definition.
5. Configure the **Viewclass Values** aspect (see Figure 75).

The different View Class Values are shown in the **Names** area, see Figure 76, and are described further on, see **View Class Values** on page 97.
6. Add the **ViewClass Reference** aspect to an aspect category in the **Aspect System Structure**.

7. In the View Class Reference dialog box, select the object in **Select View Class**. For example, select **ABB System** where the Viewclass Values aspect is created (see **Figure 73**).

8. The workplace must be restarted to verify the new values.

   If a View Class Reference aspect exists on the Aspect Category, this one will be used. Otherwise the Aspect Type will be used and as a third alternative the Default View Class.

   Another example will clarify this:

   Assume that we want all alarm lists to always appear on top of all other windows because it is important that they are never hidden by mistake. Further on, we want the alarm lists to be placed at the lower right corner of the display. To achieve that, we create a new ViewClass in the Library Structure, with an aspect of category ViewClass values with the name Main View. We configure this Main View aspect to appear in the lower right corner and to lay on top of other windows. Then we link the Aspect Category, which alarm lists belong to,
to the newly created View Class. When we access the Main View of an alarm list, it will be opened in the way that we have specified in the View Class that is pointed out. If there is no configuration for the Main View in the linked View Class, the settings in the Default View Class (see Figure 72) will be used. If we have no link at all from an aspect type or aspect category to a View Class, the settings of the Default View Class will be used for aspects of that type or category.

View Class Values

The different View Class Values in the Names area (Figure 75) are the following:

• **Position at Cursor**

  If this value is set to **Yes**, the window will be positioned at the current cursor position. The **X - and Y Position** values will not be used. If this value is set to **No**, the window will be positioned as specified by the **X - and Y Position** values.

  If there is no current cursor position, and the value is set to **Yes**, the window will be positioned as if the value was set to **No**.

• **X / Y Position**

  Specifies the horizontal (x) and vertical (y) position of the upper left corner of the window.

• **Window Height / Window Width**

  Specifies the height and width (in pixels) of the window.
The overlap position is calculated based on the values of X, Y, Window Height, and Window Width. Coordinates for the overlap positions, left, top, bottom, and right are X, Y, (X + Window Width), and (Y + Window Height) respectively. The overlaps coordinates should be within the screen safe area coordinates. The overlap coordinates are wrapped if these values are extremely high, extremely low, far left or far right with respect to screen safe area. The overlap coordinates are moved to the opposite direction from the intersection point of this overlap with the safe area or taskbar of the screen.

For example, consider a screen safe area with left value 0 and right value 1280. The values set at view class of the overlap are:

X value=1090, Y value=128, Window Height=248, Window Width=260.

In this case, the overlap coordinates are:

top = 128, bottom=376, left=1090, right=1350.

The overlap right value (1350) is greater then screen right value (1280) and the overlap cannot be opened on the screen. The overlap coordinates are recalculated and the new values are:

top= 128, bottom = 376, left=0, right=260

Refer to Configuration of Safe Areas on page 81 for more information on safe areas.

- **X / Y Offset**

The X/Y offset values specifies an offset to the start position for an overlap of for example a view class. It means that several overlap windows will be placed on top of each other but have different start positions.

If no overlap window uses the same view class, the X and Y position values will be used to position the first window. New overlap windows will add X and Y offset values to the previously opened window. The latest window decides the next overlap window position. If the overlap does not fit on the screen, the offset will move the window to the opposite side. The safe areas or the taskbar will not be covered by overlap windows.

The X Offset and Y Offset values are not used if **Position at Cursor** is **Yes**. The wrapping will be unpredictable if the view class has an Override value for
ScaleLayout set to "resizetofit". The overlap will then be resized to fit its aspect view, and this can be different from the size set in the view class item.

If the workplace is in the windows mode and the new size is bigger, the overlap will be slightly outside the screen before wrapping. If the new size is smaller, the overlap will wrap before it actually intersects the edge of the screen.

In operator mode, the overlap will not be outside the screen. It appears to bunch up at the edge of the safe area before wrapping (that is, if it is bigger than the view class items for width and/or height). The resizing takes place after the launch of the overlap and is therefore not possible to detect when the offset handling takes place.

An example:
The X and Y positions are 200. The X and Y offset values are 10. The first window will be placed at 200, 200, the second at 210, 210 and the third at 220, 220 etc.

If all windows are closed down and a new is opened it will be placed at the start position.

• **Screen**

  Specifies on which screen to open the window. The Screen value can have the values "Current" (= 0), "Main" (= -1) or a specified screen such as 1 or 3. "Current" indicates the monitor where the overlap was called up. "Main" indicates the monitor associated with the main screen (currently the primary monitor). The X Position and Y Position are always relative to the coordinate system of the indicated monitor.

  If the Screen value specifies a monitor that does not exist, the fallback is the last monitor.

• **Resizable**

  Specifies whether the window is resizable.

• **Pinned**

  Pinned specifies whether the aspect displayed in the window can be replaced by another aspect.

• **Stacking Order**
This value is only used in the Operator Mode and decides the priority of different windows. The window with the highest stacking order value cannot be concealed by another overlap window.

For example; Set 5 as stacking order on an Aspect Browser window, 7 on an alarm list and 20 on a Faceplate window and the result will look like Figure 77.

![Figure 77. Stacking Order Sample](image)

- **Web Frame**

  You can decide which Frame to use for the aspect view. Today one Standard Frame and one Faceplate Frame are used. It is recommended not to change the values but to use the default ones.

- **Override**
Contains the view class attributes that are overridden in the view class only. Here you can add your own general properties.

In the Preview System View Class, three useful general properties related with primary target (TargetBorderColor, BorderWidth and ExcludeViewClasses) are available by default. If you want to add them in another view class you have to do it manually.

The TargetBorderColor property is used for change of the color of the board surrounding the primary target. The BorderWidth is used for changing the width of the border. The ExcludeViewClasses property lists the view classes you want to exclude from being affected by the primary target in a base display. An example of a list: “Faceplate;Find Tool;Trend”.

**Max Number of Windows.** In the configuration view of a view class, it is possible to decide the maximum number of windows displayed at the same time in the workplace, using this view class.

![Max number of Windows Dialog Box](image)

Figure 78. Max number of Windows Dialog Box

If **Max number of** is set to 0 (zero) it means there is no limitation of windows displayed.

You should consider to change **Max number of windows** when:

- **Preserve** is selected in the **Replacement Strategy** tool.
- Pinned is set to **No** or **Auto** in the View Class.
- Number of open windows of the same View Class is **Max Windows**.
- At least one of the windows is **not pinned**.

In Preserve mode, Opening a same faceplate again will not result in new overlap and the one already opened will have the focus.
Replacing Pinned Overlap

Pinned overlaps cannot be replaced and thus the maximum number of windows can be exceeded. It is actually possible to open an infinite number of overlaps if all of them are pinned. To prevent this, a new setting called "Replace Pinned Overlap" is introduced with possible values Yes/No, the default value is No. When set to No, pinned overlaps will not be replaced. When set to Yes, the behavior changes to never allow the maximum number of windows/overlaps to be exceeded. The replacement of pinned overlaps is always performed as a last attempt when the maximum limit is reached. When that happens, the following rules applies:

1. If there are any unpinned overlaps on the current screen, replace the overlap.
2. If there are any unpinned overlaps on any screen, close that overlap and open a new overlap, the ViewClass will decide on which screen the overlap will be opened and whether it will be pinned or not.
3. If there are any pinned overlaps on the screen, replace that overlap after which the overlap will still be pinned.
4. If there are any pinned overlaps on any screen, close that overlap and open a new pinned overlap, the ViewClass will decide on which screen the overlap will be opened and whether it will be pinned or not.

Configuring View Classes for Different Nodes

For systems that have different monitor set-ups for different clients, it is possible to have different configurations for the view classes for each node in the system. For example it is possible to configure the behavior of the faceplate's position for the different nodes.
This is enabled by the use of rules in the view class configuration. By adding local node rules, different set-ups can be achieved. See Figure 79.

![Figure 79. Adding Node Rule for the Faceplate View Class](image)

In the Add Rule dialog box you can add a rule for one specific node, for example a node with multiple monitors, as in Figure 79.

**Group Display**

With the Group Display aspect it is possible to display a collection of aspect views in a table format. For example you might want to combine several alarm lists or faceplates in one display.

A Group Display aspect can be added to any object. In the configuration view of the Group Display aspect you decide the group display layout. With different settings you decide which aspect views to show and in what order they will be displayed. You also decide how many rows and columns the display aspect should include when the main view is opened. The minimum number of rows and columns is 1. There is no maximum number of rows or columns. The default numbers are 2 rows and 5 columns.

Displaying a large number of aspects in a group display might affect the call up time for the group display in a negative way.
Example:

In this example four faceplates will be displayed in the main view.

1. Select an object and add a Group Display Aspect.

2. Open the Group Display aspect Config View and decide how many rows and columns your group display should include. In this example the number of columns and rows are 2, the width is 200 and the height is 250.

3. Click Add to add an aspect view. The Select View dialog box will be displayed. See Figure 81.
Section 2  Workplace Configuration  

Group Display

3. Select wanted structure, object, aspect and aspect view, see Figure 81.

5. Click OK. The selected objects and views will be visible in the list.

When all table cells are filled, the Add button will be disabled. More rows or cells must then be added before you can add more aspect views.

To remove aspect views, click Remove. You can decide in which order the views should be displayed. Use Move Up and Move Down, see Figure 80. The first aspect view in the list will be placed at the top left position.

6. Select the View Class for the aspect. By default, Group Display is selected.

7. Click Apply.

Select the Group Display aspect’s Main View to see the result of your configuration. See Figure 82.
The cells use the viewclass stated in **View Class** drop-down list to display themselves. The main view uses the Graphic Display view class to display itself. The Group Display aspect can therefore be used in the Operator Workplace panel. See also Panels on page 42.

**Quad Display**

The Quad Display is a special configuration of a group display. It is locked to a two by two grid with four aspect views. The Quad Display makes it possible to toggle between the main view of the four aspects and a full screen view of any of the aspects by using the Zoom tool in the toolbar.

*Figure 82. Group Display Aspect - Main View*
To configure a Quad Display follow the steps below:

1. Select an object and add a Quad Display aspect.

2. Open the Quad Display aspect Config View. Click Select View to select wanted structure, object, aspect and aspect view for the four different frames. See Figure 83. It is not possible to select aspects of the categories Quad Display and Faceplate.

3. Click Apply. The result will look like Figure 84.

![Figure 83. Configuration View of the Quad Display](image)
A view class contains information on the appearance of different views of an aspect. In the previous versions of System 800xA, the View Class Reference aspect configured for an aspect category or an aspect type, was applicable for the system irrespective of the workplaces.

The view class configuration can also be done on a workplace level. The user can now define different view classes for the workplaces.
Refer to **Window Handling** on page 92, for more information on view classes.

Execute the following steps to use the view class override feature:

1. In the **Workplace Structure**, right-click a specific workplace and select **New Aspect**.
   
   Select **View Class Mapping** and click **Create** to create this aspect for the workplace.

   ![New Aspect](image)

   *Figure 85. Creating a View Class Mapping aspect*

2. In the **View Class Mapping** aspect, click **Add**. The **Select Overridden Viewclass Reference** dialog appears.
3. In **Viewclass Reference**, select the overridden view class reference.

4. In **View Class**, select the view class to be mapped.

5. Click **OK**. The mapping information is displayed in the **View Class Mapping** configuration.
6. Click **Apply** to save the changes.

To delete a view class mapping information, select the mapping information from the list and click **Delete**. Click **Apply** to save the changes.
Tabbed Workplace

Tabbed Workplace allows the user to navigate between graphic displays using buttons, tabs, and drop-down lists. Tabbed Workplace is used for easy navigation and responsiveness to alarms and events. A Tabbed Workplace is created by copying predefined Tabbed Workplace, located in the Workplace Structure. This workplace includes a breadcrumb list and status indicators for each tab.

The Breadcrumb list shows the object path, starting from the currently displayed object back to the root object (see Figure 88). The breadcrumbs shows where the operator has navigated and allows for quick navigation to the immediate parent or to the overview display.

The Status Indicators include an Alarm Indicator and a Status Indicator (see Figure 89). The Alarm Indicator shows the alarm severity. These indicators guide the user through the object hierarchy to locate the display that contains the alarm. This saves engineering time for navigation configuration.

The Status Indicator shows the alarm status information. For example, the status can be hidden or shelved.
Figure 88. Tabbed Workplace (Displaying tabs and Breadcrumb list)
Tabbed Workplace Concepts

The TabGrouping aspect is used to configure a Tabbed Workplace. The TabGrouping aspect determines a root object as the navigation root (Level 0). This object can have one or more Area-Level 1 objects as child objects, which appear as buttons. The Area-Level 1 objects can have Level 2 objects as child objects, which appear as tabs. To understand the traversal of objects back to the root, refer to Figure 89.

Figure 89. Tabbed Workplace (With the Drop-down and Status Indicators)
Figure 90. Objects and how they are displayed

Tabbed workplace is designed to use the same root object for all screens when using multiscreen workplace configuration.
To create the object structure the Plant object of type **Tabbed Workplace Root** can be used.

To create child objects with alarm lists and graphic display, PG2 objects of type **Display Tab** can be used. The predefined Tabbed Workplaces are configured to use these.

The tabs are automatically created, one tab for each object directly under the navigation root. The tabs get the same name as the corresponding object. If a tab object includes child objects, these appear as a drop-down within the tab, and the user can navigate to the required object (see Figure 91).

An object should have at least one default aspect of Graphic Display PG2 or Graphic Display to appear as a tab, when clicked. By default, the **TabGrouping** aspect shows the default aspect of the navigation root object when the workplace starts.

The order of the tabs can be controlled by its parent (see example in Figure 91). If you want to rearrange the child objects of Area1, right-click on the Functional Structure aspect of the Area1 object and select **Details**. Click the **Rearrange** tab to order the child tabs Cell1, Cell2, and Cell3.

The **TabGrouping** aspect is built on a pane-pair principle where the tab strip in the Tabbed Workplace is in one pane and the corresponding content is in another pane. Figure 92 shows a **Screen Layout** aspect configured for tabs.

Refer to **Workplace Layout** on page 27 for more information on screen layout.
Section 2  Workplace Configuration  

Tabbed Workplace Concepts

Figure 92. Panel layout for a TabGrouping aspect configured for tabs

All pane ids/names in the workplace must be unique for tabbed navigation to work. For navigation history hotkeys to work, the content pane names have to be prefixed with 'Base'. For example: If the content pane on screen 1 is named "Base1", the content pane on screen two must have another name, for example, "Base2".
If additional screens are required for the Tabbed Workplace, copy the recently added screen layout and rename it. For example: 2_ScreenLayout to 3_ScreenLayout.

Open the 3_ScreenLayout aspect and change the pane name. For example: Base2 to Base3.

**Configuring Tabbed Workplace**

The TabGrouping aspect contains Basic, Combined/Tab/Button Appearance, and Status Indication tabs (see Figure 93). Right-click the TabGrouping aspect and select Config View, to configure the Tabbed Workplace.

*Figure 93. TabGrouping Aspect*
Basic tab

This tab is used to configure the tab styles and the navigation root object for the Tabbed Workplace.

Figure 94. Basic Configuration

- **Item Style** - The **TabGrouping** aspect supports three kinds of styles — **Combined**, **Buttons Only**, and **Tabs Only**. The typical configuration is to use the Combined style on the primary screen, but only show tabs on others.

- **Default Level** - The default level is the level from navigation root where to collect objects. The default level for each style is predefined and cannot be changed. Following are the default levels:
  - **Combined** is 1
  - **Buttons Only** is 1
  - **Tabs Only** is 2

- **Number of Levels** - The number of levels in the object tree that will appear as buttons, tabs, or combined. By default, the number of levels is 3.

  If the number of levels is more than 3, then all the subsequent levels from 3 appear as drop-down.
• **Navigation Root** - This specifies the root object for navigation. The child objects of the selected object appear as tabs. Click **Browse** to select the root object.

Tabbed workplace is designed to use the same root object for all screens when using multiscreen workplace configuration.

**Combined Appearance tab**

This tab appears for the *Combined* style. In the Combined style Level 1 objects appear as buttons and Level 2 objects appear as tabs.

**Figure 95. Combined appearance**

• **Height** - Specifies the height of the button area. This can be changed to view one or two rows of buttons when more number of buttons are being displayed within screen width. The button height decides the tab height. The tab height will be the pane height minus the button height (see **Figure 96**). If breadcrumbs are used, tab height will be pane height minus button height minus breadcrumb height. Tabs will always occupy the remaining space within a pane.

**Figure 96. Heights. 1-Button Height, 2-Tab Height, 3-Breadcrumb Height**
For example, if pane height is 90 and the button height is 60, the tab height will be 30 (that is, 90-60). If breadcrumbs are enabled with a height of 16 then tab height will be 14 (that is, 90-60-16).

**Tab Appearance tab**

This tab appears for *Combined* and *Tab Only* style. In the *Tab Only* style level two objects appear as tabs.

This tab is used to configure the drop-down direction of the child objects. Breadcrumbs can be enabled for root and child objects.

<table>
<thead>
<tr>
<th>Widths</th>
</tr>
</thead>
<tbody>
<tr>
<td>An object item has a minimum and maximum width, min and max can be equal for static width, else the item will scale depending on the length of the object name.</td>
</tr>
<tr>
<td>Minimum Width: <strong>100</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dropdown direction for child objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] Top to Bottom</td>
</tr>
<tr>
<td>[ ] Left to Right</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Breadcrumbs Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] Enable Breadcrumbs Area</td>
</tr>
<tr>
<td>[ ] Show Breadcrumbs</td>
</tr>
<tr>
<td>[ ] Show child objects in area</td>
</tr>
<tr>
<td>Area Height: <strong>16</strong></td>
</tr>
</tbody>
</table>

*Figure 97. Tab Appearance*

- **Widths** - Controls the width of a single tab item. The item width is adjusted according to the length of the object name, but within the maximum and minimum width specified. If the object name is longer than the maximum width, the object name is truncated. There is a tool tip showing the complete name.

- **Dropdown direction for child objects** - Controls the direction of the drop-down displayed in the tabs. The drop-down can be displayed **Top to Bottom** or **Left to Right**.
• **Breadcrumbs Area** - Select the **Enable Breadcrumbs Area** check box to show the breadcrumb area in the tabbed workplace.
  
  – Select **Show Breadcrumbs** to display the object path in the breadcrumb.
  
  – Select **Show child objects in area** to display the child objects (level 3 objects) in the breadcrumb.

**Area Height** specifies the height of the breadcrumb list. The area height decides the tab height. The tab height will be the pane height minus the breadcrumb height (see Figure 96). To ensure the visibility of the tabs and the breadcrumb, the user must update the height specified for the tab in the XML tab of the **Screen Layout** aspect on the Tabbed Workplace object in the **Workplace Structure**.

**Button Appearance tab**

This tab appears for both **Combined** and **Buttons Only** style. This tab is used to configure the width of the buttons and the number of screens associated with the Tabbed Workplace.

<table>
<thead>
<tr>
<th>Widths</th>
</tr>
</thead>
<tbody>
<tr>
<td>An object item has a minimum and maximum width, min and max can be equal for static width, else the item will scale depending on the length of the object name.</td>
</tr>
<tr>
<td>Minimum Width: 100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Screens</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="1" alt="1" /> <img src="2" alt="2" /> <img src="3" alt="3" /> <img src="4" alt="4" /></td>
</tr>
</tbody>
</table>

*Figure 98. Button Appearance*

• **Widths** - Controls the width of a single button. The button width is adjusted according to the length of the object name, but within the maximum and minimum width specified. If the object name is longer than the maximum width, the object name is truncated. There is a tooltip showing the complete name.

• **Screens** - Creates the number of sections required on the button corresponding to the screens used in the Tabbed Workplace. Typically, the number of sections
configured for the button should be the same as the number of screens configured for the Tabbed Workplace.

For example, if the Screens selected is 2, the button will have two sections (see Figure 99).

![Figure 99. Buttons corresponding to Screens](image)

When the second section in a button is clicked, the aspect view appears in the content pane of the second screen.

If the number of sections configured for the button is greater than the actual number of physical screens, the last section of the button will navigate to the last screen.
**Status Indicators tab**

This tab is used to configure the alarm and status indicators.

![Status Indicators tab diagram](image)

*Figure 100. Alarm and Status Indicators*
Figure 101 shows the Alarm and Status indicators available on buttons and tabs.

![Figure 101. Alarm and Status Indicators](image)

The properties used in alarm and status configurations must exist on all objects. The alarm and status indicators properties must be typed in either of the formats - `<aspect name>:<property name>` or `<property name>`.

- Select the **Use Alarm Indicator** check box to display the alarm priority and alarm state for buttons and tabs.
  
  - **Alarm Priority** - Displays the severity of the alarm. When property value exceeds 0 the priority value will be shown in the Alarm Indicator. The application refers to the selected color configuration to get the corresponding color for the alarm indicator. The color is determined using both Alarm Priority and Alarm Status.

  In the case of **Button Only** or **Combined** style, the **Alarm Priority** value will also appear inside the alarm indication area in addition to the color.

  - **Alarm State** - Displays if the alarm is acknowledged or not.

  `AlarmState` and `PriorityLevel` properties of Alarm Event List aspect can be used as Alarm Priority and Alarm State properties. `AlarmConditionState` and `AlarmPriorityLevel` global properties can also be used.

  Select the **Use Built-in Hierarchical Calculation** check box to evaluate
the current alarm of the object against the child objects, and show the most significant alarm in the alarm indicator.

The alarm indicator always displays the number and color of the unacknowledged alarms with highest priority. Only when all the unacknowledged alarms are acknowledged, the alarm indicator displays the number and color of the acknowledged alarms with highest priority.
The buttons will always show the most significant alarm of all tabs.

- Select the **Alarm Color Definition** from the drop-down to evaluate the color to be shown in the alarm indicator if the value of the Alarm Priority or Alarm State property value exceeds 0.

- Select the **Use Status Indicator** check box to display the status indicator for buttons or tabs.

  - **Property** - Displays the status of the alarm such as Hidden or Shelved. Three different kinds of status properties are prioritized as 1, 2, and 3 respectively. If the first property is active, the status indicator will be shown, and the other configured properties are ignored.

  If a property value exceeds 0, the corresponding **Foreground** and **Background Color** is displayed in the status indicator. In the case of **Button Only** and **Combined** style, the corresponding **Letter** will also appear inside the alarm status indication area.

  **ShelvedAlarmCount** and **HiddenAlarmCount** properties of Alarm Event List aspect can be used as status properties. **IsAlarmShelved** and **IsAlarmHidden** global properties can also be used.

  Select the **Use Built-in Hierarchical Calculation** check box to evaluate the current status of the object against the child objects, and show the most significant status in the status indicator.

The Status Indicator will be hidden for an object if **TabGrouping** aspect fails to subscribe to that object.
Resources

A TabGroup Colors aspect, controls the colors used by the Tabbed Workplace. This aspect is located in the Tabbed Workplace under Workplace Structure and contains the following predefined parameters:

- TabViewBackColor - The background color of the main view.
- TabItemBackColor - The background color of a single tab/button item.
- TabItemSelectedBackColor - The background color of a single tab/button item when it is selected.
- TabItemBorderColor - The border color of a tab/button item.
- TabItemHighlightColor - The border color for tabs/buttons when cursor hovers the item.
- TabItemForegroundColor - The foreground color for the text and symbols.

A TabView Font Resources aspect, controls the fonts used by the Tabbed Workplace. This aspect is located in Library Structure > ResourceLibraries > TabView Fonts and contains the following set of parameters that correspond to a specific font:

- TabViewTabFont - The font used within a tab item.
- TabViewDetailFont - The font used within a drop-down item.
- TabViewCrumbFont - The font used within the breadcrumb.
- TabViewButtonFont - The font used within buttons.

If the font size is changed for tabs or breadcrumbs, the height of button area must be changed. The button height expands according to the height of the font.

Using Hotkeys in Tabbed Workplace

Navigation in a tabbed workplace can be done using keyboard shortcuts. The keyboard shortcuts can be defined through by adding the Hot Keys aspect (see Figure 102).
In **Hotkey**, enter the hotkey for keyboard navigation.

In **Action**, select the required tab navigation for the keyboard shortcut. Actions such as Tab Navigation Previous, Tab Navigation Next, Tab Navigation Up, Tab Navigation Down, and so on are available.

For more information on adding hotkeys, refer to **Hot Keys** on page 132.

**Figure 103** shows the objects in the Functional Structure and the appearance of the respective objects in the Tabbed Workplace.
Section 2  Workplace Configuration

Using Hotkeys in Tabbed Workplace

Table 5 describes the hotkey navigation for the objects in the Area2 object.

Table 5. Hotkey Navigation for Area 2 objects

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Tab</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + 1</td>
<td>Tab 1</td>
<td>Temperature</td>
</tr>
<tr>
<td>Ctrl + 2</td>
<td>Tab 2</td>
<td>Process 1</td>
</tr>
<tr>
<td>Ctrl + 3</td>
<td>Tab 3</td>
<td>Process 2</td>
</tr>
</tbody>
</table>

Table 6 describes the hotkey navigation from the Process 1 object.

Table 6. Hotkey Navigation for Process 1 object

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + Up</td>
<td>Area2 (Parent object)</td>
</tr>
<tr>
<td>Ctrl + Alt + Down</td>
<td>Navigates to the child object</td>
</tr>
</tbody>
</table>

Figure 103. Objects in the Functional Structure and the corresponding view in Tabbed Workplace
Table 6. Hotkey Navigation for Process 1 object

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + Right</td>
<td>Process 2 (Tab to the right)</td>
</tr>
<tr>
<td>Ctrl + Alt + Left</td>
<td>Temperature (Tab to the left)</td>
</tr>
</tbody>
</table>

No navigation happens for the following keyboard shortcuts:

- <Ctrl + Alt + Left> from Temperature.
- <Ctrl + Alt + Right> from Process 2.
- <Ctrl + Alt + Down> from Mixing Flow.
- <Ctrl + Alt + Up> from TestFactory.
Favorites

With the Favorite aspect it is possible to group and organize the most visited aspects for fast access. The Favorite aspect system is a function similar to the Favorites function in Internet Explorer.

In a Workplace, the Aspect Favorites can be accessed from the Application Bar, if the Workplace is configured to display Favorites, or from the Aspect Menu tool. See Figure 104 and Figure 105.

![Figure 104. Aspect Favorites Bar](image)

Figure 104. Aspect Favorites Bar

![Figure 105. Aspect Menu](image)

Figure 105. Aspect Menu

The Aspect Menu displays the Favorite aspects of the current User and the User Groups the user belongs to. In Plant Explorer you can add a Favorite to a User Group as described in Adding a Favorite on page 131.

Adding a Favorite

Create a Favorite aspect on a Favorites object in the User Structure. Open the configuration view and select the aspect the Favorite should link to. A Favorites object can be created as a child of a User or User Group object, or as a child of another Favorites object. The Aspect Favorites defined for user groups must be organized in the Plant Explorer.

Adding a Favorite is possible for an operator as well. Read more about how to add, use and organize Favorites in System 800xA Operations (3BSE036904*).

The Aspect Menu tool can be accessed from the Application Bar, see Figure 105. The structure displayed in the Aspect Menu is the User Structure. It includes the Favorites objects placed under the user and the user groups. A Favorite aspect can only be added to a Favorites object.
Hot Keys

The Hot Keys Aspect System is used to configure Hot Keys. It enables configuration of key combinations that perform specific functions, such as opening an aspect view, activating a verb, or navigating to next or previous graphic displays. The hot keys operations can be global, i.e. independent of highlighted object or affect the highlighted object. The hot key configuration only allows binding hot keys to existing object or aspect verbs.

When configuring Hot Keys make sure that you are a member of the Operator group, to ensure that all verbs available to the operator are listed.

How to use the Hot Keys Aspect

Each hot key can be associated with two operations, one for key down and one for key up.

Hot keys enables fast access to:

- process object operations like start/stop, alarm acknowledge etc.
- information like displays, documents or other aspects.
Table 7 lists the predefined Object Hot Keys available in the Operator Workplace:

Table 7. Workplace Hot Keys

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT+HOME</td>
<td>Show Cursor</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Find tool</td>
</tr>
<tr>
<td>CTRL+SHIFT+3</td>
<td>All process alarms</td>
</tr>
<tr>
<td>CTRL+SHIFT+4</td>
<td>All process events</td>
</tr>
<tr>
<td>CTRL+SHIFT+5</td>
<td>System alarms</td>
</tr>
<tr>
<td>CTRL+SHIFT+6</td>
<td>System events</td>
</tr>
<tr>
<td>CTRL+SHIFT+7</td>
<td>System status</td>
</tr>
<tr>
<td>CTRL+SHIFT+S</td>
<td>Direct external alarm silence</td>
</tr>
<tr>
<td>CTRL+ALT+F4</td>
<td>Close all overlaps</td>
</tr>
<tr>
<td>ALT+F4</td>
<td>Close Active Window</td>
</tr>
<tr>
<td>F1</td>
<td>Context Sensitive Help</td>
</tr>
<tr>
<td>CTRL+SHIFT+F1</td>
<td>Show hot key map</td>
</tr>
</tbody>
</table>

The hotkeys that have the hotkey context **Highlighted Object** with a verb should have the following default aspects:

1) **Verb Map**, which provides the virtual verbs for the object.

2) **Scripting Verbs**, which contains the definition of the virtual verbs.

The hotkey does not function if these aspects are not available for the object. The aspects **Verb Map** and **Scripting Verbs** provide the value for the corresponding verb. An example is <CTRL+SHIFT+Q>.
Execute the following steps to create and use a Hot Keys aspect:

Before creating a new hot key, verify the availability of the required key combinations in the Hot Keys Map aspect in Workplace Structure > Web System Workplace > Operator Workplace.

Use the key combinations that are reserved by Microsoft Windows in the Operator Workplace only after disabling them manually in Windows. For example, the hot key <CTRL + SHIFT + 0> is used for switching between input languages in Microsoft Windows. To use the same key combination in the Operator Workplace, remove the usage through Control Panel > Clock Language and Region > Region and Language.

1. Select the Workplace object.
2. Add the Hot Keys aspect. (It has to be added to the Workplace object which may only hold one Hot keys aspect).

![Figure 107. Hot Keys Aspect System - Main View](image)
Section 2  Workplace Configuration  How to use the Hot Keys Aspect

The configuration contains a list of key combinations together with the operation to perform for each key combination. It is possible to have two entries with the same hot key if they have different key state.

To define a hot key that uses the numeric key pad, the hot key must be defined with the Num Lock toggle off, and the Num Lock toggle must always be off when using the hot keys.

Configuration View - Global Operations

Figure 108. Global Operations

Global hot key operations are independent of highlight and selection. To configure a global Hot key operation, following are the steps:

1. Enter the key combination, for example ALT+A in the Hotkey area.
2. Select Global in the Context drop-down menu.
3. Select whether the hot key should open an aspect or a verb, or navigate to the next or previous graphic display in the Action drop-down menu.
   a. If the hot key should open an aspect, select the aspect and the view. If no view is selected, the default view will be opened.
b. If the hot key should execute a verb, select the aspect that implements the verb and then the verb.

c. If the hot key should navigate to the next or previous graphic display, select Navigate next or Navigate previous, respectively.

Navigation hot keys work only for the graphic displays opened in the same workplace base area. Hot keys cannot be used to navigate between a display opened in the base area and the one opened in the overlapped window.

For Multiscreen operator workplace, user must click on the desired screen and use the navigation hot keys.

4. Click Add.

Configuration View - Operations on Highlighted Object

![Configuration View - Operations on Highlighted Object](image)

*Figure 109. Operation on Highlighted Object*

To configure an operation, do as follows (see Figure 109):
1. Enter the key combination, for example ALT+A in the Hotkey area.
2. Select Highlighted in the Context drop-down menu.
3. Select whether the hot key should open an aspect or a verb in the Action drop-down menu.
   a. If the hot key should open an aspect, you select the aspect category and possibly the view.
   b. If the hot key should execute a verb, you will be limited to object verbs. In this case, you select the object type or object type instance and get a list of the object verbs implemented.
4. Click Add.

Changing and Removing Hot Keys

- Select details of a hot key configuration in the list. The input fields will then be entered.
- To remove a hot key configuration, select it in the list and click Remove.
- To modify a hot key configuration, select it in the list and click Remove. The configuration will remain in the input fields. Change the input fields as desired and click Add.

When a highlighted object with a Hot Key aspect is activated, and more than one aspect of the selected category is found, the default aspect of that category is used. If there is no default, the first aspect of the category is used.

If there is no aspect of selected category, an aspect of the same type will be attempted. If no object is highlighted or if the operation cannot be performed, nothing will happen.

The operation will be performed on all objects that support the operation.

After adding the first Hot Key aspect you must restart the Workplace. You do not have to restart the Workplace after additional hot key configuration.
Configuring Color Settings with Logical Colors

Some colors have a special meaning for an operator, for example the color on an active alarm, or a warning message. Other colors need to be the same on all places to give the system a user-friendly look (for example background colors). You also want to be able to change these colors with one operation for all occurrences.

Logical color is the concept used to be able to fulfill these needs. A logical color is defined once, and the user of the color refers to it by its name.

The Operator Workplace contains a set of predefined logical colors divided into several groups for their different purposes.

The table below shows the predefined logical colors groups:

Table 8. Predefined Logical Color Tables

<table>
<thead>
<tr>
<th>Color group</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Analysis Colors</td>
<td>Used in Alarm Analysis.</td>
</tr>
<tr>
<td>Display Element Colors</td>
<td>Used in Display Elements.</td>
</tr>
<tr>
<td>Event Colors</td>
<td>Used in graphic aspects for different events, like blocked, in alarm state, Alarm and Event lists etc.</td>
</tr>
<tr>
<td>Event Colors 3D Ext</td>
<td>Same as Event Colors, with support for 3D look. (The color set contains two variations of each color, one lighter and darker, which makes it possible to create 3D images).</td>
</tr>
<tr>
<td>Event Colors Shelving</td>
<td>Used for shelving.</td>
</tr>
<tr>
<td>General Colors</td>
<td>A general set of colors for faceplates, graphics.</td>
</tr>
<tr>
<td>High Performance Element Colors</td>
<td>Used for the high performance graphic elements.</td>
</tr>
<tr>
<td>High Performance HMI Colors</td>
<td>Used for the high performance operator workplace.</td>
</tr>
<tr>
<td>Media Colors</td>
<td>Used for graphic displays.</td>
</tr>
<tr>
<td>Object Colors</td>
<td>Colors for object properties, process graphics.</td>
</tr>
</tbody>
</table>
A Logical Color Group is defined by a Logical Color Definition aspect always placed on the root object Web System Workplace in the Workplace Structure.

**Overriding an Existing Logical Color Definition**

The System is delivered with a standard set of Logical Colors. You can always override a logical color by changing the color definition in the Logical Color Values aspect, on the Workplace object. The Logical Color Values aspect is created together with a Logical Color Definition.

To change a logical color, follow the steps below:

---

**Table 8. Predefined Logical Color Tables (Continued)**

<table>
<thead>
<tr>
<th>Color group</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Colors 3D Ext</td>
<td>Same as Object Colors, with support for 3D look. (The color set contains two variations of each color, one lighter and darker, which makes it possible to create 3D images).</td>
</tr>
<tr>
<td>Process Graphics Colors</td>
<td>Faceplates colors (general).</td>
</tr>
<tr>
<td>Standard Symbol Colors</td>
<td>Used for standard symbols.</td>
</tr>
<tr>
<td>TabGroup Colors</td>
<td>Used in tab groups.</td>
</tr>
<tr>
<td>Trend Colors</td>
<td>Colors for the different trend traces.</td>
</tr>
<tr>
<td>Uncategorized Colors</td>
<td>For special purposes.</td>
</tr>
<tr>
<td>Wide Screen Alarm Colors</td>
<td>Colors for the different alarms in wide screen.</td>
</tr>
<tr>
<td>Wide Screen Trend Colors</td>
<td>Colors for the different trend traces in wide screen.</td>
</tr>
</tbody>
</table>
1. Select the Logical Color Values aspect you want to change and open the Configuration dialog box.

![Logical Color Override Dialog with Colors Added](image)

*Figure 110. Logical Color Override Dialog with Colors Added*

2. Select the logical color name you want to modify, then highlight the RGB value in the second section of the dialog box. See *Figure 110*.

3. Click **Modify** and select the wanted color.

4. Click **Apply** to save the logical color value override.

**Creating a New Logical Colors Definition**

You can also add your own logical color groups for your own purposes. The added logical colors will work exactly as the system default logical colors. It is recommended to use the existing colors.

To create a logical color, follow the steps below:

1. Expand the Web System Workplace object in the Workplace Structure.
2. Click in the aspect area and create a Logical Colors Definition aspect. Give the new aspect a proper name. A corresponding Logical Color Values aspect with the same name is automatically created on the Workplace objects below.

![Workplace Structure](image)

**Figure 111. Workplace Structure**

3. Select the new aspect and click Add in the Config View to define the name of a new logical color. See Figure 112. You can add up to 8 blink colors. The defined colors will be shown for 250 ms each.

![Logical Color Definition Dialog Box](image)

**Figure 112. Logical Color Definition Dialog Box**

The logical color name must consist of the characters a-z, A-Z, 0-9. The name must start with an alphabetic character.
If you want to create a red-white blink that is red for 1 s and white for 1 s you define eight colors, four red identical color entries followed by four white identical color entries.

## Configuring Context Menu

Some configurations affect the appearance of the context menu. For example configuration of default aspects, aspect filters and submenus.

### Default Aspect

The second entry in the Context Menu is the default aspect of the selected Aspect Object. Usually, activating the Aspect Object, e.g. by double-clicking it, will display the default aspect. The aspect that actually becomes the default aspect of an Aspect Object is controlled by an Aspect Precedence List.

### Aspect Precedence List

The aspect precedence list is an aspect that holds a list of rules. Whenever the default aspect is calculated, each rule in the list is tried to find an aspect on a specific Aspect Object. If the Aspect Object does not have an aspect that matches the rule, or more than one aspect matches the rule, the next rule in the list will be tried instead, and so on. The aspect precedence list can contain aspect categories, aspect types, aspect keys and other precedence lists (nested precedence lists).
Section 2  Workplace Configuration

Configuring Context Menu

The built-in aspect precedence list, called the Default Precedence List, can be found in the Library Structure and is valid for the whole system, see Figure 113.

Create additional Precedence Lists. It is possible to create additional Precedence Lists. For example different users can have their own precedence list. The Object Handling Profile Values aspect located on the user object in the User Structure, controls which Precedence List to use. By default the Default Precedence List aspect is used for all users.

To create a precedence list for a user follow the steps below:
1. Create a new Aspect Precedence List object on the Aspect Precedence Lists object in the Library Structure and give it a name.

2. Add aspect types, aspect keys, aspect categories or precedence lists to your newly created list. When you are done click **Apply**.

3. Go to the User Structure and select the user object for which you want to add the new precedence list.

4. Select the Object Handling Profile Values aspect in the aspect view.

5. Select **Local** in the **Datasource** area, and browse for your newly created precedence list by clicking the Browse button next to the **Object Name** text filed. See **Figure 114**.

6. Select your list in the Select Object dialog box and click **OK**.

7. Click **Apply**.

**Precedence and the Default Aspect**

The precedence list is constructed to make it possible to tailor the default aspect for any Aspect Object using a range of rules such as aspect category, aspect type, nested...
precedence lists and aspect key. The combination of settings makes the configuration versatile but at the same time somewhat complex and therefore the full functionality of the precedence list is explained in steps.

**Precedence using Aspect Category.** The most straightforward approach is to simply list the aspect categories in order starting with the most important aspect category.

When a user right-clicks an object, the default aspect is located by looking for an aspect of one of the aspect categories listed in the precedence list. In the example below, the context menu first looks for an aspect of the aspect category Faceplate. Since the object does not have such an aspect it then looks for the next aspect category in the list. The object does have an aspect of the aspect category “Trend Display” so then that aspect is the default aspect.
Note that if the object would have two trend display aspects that rule in the precedence list would have been skipped and the next aspect, the Graphic Display, would have been the default aspect.

**Figure 115. Precedence List using Aspect Category**

Note that if the object would have two trend display aspects that rule in the precedence list would have been skipped and the next aspect, the Graphic Display, would have been the default aspect.

**Precedence using Aspect Type.** In some cases, listing all aspect categories would not make sense and in that case the Aspect Type can be added to the precedence list. The aspect type works just like the aspect category; the context menu looks for an aspect of the listed aspect type. In the example below, the precedence list starts with the faceplate aspect category and then any aspect of the type Graphic Display PG2.
This means that any aspect of the Graphic Display PG2 aspect type will be the default aspect. In the example below, the default aspect is the “Overview Graphic Display” which is of the aspect category “Overview Graphic Display PG2” and the aspect type “Graphic Display PG2”.

Precedence using Aspect Key. The third rule available is using an aspect key. You can use any aspect key in the precedence list, either you create a custom aspect key or you can use the built-in key called “Default Aspect”.

Using an aspect key to state the default aspect on an object requires more work, but gives the most flexibility. Since the aspect key can be placed on any aspect of an object, the engineer has the possibility to assign the key to any aspect regardless of aspect category or aspect type. For example, there are two objects that both have faceplate and trend aspects and one object should have the faceplate as default aspect while the other should have the trend aspect as default aspect. In this case the engineer must resort into using an aspect key on the specific aspect that should be
default. Assigning the aspect key “Default Aspect” to the faceplate on the first object and to the trend display on the second object will solve the problem.

Using an aspect key can sometimes be useful if many objects in the system have several aspects of the same category and the engineer wants to specify what aspect should be the default. As an example, a library coming from a system extension contains many object types all pre-configured with faceplates. However, on some specific object types the engineer wants to make a custom version of the faceplate and adds his own faceplate to the object type. Now there are two faceplate aspects

Figure 117. Precedence List using Aspect Key - Example 1
and the aspect category rule cannot be applied but the aspect key can. The engineer then creates an aspect key and tags his new faceplate aspects with that key. The user then puts the aspect key before the aspect category in the precedence list.

Figure 118. Precedence List using Aspect Key - Example 2

How to set the aspect key as Default Aspect

Follow the steps below to set the aspect key default aspect:
1. Open the context menu of the aspect and select Details.
2. Select the Aspect Info tab.
3. Select the Default aspect check box. See Figure 119.

How to create and add a custom aspect key

Follow the steps below to create a custom aspect key:
1. Open the context menu of the aspect and select Details.
2. Select the Aspect Info tab and click New in Aspect Keys. See Figure 119.
3. Give the key a name and a description. See Figure 120.
Section 2  Workplace Configuration

Configuring Context Menu

4. Select the Add to current Aspect check box and click OK.

5. Click Apply.

To add an existing key to an aspect you click Add and then select the key from the list that appears.

**Linking Precedence Lists.** The last type of rule in the precedence list is a link to another precedence list. This means that when the context menu finds a link rule, it then opens that precedence list and starts at the top. When all rules of the linked precedence list have been tried the context menu continues after the link in the original list.

The typical user case for linking to other precedence lists, is overrides for e.g. specific users. For example, an engineer would probably want a customized version of the operator’s precedence list but without redefining the entire list. Therefore, the engineer creates a new precedence list with the engineering aspect categories first then a link to the operator’s list.

In Figure 121, the precedence list “Engineering Precedence” is linked to the Default Precedence list and makes the Graphic Display PG2 a default aspect before any other aspect.

![New Key](image)
Configuring Aspect Filters

An Aspect Filter allows you to select the aspect categories to be included in the filter. When the filter is applied, only the aspects belonging to the selected aspect categories, will be listed in the context menu and in the aspect list area. Filters can be configured for an Operator Workplace and the Plant Explorer Workplace.

To configure an Aspect Filter, follow the steps below:

1. Click in the Plant Explorer Workplace toolbar. The Configuration dialog box is displayed.
2. The Configurable filters lists the existing filters. The other two lists display available and hidden aspect categories in a new filter.

3. To configure an existing filter, select a filter in the Configurable filters list. When selected, the aspect categories included in that filter are displayed in the Available aspect categories or Aspect categories hidden by filter lists.

   Click Add or Remove to toggle the categories between the Available aspect categories or Aspect categories hidden by filter lists.

4. To create a new aspect filter, click New. This will display the New Filter dialog box.

   Type a name for the filter, see Figure 123, and click OK. The name of the new filter is displayed in the Configurable Filters list, and you can start configuring it by adding aspect categories to be included in the filter.
5. Click Apply to save the changes.

6. Verify the filter configuration by browsing in different structures and check that only the configured aspect categories are listed in the Aspect list area.

   Default aspect filters can be set for users and user groups.

**Submenu Configuration**

By using submenus it is possible to group information in the object context menu and/or expand information from the Aspect Context Menu to the Object Context Menu.

For example, if an aspect has three views, you can select a specific view directly from the object menu. These types of adaptations made to the context menu can be enabled per user and/or workplace.

The adaptations are specified via the Workplace Settings Profile Values aspect located on the workplace object and/or the user object.

Adaptations specified on a Workplace object override settings on a User object and the settings defined in the Workplace Settings Profile Values aspect. In the Workplace Settings Profile Values aspect it is possible to define settings for all users.

**How to create a Submenu**

The steps below shows an example of how to group aspect categories and create a submenu with its instances for a specific user.
1. Select the user object and add a Profile Values aspect and call it **Workplace Settings Profile Values**.

2. The Profile Definition Selection is displayed. Select **Workplace Object/Workplace Settings Profile Definition**. See Figure 124.

![Profile Definition Selection Dialog Box](image)

*Figure 124. Profile Definition Selection Dialog Box*

3. Click **OK**.

4. In the Profile Values dialog box (see Figure 125):
   - Select **Group Aspects** in the **Names** list
   - Select **Local** in the **Datasource** area
   - Select **OnDemand** in the **Mode** drop-down menu.

<table>
<thead>
<tr>
<th>Normal (Default)</th>
<th>Aspects are not grouped according to category.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExplicitOnly</td>
<td>Only those categories that have been enabled for this adaptation are grouped into a submenu. (Adaptations specified by the aspect always override settings made on the aspect category.)</td>
</tr>
</tbody>
</table>
5. Click **Apply**.

6. To see the result, open a context menu for a process object in a graphic display. See **Figure 126**.
Figure 126. Example of a Submenu
Workplace Settings Profile Configuration

The Workplace Setting Profile Definition is created using the Profile Values aspect. Click the Profile Values aspect and the Profile Definition Selection dialog appears.

Select Workplace Object/Workplace Settings Profile Definition and click OK. This displays the view as shown in Figure 128.
Figure 128. Config View of Workplace Settings Profile Definition
The following are the different profiles available for the workplace object:

- **EnableLogover** - This determines if the user interface for Logover should be enabled or not.
- **Expand Views in Context Menu** - This specifies the method to expand the views in context menu. To update the value, select **Local** in the **Datasource** area. Select a value from the available list in the drop-down appearing to the right of this dialog.
- **Expand Verbs in Context Menu** - This specifies the method to expand the verbs in context menu. To update the value, select **Local** in the **Datasource** area. Select a value from the available list in the drop-down appearing to the right of this dialog.
- **Group Aspects** - This controls the method to group the aspects of same category into separate sub menus. To update the value, select **Local** in the **Datasource** area. Select a value from the available list in the drop-down appearing to the right of this dialog.
- **Group Verbs** - This controls the method to group the verbs belonging to the same aspect into separate sub menus. To update the value, select **Local** in the **Datasource** area. Select a value from the available list in the drop-down appearing to the right of this dialog.

---

**Workplace Settings Icon Configuration**

The Workplace icon settings allow to configure different sizes for the Application bar, the Display bar and the Status bar icons. This enables configuration of toolbar icons suitable to the need of the workplace. For example, Medium sized icons may be suitable for an extended operator workplace.

Following are the toolbar icons sizes (See **Figure 129**):

- Small-Classic (16x16 pixels with existing 800xA icons)
- Small (16x16 pixels with System 800xA new icons)
- Medium (24x24 pixels with System 800xA new icons)
To configure the icon size, follow the steps:

1. Right-click the Workplace object from Workplace Structure > Web System Workplace, System Workplace and select New Aspect from the context menu. The New Aspect dialog box appears.

*Figure 129. Toolbar Icon sizes - Medium, Small, and Small-Classic*
2. Select **Profile Values** from the list.

3. Enter a name for the aspect and click **Create**.

![Profile Values aspect](image)
4. Right-click on the new profile value aspect created for the workplace and select **Config View** from the context menu. The **Profile Definition Selection** dialog appears.

![Profile Definition Selection dialog](image)

*Figure 132. Profile Definition Selection - Icon Setting*

5. Select **Workplace Object / Workplace IconSetting Profile Definition** and click **OK**. The **Profile Values** dialog appears.
Figure 133. Profile Values - Icon Support Rules

6. Select **Local** datasource for the base rule in the **Datasource** area.

7. Enter the preferred icon style in the text box. For example, Small. Click **Apply** to save the changes.

Launch the configured workplace to see the changes.
User Profile Configuration

To make it easier for each user to access the information they need, you can set up individual profiles for each user. These decide which type of information that will be displayed. This means that all users can get fast access to the information they need frequently.

The User Profile values are set on the Workplace Profile Values aspect (see Figure 134) for each user in the User Structure.

Settings in the Profile Values Dialog Box

Below are the different settings in the Profile Values dialog box described.

![Workplace Profile Values Dialog Box]

Figure 134. Workplace Profile Values Dialog Box
Names List

In the Names list, you can see which different settings that can be made for the user. Depending on the type of Profile Values aspect you have selected different settings are available.

Some of the available settings are:

**Default Workplace.** It is possible to decide which workplace will be default in the default system. See also Create and Configure an Operator Workplace on page 15.

**Default Environment.** See *System 800xA Engineering, Engineering and Production Environments (3BSE045030*)*.

For more information on Replace Pinned Overlap, refer to Replacing Pinned Overlap on page 102.

**Plant Explorer Settings.** With Plant Explorer settings you can configure how the Plant Explorer will behave and present data. You can set a default aspect filter, a default structure, make settings for the aspect list and the name composer.

The settings are made on the four tabs, in the dialog box.

- **Default Filter**
  In the drop-down menu, you can select which aspect filter you want to be the default filter for the user.

- **Default Structure**
  Use the drop-down menu to set a default structure to be displayed in the Object tree view area at start-up. All browse dialogs will start in this structure (e.g. Add/Edit dialogs).

- **Aspect Columns**
  The list on this tab shows all aspect columns that can be displayed in the aspect list. Use the lists to set the columns to be included in the user’s aspect list. (If the Auto select check box is selected in the dialog box, the most recently selected aspect will automatically be selected when an aspect list is displayed.)

- **Name Composer**
  Under this tab, you can configure the way in which names of objects will be
presented in the aspect browser of Plant Explorer. You can select which object attributes to be presented as well as determine the formatting. Free text strings can be included. The default setting is %Name%, %Type Name%, which displays the name of the object followed by the name of the object type.

**Replacement Strategy.** This setting decides the navigation strategy in the system. Enter Replace or Preserve in the text field.

**Workplace Start Object.** It is possible to choose which aspect, added to the workplace object that will be the Startup Display. For more information, read Configure the Default Startup Display on page 43.

**Default Inheritance Structure.** It is possible to select the structure in which the parent objects are searched for the Display Bar shortcut aspects.

**PG2Print.** This setting is used to enable the PG2 Print screen.

**Performance Checking**

The profile values **Performance Check, VMSize, TimeLimit**, and **SamplingInterval** are related to performance checking.

**PerformanceCheck.** This setting enables monitoring of virtual memory on the workplace application. For more information on performance, refer to Workplace Performance Monitoring on page 168.

**VMSize.** This setting specifies the Virtual Memory Size threshold value in MB. The default value is 2800 MB.

A warning message is displayed when the workplace application memory exceeds the specified threshold value.

**TimeLimit.** This setting specifies the total time (in seconds) to collect samples at a frequency specified in SamplingInterval.
**SamplingInterval.** This is a time interval in seconds, to monitor the virtual memory.

**Replace Overlaps on Different Screen.** Enabling this profile value produces the following behavior for overlaps on a multiple screen workplace, when the screen trait for the respective view class is not set or the value of the screen trait is 0.

1. With the **Replacement Strategy** set to **Replace**, open an overlap of any view class (for example, a Faceplate) and move the overlap to another monitor.

2. Go back to the original screen and open another overlap of the same view class (for example, a Faceplate). This will replace the overlap that was first opened in Step 1.

If this profile value is not enabled, the normal behavior of overlaps on a multiple screen workplace is produced.

1. With the **Replacement Strategy** set to **Replace**, open an overlap of any view class (for example, a Faceplate) and move the overlap to another monitor.

2. Go back to the original screen and open another overlap of the same view class (for example, a Faceplate). This will open a new faceplate on the original screen or the screen mentioned in the screen trait of the corresponding view class if the screen trait value exceeds 0.

Enabling this profile value will not have any effect if the Screen Trait of the respective view class is set (that is, greater than 0), because the precedence is given to the Screen Trait value.

**Workplace Performance Monitoring**

To monitor the performance:

1. Select the required user from the **User Structure**.

2. In the **Workplace Profile Values** aspect, select **PerformanceCheck** from the **Names** list.

3. Select **Local** in **Datasource** and select the **Value** check box.

4. Modify the other profile values (that is, **VMSize**, **TimeLimit**, and **SamplingInterval**) if required.
5. Restart the workplace after updating the profile values.

**TimeLimit** specifies the total time to collect samples for each **SamplingInterval** duration.

For example, for a **TimeLimit** of 30 seconds and **SamplingInterval** of 5 seconds, a total of 6 samples are collected. A warning message appears if the all values of the collected samples exceed the Threshold Value.

**Note**: Even if one collected sample is less than the threshold value, the warning is not displayed.

The warning message appears as a performance notification.

A System Message is logged for the first time and for every one hour, from then on when the Threshold Value is crossed by every sample collected during the **TimeLimit**.

Click the performance notification ![Performance Monitor](image) and the **Performance Monitor** dialog appears.

![Image of Performance Monitor](image)

*Figure 135. Performance Monitor*

Click **Continue Working** to continue the work.

Click **Restart the Workplace** to restart the workplace.

Click **Create Error Report** to create a dump file. By default, the file is placed in \C: \OperateITData \Temp \Dump \Hang.
Rules List

It is possible to add and delete nodes in the Rules list. For example; you want to use the default Workplace on every node except one special node. Add that node by clicking the Add button and use the browser to select desired Workplace. Click Apply.

Datasource and Update Mode Area

In the Datasource area you can select which settings you want for your profile. Select Default to use the default settings defined in the system’s Profile Definition. If you want to define and use your own settings, select Local. The Indirect from radio button gives you the possibility to choose definitions set by another user, for example the operator. Select Indirect from and use the browser to select desired user profile in the Object Name field.

In the Update Mode area two check boxes are available; Update Enable and Update local. If the Update Enabled button is selected, it is possible to make changes on the selected item. In the Object Name area the name of the default Workplace is shown. You can change it with the Browse button.

Configuring User Access to Structures

This section describes the procedure to configure access for the users to different structures in the workplace.

Execute the following steps to set the user access:

1. Select the required object (for example, Admin Structure, Aspect Category) from Aspect System Structure > Basic Property Aspects > Basic Property Structure.

Select the Aspect Category Definition aspect.
2. Click the **User Role Bindings** tab.

---

**Figure 136. Preview of Aspect Category Definition**

**Figure 137. User Role Bindings tab**
3. In the grid, select the **Index** to assign the user role.

   The **Read** index controls the visibility of a structure. For example, in the **Admin Structure, Aspect Category** object, select **System Engineer Role** for **Read** index. Only the users having this role can view the structure in the workplace.

4. In **User**, select the user role to be assigned for the selected index.

5. Click **Apply** to save the changes.

   Click the **Permissions** tab to select the required permissions to be assigned for each operation.

---

**Import/Export of Workplace**

When exporting a Workplace without dependencies make sure to export the Logical Color Definition aspects placed on the Web System Workplace object if they have been modified or added.
Section 3  Alarm and Event

Introduction

An Alarm system is an important element in almost all modern operator interfaces to industrial plants.

Alarms are signals announced to the operator by an audible sound, some form of visual indication, and/or with a message of some kind. The alarm indicates a problem and the purpose is to direct the operator’s attention towards plant conditions, so the user can correct potentially dangerous situations in time.

There are two types of alarms and events.

- Process Alarms and Process Events are generated from your process, such as failure in a valve or pump or an overpressure in a tank.
- System Alarms and System Events are generated from the 800xA System, for example network problems, file system errors or server errors.

This section describes how to change the presentation of an alarm and event list. That is you should decide what the lists should look like; how many columns should be included, which colors should be used, in what sort order should the alarms appear and so on.

For more information on creating Alarm and Event Lists, refer to System 800xA Configuration (3BDS011222*).

Configuration

When configuring an Alarm and Event List, you decide how the list should be presented for the operator. You decide how many columns it will include, which color will be used, in what sort order will the alarms be presented and so on.
This section describes how to use an Alarm and Event List Configuration aspect as provided in the Library Structure in the Plant Explorer, but it can also be your own customized Alarm and Event List Configuration. Configuration requires the Application Engineer role.

A configuration aspect defines the layout and filter parameters of a list and may be associated with a number of Alarm and Event List aspects. A customized list can be saved with a descriptive name in the Library Structure with other default configurations or within another structure (usually where it is used). Working with lists, the presentation of the view can be modified and the default configuration restored as required by the operator.

The following configuration possibilities of the Alarm and Event List aspect are described below:

- Setting Sort Order
- Setting Colors
- Setting Column Options
- Setting Date/Time and Alarm Status Format in Lists
- Setting Toolbar Format
- Summary Information
Changing the Presentation of an Alarm and Event List

1. Select the Alarm and Event List Configuration aspect in the Library Structure which you want to modify (see Figure 138). It is recommended to make a copy of the original list and modify the copy.

![Figure 138. Default Alarm and Event List Configuration](image)

The selected list presentation can also be changed by selecting the View Configuration button in the toolbar of the list, see Figure 139.

![Figure 139. Alarm List Tool Bar - View Configuration Button](image)

2. Open the Config View of the aspect. A dialog box with several tabs (five are described in this section) will be displayed:
   - Columns
   - Sort
Setting Column Options

The Columns tab see Figure 140, is used to configure the header names as well as what column headers will be shown, and in what order and size. It is also possible to decide whether the row and column headers will be shown and how many messages per page that will be shown in the list.

The number of decimals and horizontal alignment functionality is available from System 800xA 6.0.3 and later versions. This functionality is used to customize the alarm list and event list. Any changes made for the alarm list and event list will also reflect when printing the alarm list and event list. This functionality is also available for alarm logger.

Number of decimals: It is used to configure the number of decimals to show in the alarm list and event list for attributes with decimal values. By default six decimals will be shown.

Horizontal alignment: It is used to configure the horizontal alignment for each column in the alarm list and event list. By default the columns will be left-aligned for all columns except for columns that shows decimal values, which will default to be right-aligned. Horizontal alignment for AckState, EnableState and GroupAlarm columns cannot be configured and these columns will always be center-aligned.
Section 3  Alarm and Event  Changing the Presentation of an Alarm and Event List

Selecting Message Fields for Display
Add or delete columns from the Message Layout area by selecting or clearing one of the Message Fields attributes. When an attribute is selected, it is added to the list. If it is cleared, it is removed from the list.

Setting Order of Columns
Move a column by dragging it to the proper position within the Message Layout area.

Changing Column Header Names
Select the row to be changed and then click on the column header name.

Figure 140. Columns Tab
Changing the Presentation of an Alarm and Event List  Section 3  Alarm and Event

An edit box will appear, where you can change the name. The customized name appears in the column heading. Another way to change the name is to select the cell to be changed and then press <F2>.

– **Changing Column Size**
  Select the row to be changed and then click on the column width. An edit box will appear, in which you can change the size. It is also possible to change the width by dragging the columns to the right size in the **Message Layout** area.

– **Show Row Headers/Column Headers**
  Use the check boxes at the bottom of the dialog box to show or not show Row or Column Headers.

– **Viewable Messages**
  Enter a number, 1 to 500, in the **Viewable Messages** text field to set how many messages that shall appear in the list.

– **Changing Font**
  Click **Change...** in the **Font** area to change the shape of the font.

– **Wrap Text**
  To view long alarm messages without missing any information, select the **Wrap Text** check box to split the alarm messages into several rows.

  The wrap text check box applies to any column (not just message) where the text does not fit into the column width.

– **Print**
  Select the check box corresponding to the columns to be printed. Only the selected columns will be visible while printing the alarm list.

**Configure Number of Decimals and Horizontal Alignment**

For alarm list and event list the configuration is performed in Alarm and Event List Configuration aspects and for alarm logger the configuration is performed in Alarm and Event Logger Configuration aspects.

The default value (6 decimals) can be changed for alarm list, event list and alarm logger. For alarm list and event list this is performed in the Library Structure on the Alarm & Event List Configurations object’s **Alarm & Event List Global Settings**
aspect. For alarm logger it is performed in the Library Structure on the Alarm & Event Logger Configurations object’s **Alarm Logger Global Settings** aspect.

**Configure Number of Decimals**

- **Default number of decimals**: When changing the global default number of decimals it will affect all unchanged decimal attributes in the system. By default the value is 6, but it can be changed through this setting. This works equal for alarm list, event list and alarm logger.

- **Alarm and Event List Configuration aspect**: Under the Columns tab in Alarm and Event List Configurations aspects Alignment and Decimals are available in the Message Fields area (see Figure 140). The Decimals column shows N/A for any non-decimal attributes and it is not possible to change it. **Default** will be shown for a decimal attribute if the number of decimals has not been specifically configured for the attribute. If the number of decimals is changed for an attribute and the default value is changed afterwards this will not affect the changed attribute.

**Configure Horizontal Alignment**

The horizontal alignment is configured in the Columns tab in the Alarm and Event List Configuration aspect and in the Alarm Logger Configuration aspect. The current alignment can be changed by pressing the combo box and select preferred alignment. It is not possible to change the alignment for some attributes which are defaulted to “Center” (see Figure 140).

**Setting Sort Order**

Use the **Sort** tab (Figure 141) to set the alarm lists default sort order. It is possible to set three sort order criteria for the alarm/event messages.

Select sort order attribute in the drop-down menu for each of the sort order criteria. All attributes supported by the OPC Server are available in the drop-down menus. The user can also specify if the sorting should be done in **Ascending** or **Descending** order.
Select the **Reverse sorting each page** check box to reverse the sort order within each alarm page. This does not affect the alarm page order.

![Figure 141. Sort Tab](image)

**Setting Colors**

**Alarm Color Definition Aspect.** The Alarm Color Definition aspect is used to configure the colors of the alarms in the alarm and event list. Open the Config View of the aspect to be able to configure the colors. A dialog box with two tabs will be displayed; the **General List Colors** tab and the **Priority colors** tab.

The **General List Colors** tab, see Figure 142, is used to configure the general colors for the alarm and event list.
When you click on a color button in the Alarm Color Definition Aspect dialog box the Logical Color dialog box will appear, in which you select the color for the above mentioned settings.

- In the **List Single Colors** area you define the text and background color that will be used for all alarms.

- In the **List Alternating Background Colors** area you specify which background colors that will be alternated when alarms are displayed in the alarm and event list. This setting only applies when you have selected Alternate Colors in the Colors tab in the alarm and event list configuration, see Figure 145.

- With the **List Background Color** button you specify the background color for the alarm and event list.
– With the **Hidden Indicator Color** button you define the color for the hidden alarms.

For information about Logical Colors see **Configuring Color Settings with Logical Colors** on page 138.

The **Priority colors** tab is used to configure the text and background color for alarms of different priorities.

---

**Figure 143. Priority Colors Tab**

To select color for the **ActiveUnackedText, ActiveUnackedBg, ActiveAckedText, ActiveAckedBg, InactiveUnackedText, InactiveUnackedBg, InactiveAckedText, InactiveAckedBg, Hidden Text, HiddenBackground, ShelvedText and ShelvedBackground** columns click on the respective box, which you want to set color for. The Logical Colors dialog box will appear with predefined color groups. It is also possible to drag a color from one cell to another.

To set one color for a whole column you just click the column header and select the desired color from the Logical Color dialog box.

If the you select the **Preview** check box you can see how the colors look like in the alarm and even list, see **Figure 144**. When in preview mode it is not possible to change color.
Section 3  Alarm and Event

Changing the Presentation of an Alarm and Event List

The Color tab is used for specifying the color definition that the list configuration should use. See Figure 145.

If you want to modify the printout color for an alarm list or an event list open the file C:\Program Files(x86)\ABB 800xA\Base \ config\ printercolors.map in notepad and follow the instructions.

**Color Tab.** The Color tab is used for specifying the color definition that the list configuration should use. See Figure 145.
In the **Text Color Options** area, select **Use All Colors** if the alarm list should use all text colors defined in the Alarm Colors Definition aspect. Select **Use Single Color** if only one color should be used.

In the **Background Color Options** area you define the background color behavior.

- Select **Use All Colors** to use all colors defined in the Alarm Colors Definition aspect.
- Select **Use Single Color** to use one background color.

*Figure 145. Color Tab*
Select **Alternate Colors** to alternate between two background colors. This is enabled if **Use Single Color** is selected in the **Text Color Options** area.

Select the **Use separator between groups** check box to display a thin line between the grouped alarm lines. This check box is grayed out if **Use All Colors** is selected.

In **Stripe the lines in groups of**, enter the number of alarm lines to be grouped. By default, the value is 1. This is grayed out if **Use All Colors** is selected.

The settings **Alternate Colors**, **Use separator between groups**, and **Stripe the lines in groups of** define the background colors used on the alarm lines and do not follow an individual alarm. The striped lines or separators are fixed in their position. The alarms are automatically moved up or down the list based on the occurrence of new alarms or shelving or hiding of existing alarms. Therefore, it is recommended to use these settings on lists that have stable content as it improves readability.

### Setting Date/Time and Alarm Status Format in Lists

The **Format** tab, see **Figure 146**, is used for configuring the date and time format from the listed format options and to configure the alarm status format to be shown in the status bar.

In the drop-down menus a set of predefined format options are available. If you want to type your own formats, conventions will be presented if you click the help button for respective list.

Use the same time separator as defined in **Windows Regional Options**, to be able to copy data to other applications such as Excel.
Setting Toolbar Format

In the **Toolbar** tab, select the required options that must appear as an icon in the Alarm and Event List toolbar. Select **Show All** and click **Apply** to add all the options, including any new options as a result of new updates to the 800xA System,
in the toolbar. Deselect **Show All** to select/deselect the options to customize the icons in the toolbar and click **Apply**.

![Figure 147. Toolbar Tab](image)

### Summary Information

The **Summary** tab displays a summary of your configuration.
Figure 148. Summary Tab
Alarm Response Navigation

The Alarm Response Navigation feature allows the operator to navigate quickly different aspects from an object. The following are the features of Alarm Response Navigation:

- Quick navigation to single or multiple aspects using the object context menu or through the Alarm and Event List.
- One time configuration or detailed configuration to enable quick navigation for all types of objects or for an object or object instance respectively.

For more information on navigating different aspects, refer to System 800xA Operations (3BSE036904*).

Configuring Alarm Response Navigation

The Alarm Response Navigation feature allows the user to configure up to four aspect objects.

To enable the Alarm Response Navigation feature:

1. Select **Alarm Response Settings** from **Workplace Structure > Web System Workplace > Plant Explorer Workplace**.

2. Select the **Enable Alarm Response Navigation** check box (See Figure 149).

When uploading an **Alarm Response Navigation** aspect to a subscriber system using Multisystem Integration, the structure in which the aspect exists must be retained on the uploaded system. This is important if the navigation mode (see **Alarm Response Navigation Global Settings tab**) is set to **Path & Category** or **Path & Name** because the navigation is done relatively to the object where the **Alarm Response Navigation** aspect exists.

For more information on Multisystem Integration, refer to System 800xA Multisystem Integration (3BSE037076*).
Global Settings

By default, the Alarm Response Navigation feature is configured through the Alarm Response Settings aspect in Workplace Structure > Web System Workplace > Plant Explorer Workplace (see Figure 149).
Alarm Response Navigation Global Settings tab. The Alarm Response Navigation Global Settings tab is used to configure the Alarm Response Navigation entries which describes how the aspects can be resolved in relevance to an object.

The entry can be configured in the following ways;

- **References** (Aspect Category navigation)
  
  In this mode of navigation, specify the aspect category name in Aspect Category. If an aspect corresponding to the specified aspect category does not exist on the object, all the aspects in which this object is referenced, is searched.
  
  If an aspect corresponding to specified aspect category exist, navigation is done to this aspect.

- **Path & Category** (Object path aspect category navigation)
  
  In this mode of navigation, specify a relative name server syntax string in Object Path and an aspect category name in Aspect Category. Using the specified object path, the required object is located. If this object contains an aspect corresponding to the specified aspect category, navigation is done to this aspect.

- **Path & Name** (Object path aspect name navigation)
  
  In this mode of navigation, specify a relative name server syntax string in Object Path and an aspect name search pattern in Aspect Category. Using the
specified object path, the required object is located. If this object contains aspect with a name matching the specified aspect name pattern, navigation is done to that aspect.

- **Disabled**

  Navigation is not done for this mode.

Click on Object Path to open a help text that lists examples on how to specify the object path.

**Aspect Type Mappings tab.** The Aspect Type Mappings tab is used for the configuration of aspect type groups. Aspect types can be added or removed from an aspect type group.

In the Alarm Response Navigation Global Settings tab, a specific aspect category must be selected for the navigation when the Mode is set to Path & Category or References. In the Aspect Type Mappings tab, the user can select one or more aspect categories to be grouped into an aspect type group.

When the specified aspect category (configured when the Mode is set to Path & Category or References) is not found on the target object, the aspect type groups are searched for the aspect type of the specified aspect category.

If the aspect type is not found in any aspect type group, no navigation is done. Otherwise, the following search algorithm is applied.

1. A search is made on the target object to find an aspect of the same aspect type as the specified aspect category. If found, navigation is done to this aspect and the search ends.

2. A search is made on the target object to find any other aspect of the other aspect types configured in the aspect type group. If found, navigation is done to this aspect and the search ends.

If no aspect is found using the two methods, no navigation is done for the corresponding alarm response entry.

By default, three aspect groups, Graphic Displays, Faceplates, and Trends are defined.
This section describes how the mapping is done between aspect categories included in an aspect type group.

For more information on specifying the navigation entries, refer to Alarm Response Navigation Global Settings tab.

- **References** (Aspect Category navigation)
  
  A list of aspects referencing the current object is retrieved. Each aspect in the list of aspects is verified to find an aspect of the selected aspect category.

  If a match is found, the aspect reference is added to the list of resolved aspect references.

  Otherwise, the aspect category of the aspects found, is compared to the selected aspect category. In the Aspect Type Mappings tab, if these aspect categories are mapped in the same aspect type group, the aspect reference is added to the list of resolved aspect references.

- **Path & Category** (Object path aspect category navigation)

![Aspect Type Mappings tab](image)
If the Object Path is specified, navigation is performed according to the path description. If an object is found, the aspect corresponding to the specified aspect category is retrieved.

If a match is found, the aspect reference is added to the list of resolved aspect references.

If an aspect corresponding to the specified aspect category does not exist, and the specified aspect category is mapped to an aspect type group in the Aspect Type Mappings tab, the object is searched for aspects of this aspect category.

If this aspect type group contains other aspect categories, the aspects are searched in these aspect categories. If a match is found, the aspect reference is added to the list of resolved aspect references.

- **Path & Name** (Object path aspect name navigation)

  If the Object Path is specified, navigation is performed according to the path description. If an object is found, the aspects are matched against the specified aspect names. If a match is found, the aspect reference is added to the list of resolved aspect references.

**Adding an Aspect Type Group:** To add a new aspect type group:

1. In Group, click Add.

2. In Name, enter a name for the group. By default, the name appears as GroupX where X can be 1, 2, and so on.

3. The available aspect categories are displayed in Available Types.

   To add an aspect category to the group, select the required aspect category in Available Types and click to add to the Selected Types list.

**Object Settings**

To override the default setting of the Alarm Response Navigation feature (described in Global Settings), add the Alarm Response Navigation Object Settings aspect to an object type or an object.

The default setting is overridden only on the objects that have the Alarm Response Navigation Object Settings aspect created directly on the required object or inherited from an object type.
Select the **Override** check box corresponding to a navigation entry. This will override the navigation entries specified in the **Alarm Response Settings** aspect.

**Figure 152. Alarm Response Navigation Object Settings aspect**
Section 4 Trend

Trend Configuration

The Trend System displays history data graphically. The history data and run-time data are seamlessly integrated.

A Trend Display example is shown in the figure below:

Figure 153. Trend Display Example
The Trend Aspect System defines two Aspect Types, the Trend Template and the Trend Display. Read about Trend Template on page 198 and Trend Display on page 201.

**Trend Template**

A Trend Template is a re-usable template for building many similar trend displays. If you modify an existing Trend Template, the changes will not automatically affect existing Trend Displays that has been created using that Trend Template. If you click **Reset to Template** any changes made in the Trend Display will be overwritten with the changes made in the Trend Template.

Settings that are affected are those that you can not change in your existing trend display, such as number of areas and configurable rows, trace colors and Hide/Show Table. For more details see Trend Configuration Details on page 208.

**Default Trend Templates**

There are two default trend templates available; The Advanced Trend Template and the Standard Trend Template. See Figure 154.

<table>
<thead>
<tr>
<th>Legend</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Trend Area</td>
</tr>
<tr>
<td>2</td>
<td>Trend Toolbar</td>
</tr>
<tr>
<td>3</td>
<td>Trend Table</td>
</tr>
</tbody>
</table>

The Trend Aspect System defines two Aspect Types, the Trend Template and the Trend Display. Read about Trend Template on page 198 and Trend Display on page 201.

**Legend**

- 1: Trend Area
- 2: Trend Toolbar
- 3: Trend Table

**Figure 154. Default Trend Templates**
Create a New Trend Template

Follow the steps below to create a new Trend Template aspect:

1. Expand the Library Structure
2. Select the Trend Templates, and create a new object.
3. In the New Object dialog box, select the Trend Template Library. Give the object a name and a description and click Create.
4. Select the new Trend Template Library object and select New Object from the context menu.

5. Select Trend Template. Give the new object a name and a description, and click Create.

Figure 155. Mark Trend Template Library
6. Select the created object in the object area, and select the Trend Template in the aspect list.

7. Customize the **General**, **Details** and **Columns** tabs in the Trend Template Aspect. For more details see **Trend Configuration Details** on page 208.
Follow the steps below to create a Trend Display aspect:

8. Click **Apply** when all changes are done.

**Create a Trend Display**

Follow the steps below to create a Trend Display aspect:
1. A Trend Display can be created in any structure. One proper structure is the Functional Structure.

![Select Structure](image)

*Figure 159. Select Structure*

2. Select the place where you want to locate the Trend Display and select **New Aspect** in the context menu.

![Create New Aspect](image)

*Figure 160. Create New Aspect*

3. In the New Aspect dialog box, select the Trend Display aspect. Give the aspect a name and a description. Click **Create**.
Note that there exist three different aspect categories of Trend Displays, the Operator Trend, the Trend Display and the Object Trend. The difference between them is the user roles required to modify them:

- Operator Trend - require operator role
- Trend Display - require application engineer role
- Object Trend - require software developer engineer role

![New Aspect Window]

**Figure 161. Create Trend Display**

4. Select the created aspect in the aspect list.

![Aspects of Trend Display]

**Figure 162. Select Trend Display Aspect**
5. The created Trend Display aspect will look like the figure below:

![Trend Display](image)

**Figure 163. Trend Display**

6. The created Trend Display uses the default Trend Template. To use the Trend Template created in the section *Trend Template* on page 198, you must select it in the Config View.

![Config View](image)

**Figure 164. Config View**
7. In the Config View you select wanted Trend Template from the Trend Template drop-down list.

![Trend Template Selection](image1)

**Figure 165. Select another Trend Template**

8. Return to the Trend Display Main View.

9. To insert an object, make one of the following actions:
   - Click in the **Object Name** column and type the object name. (Or enter a **dot**)
   - Select a signal from the **Select Object** overlap dialog box.
   - Drag the object and drop it in the **Object Name** column.

![Select Object Dialog Box](image2)

**Figure 166. Select Object overlap Dialog Box**
10. Select Aspect, Property and Log Name from the drop-down menus. If needed change the other columns as well.

Figure 167. Select Trend Display Log

If you are not selecting an aspect in the Aspect Name column (see Figure 167), all properties for the selected object will be listed.

Press <Shift> while selecting property in the Property selection column (see Figure 167), then only logged properties will be displayed.

If you are not selecting a Log Name, SEAMLESS will be selected by default (see Figure 167).

For more configuration information see Trend Configuration Details on page 208.

XY-Plot

An XY-plot is a trend that uses a trend variable instead of time on the X-axis. It draws one analog signal as a function of another analog signal (instead of plotting it as a function of the time).
The size of the XY-plot End Marker can be changed. Open the Trend Template aspect and enter wanted End Marker size in the End marker size area. See Figure 169.
Background Image

A background image can be shown on XY-plots. Two images can be configured in the template, but there is also a possibility to add pictures in the configuration view of the Trend Display aspects. See the section about Trend Display Configuration Details on page 225, for more information about how to configure the pictures.

Trend Configuration Details

In this section all selections for the Trend Configuration Details aspect are described in detail.

The Trend Template Configuration Details aspect has three tabs:

- General Tab
Section 4  Trend

Trend Configuration Details

- Details Tab
- Columns Tab

General Tab

Figure 170. General Tab in the Trend Configuration Details Aspect

The General tab includes the following areas:

- Trend view area
- Table area
- Trend areas
- XY-plot area
- Time scopes area
- Table Font area
Trend Configuration Details

Trend view area.

The **Default View** field defines which view to show when the Trend Display aspect is opened. This can be set to Main, Top, Left, Right or XY-plot View. The Scroll position value indicates how far (in percent of whole width) from the right edge to draw the curve. Allowed values are 0-20.

Select the **Refresh when zooming** checkbox to automatically update the traces in a trend during a zoom operation by refetching the data for the new time span. In the previous versions of 800xA system, the user should press <Shift> during the zoom operation to update the traces.

By default the **Auto-Scroll on Scroll Position** is enabled. This improves the performance of plotting in trend display.

Table area.

The **Size** field indicates how many rows that will be displayed in the table part of the Trend Display. There is no virtual limit for the number of traces.

The **Visible** check box indicates if the table part of the Trend Display will be visible or not. The **Update Rate** text field specifies the update rate of trim traces in the Trend Display.

The **Left/Right View** indicates the percentage view of the trend table with respect to trend display in left and right view. This range is limited from 5% to 95%.

Trend areas.

The number displayed in the **Count** field, is the number of trend areas displayed in the Trend Display. You must set the Sizes (height) of each trend area.

XY-plot area.

The **End Marker Size** field is used to configure the size of the XY-plot End Marker. The XY-plot background pictures are used to configure which pictures to use as
background. Note that pictures also can be configured on the Config View page of the Trend Display aspect.

**Time scopes area.**

The Time Scopes area defines the time scopes that are selectable (by default) in the Trend Display. The marked time scope is used when your Trend Display opens. To make a new selectable range, mark an existing range, modify the numbers of Years, Months, Days, Hours or Minutes and click **Add**.

To Replace or Delete an existing range, do that in the same way as for Add, but click the dedicated button.

Note that at least one time scope must be defined.

When changes are made, click **Apply** to make the changes take effect. **Cancel** resets all changes since the last **Apply** was given.

**Table Font area.**

The Table Font area defines the Font, Font style and size of the text in the Trend Table.
Details Tab

The Details tab includes the following areas:

- Grid Lines area
- Trend Display colors area
- Trace Properties area

**Grid Lines area.**

The Grid Lines configuration allow you to enter the number of Major and Minor Ticks that will be displayed in the Trend Display. By selecting the Show lines for minor ticks check box, you to decide weather or not to show minor tick lines.

*Figure 171. Details Tab*
Trend Display colors area.

You may change color on Background, Table, Trace area, Grid and Axis. Click in the relevant field to change the color. The Select Logical Color dialog is displayed (see Figure 172) where you can select the required color. By default the Trend Colors set is selected.

Select the required color in Alarm State to indicate that the object corresponding to a trace is in Alarm State. This is recommended for Analog type objects which contain a signal to connect the object to an Alarm State.

Also, click the Alarm Coloring column to enable or disable the alarm coloring for each trace.

For more information on configuring the Alarm State to a signal, refer to System 800xA Configuration (3BDS011222*).

If you want to use another color set, open the drop-down list (see Figure 173), and select the color set you want to use.

Figure 172. Color Select Dialog Box
The Number of traces in the Trend Display can be set. You can also select whether to have Trace identification numbers in the trend. The possible values are None, Above, Center or Below (see Figure 171).

You also have the option to Enable binary display of binary signals. If Sort binary area check box is selected, the binary signals are drawn below the other curves (see Figure 173).

If you want to modify the printout color for a trend display, open the file printercolors.map in a notepad and follow the instructions provided in the file. This file is located in C:\Program Files (x86)\ABB\800xA\Base\config.

Figure 173. Color Select Set Drop-Down Menu
Figure 174

Figure 174. Binary Traces

The Use Y Buffer option ensures that filled curves does not hide each other (see Figure 175).

Figure 175. Y Buffer

The Min axis text size and Max axis text size are used to define the text sizes on the left and right axis. The text is never smaller than Min text size and never larger than Max text size.
Click the **Color** column to open the **Color Select** dialog box (see Figure 172) to select the color to be used for the trace.

Click the **Axis** column to decide on which side the scaling will be shown, left or right.

To specify in which Trend Area a trace will be displayed, click repeatedly in the **Area** column.

It is also possible to view trends using linear or logarithmic scales. Click the **Axis Type** column to select the required scale.

![Figure 176. Logarithmic Scale](image)

To specify what treatment to use, click the **Treatment** column repeatedly. The available treatments are: Average, Max, Min, Momentary, Sum, Standard deviation, Time average, Max (actual time), Min (actual time), Start, End, and Extended Momentary.

To specify what style to use, click the **Style** column repeatedly. The available styles are: Normal, Linear, Stepped, Filled and Point.

To specify what extrapolation mode to use, click repeatedly in the **Extrapolate** column. The available extrapolation modes are: None, Value and Slope.
Note that you can reverse the selection order by pressing <Shift> while clicking in the Area, Treatment, Style and Extrapolate columns.

**Auto Scaling**

Select the Enable Auto Scale check box to enable auto scaling for the trace.

**Range factor** specifies the percentage of maximum possible range. By default, the value is 3.

**Value factor** specifies the percentage of the height of the visible trace. By default, the value is 20.

**Hysterisis** specifies a range in which the signal values can vary without rescaling.

Use the following algorithm to calculate the automatic scale of the Y-axis.

The required amount of space between the displayed curve
\[
(Spare) = \max \left( \frac{\text{Value factor}}{100} \times (\text{Max Value} - \text{Min Value}), \right.
\]
\[
\frac{\text{Range factor}}{100} \times (\text{Normal Maximum} - \text{Normal Minimum}) \right)
\]

where,

\[
\text{Max Value} = \text{Visible maximum value of the trace.}
\]

\[
\text{Min Value} = \text{Visible minimum value of the trace.}
\]

\[
\text{Normal Maximum} = \text{Normal maximum value of the trace.}
\]

\[
\text{Normal Minimum} = \text{Normal minimum value of the trace.}
\]

The spare value is used to calculated the High Range and Low Range values for the Y-axis.

\[
\text{High Range} = \min (\text{Normal Maximum}, (\text{Max Value} + \text{Spare}))
\]

\[
\text{Low Range} = \max (\text{Normal Minimum}, (\text{Min Value} - \text{Spare}))
\]

Hysterisis is used to stop auto scaling of a trace unless the Max Value and Min Value exceed the values used to calculate the current Y-scale by a defined amount.

The Hysterisis will be expressed as a percentage of the current height of Y-axis:

\[
H = \frac{\text{Hysterisis}}{100} \times (\text{High Range} - \text{Low Range})
\]
To trigger a new auto scale value, the trace value must exceed,

\[ \text{old Max Value} \pm H \text{ or old Min Value} \pm H \]

The variables used in the calculation are set in the Control Connection aspect of a signal. For more information on configuring this aspect, refer to System 800xA Configuration (3BDS011222*).

**Momentary and Extended Momentary.**

When choosing Momentary as Treatment (i.e. the raw data) the trace will only show a maximum of 86400 points even though more data exists.

The Extended Momentary treatment gives the same visual result but does not have this restriction, and it should therefore be used if more than 86400 raw data points needs to be shown in the trend.

**Columns Tab**

The Columns tab includes information about how to customize the Trend Display table columns.
A description of the Columns are found in Table 9. The Name and Width, refer to what and where columns will be displayed in the Table heading of the Trend Display.

To change them, double-click on a row and make the changes in the overlap dialog box. It is also possible to change the width by dragging the columns to the right size in the Column Layout area. After all changes are done you save the configuration by clicking Apply.
Table 9. Trend Display Table Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible</td>
<td>A check box indicating whether the trace is visible or not. Clicking the check box toggles the visible state. This does not enable the <strong>Save</strong> and <strong>Cancel</strong> buttons.</td>
</tr>
<tr>
<td>Status</td>
<td>The data collection status. Logical colors are used to display the data collection status. If something goes wrong with the data, the color of the cell is <strong>trendErrorStatus</strong> (by default red). If everything is OK, the color is <strong>trendNormalStatus</strong> (by default green). While a request for data is in progress the color is <strong>trendRequestStatus</strong> (by default flashing yellow). The logical colors used by trend are defined in the Trend Colors Aspect of the used workplace.</td>
</tr>
<tr>
<td>Trace Color</td>
<td>The color of the respective trace.</td>
</tr>
<tr>
<td>Object Icon</td>
<td>The object icon, which is the same icon that is displayed in the aspect browser. Clicking this cell displays a dialog that allows the user to select the object that is the source of the data.</td>
</tr>
</tbody>
</table>
| Object Name     | The name of the selected object as specified in the name aspect. If the object has been configured to be relative to the object where the Trend Display aspect is placed, this cell shows the path of the object (usually beginning with `.`). It is possible to type an object name or path into a cell in this column. The input will only be accepted if it refers to an existing Object. When the cell is accepting input, the cell also contains a button with three dots. Clicking this button displays the same dialog as when clicking the object icon. If the property column is not part of the configuration, the cells of this column also display the selected property using the syntax `<object>:<property>`.
| Object Description | The description of the selected object.                                                                                                                                                                    |
### Table 9. Trend Display Table Columns (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect</td>
<td>The property aspect of the object that is selected. You can select from a drop-down menu the available property aspects on the object.</td>
</tr>
<tr>
<td>Property</td>
<td>The property of the object which is displayed in the Trend display. In this column, you can select from a drop-down menu the available properties on the object, or type the desired property. If no property aspect is selected the drop-down menu includes all available properties on the object, otherwise only the properties from the selected aspect. It is not possible to select a non-existent property. Non-unique property names are prefixed with the aspect name. If SHIFT is pressed only logged properties will appear in the property drop-down list.</td>
</tr>
</tbody>
</table>
| Log Name   | The log which is displayed for the specified object and property. If no log is selected, data are fetched from different logs to match scope and treatment.  
A drop-down menu shows logs defined by the Log Configuration Aspect. In addition to these, the TRIM log is always available, and if this is selected, a trim trace is displayed for the property. (See also Property column).  
If there is no Log Configuration aspect on the selected object, the user can select TRIM and SEAMLESS.  
If TRIM is selected, the Trend Display will display a trim trace showing only data starting at the time the Trend Display was opened. This data is lost when the Trend Display is closed. |
Table 9. Trend Display Table Columns (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Range</td>
<td>The lowest Y-axis value of the trace. The user can change it by typing another value and press &lt;Enter&gt; or use the arrows. The Low Range can be set in either of:</td>
</tr>
<tr>
<td></td>
<td>• the Object Type.</td>
</tr>
<tr>
<td></td>
<td>• the Object Instance for presentation attribute.</td>
</tr>
<tr>
<td></td>
<td>• the Log.</td>
</tr>
<tr>
<td></td>
<td>• the Trend Display.</td>
</tr>
<tr>
<td></td>
<td>The above listed are in override order. The presentation attributes (max, min, unit, range) configured in the Presentation tab of the Log Configuration aspect will override the values of the attributes in Control Connection / Property Extension information (for General Properties) and will be presented in the Trend Display.</td>
</tr>
<tr>
<td></td>
<td>The override order is explained for the Log Configuration Aspect View in System 800xA Configuration (3BDS011222*).</td>
</tr>
<tr>
<td></td>
<td>The value zero means no override.</td>
</tr>
<tr>
<td>High Range</td>
<td>The highest Y-axis value of the trace. High Range functions similar to Low Range.</td>
</tr>
<tr>
<td></td>
<td>The value zero means no override.</td>
</tr>
<tr>
<td>Time Offset</td>
<td>The time offset used for the trace. The default is zero (0). If this offset is positive, the trace is shifted right. If the offset is negative, the trace is shifted left. The desired offset can be typed by the user. The format used by the cell is yy:mm:dd HH:MM:SS.</td>
</tr>
</tbody>
</table>
Table 9. Trend Display Table Columns (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Filter | The filter value to use. The default is zero (0), indicating no filter. The value must be between zero (0) and one (1), not including one. Only values above 0.5 have a noticeable effect. The filter function is

\[
 dd(f_n) = (1 - filter) \times v_n + filter \times v_{(n-1)}
\]

where \( v \) is the original value at point \( n \) and \( f \) is the new value at point \( n \).

The filter works as a low-pass filter, effecting noise reduction for the trace. The visible result is that the trace appears smoother. The closer this value is to one (1), the stronger this effect will be. With a value very close to one (1), the trace will appear almost flat. See example below.

- filter = 0
- filter = 0.8
### Table 9. Trend Display Table Columns (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>The drawing style selected for this trace. It is possible to change the style by selecting from a drop-down menu of styles. The available styles are shown below.</td>
</tr>
<tr>
<td></td>
<td><img src="linear.png" alt="Linear" /></td>
</tr>
<tr>
<td></td>
<td><img src="point.png" alt="Point" /></td>
</tr>
<tr>
<td></td>
<td><img src="stepped.png" alt="Stepped" /></td>
</tr>
<tr>
<td></td>
<td><img src="filled.png" alt="Filled" /></td>
</tr>
<tr>
<td></td>
<td>In addition to these, there is Normal. If this style is selected, the actual style depends on what is specified for the display mode presentation attribute.</td>
</tr>
<tr>
<td>Ruler Time</td>
<td>The time at the position of the ruler when the ruler is active. If the trace has a time offset, this time will differ from the axis time (and from the other traces).</td>
</tr>
<tr>
<td>Ruler Value</td>
<td>The value at the position of the ruler for each trace when the ruler is active.</td>
</tr>
<tr>
<td>Treatment</td>
<td>The treatment shows how the history server should treat the raw data before sending it to the Trend Display. A new value can be selected from the drop-down menu.</td>
</tr>
<tr>
<td>Mean Value</td>
<td>The average value of the current scope.</td>
</tr>
</tbody>
</table>
Table 9. Trend Display Table Columns (Continued)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extrapolate</td>
<td>The type of extrapolation which is selected. A new value can be selected from the drop-down menu. The meaning of the selections are:</td>
</tr>
<tr>
<td></td>
<td><em>None</em>, no extrapolation of the trace value is done.</td>
</tr>
<tr>
<td></td>
<td><em>Value</em>, the trace is continued from the last point until current time with the same value as the last point.</td>
</tr>
<tr>
<td></td>
<td><em>Slope</em>, the trace is continued from the last point until current time with the same slope as between the two last points.</td>
</tr>
<tr>
<td>Min Value</td>
<td>The minimum value of the current scope.</td>
</tr>
<tr>
<td>Max Value</td>
<td>The maximum value of the current scope.</td>
</tr>
<tr>
<td>Pair Property</td>
<td>The index used for pairing XY plot.</td>
</tr>
</tbody>
</table>

**Trend Display Configuration Details**

The Trend Display Config View is used to:

- Select Trend Template.
- Configure which pictures to use as XY-plot backgrounds (if any).
- Select the XY-plot background picture controlling property.
- Configure the supporting lines for each trend area.
Trend Template

In the Trend Template area you configure which Trend Template to use. The Default Trend Template is found in the Aspect System structure. Read more about default trend templates in the section Default Trend Templates on page 198. View is used to open the trend template. Note that this is disabled for the Default Trend Template.

Figure 178. Trend Display - Config View

XY- Plot Picture Configuration

If some pictures have been configured on the trend template, these are pre-selected in the picture boxes.

If other pictures then the ones configured in the Trend Template should be used these can be added here. Press the “…” button next to the picture selection drop-down list, and a file open dialog box is shown. Pictures added here can also be deleted by using the Delete button.
If pictures are selected in both boxes, a controlling property is used to determine which one to use. First you have to select the object containing the property. This is done by using the "..." button next to the Controlling object text box. The Controlling property drop-down menu is then populated with all binary properties of the selected object, and you have to select one of them.

**Configuring Supporting lines**

The slope and supporting lines can be configured for each trend area.

The Area column displays the trend areas configured in the Trend Template (see Trend areas).

Click the Supporting Lines column to enter the number of supporting lines for the area (see Figure 179). Supporting lines indicate the number of lines displayed in a trend area.

Click the Slope column to enter the slope of the supporting line (see Figure 179).

![Figure 179. Trend Display - Configuring Supporting lines](image)

The Size column displays the size of the trend area. This is configured in the Trend Template (see Trend areas).

**Trend Configuration Hints and Tips**

The following general hints and tips should be considered when configuring your Trend Display:

- Check the Enable binary and Sort binary area check boxes on the Details tab of the Trend Template, if you want to have any binary signals in your Trend Display.
Use the ExtMomentary treatment instead of Momentary treatment, if you want to display more than 86400 points (1 day of 1 second data) raw data in a trace.

Increase the End Marker Size on the trend template if it is difficult to see the last value in an XY-plot.
Section 5  Creating Reports

Overview

You can create reports either with Excel Data Access (Data Direct), or with various third party report building applications. These reports can then be scheduled and run using the Application Scheduler and Report action plug-in.

The Report action lets you direct the report to various output destinations including printers, e-mail, files such as PDF, html, Excel, and report logs configured with the Information Management History Server function. You may also attach completed report files to Completed Report objects in the 800xA System aspect directory. This lets you browse for completed report files via the Plant Explorer, and also lets you apply version control and electronic signatures to report files.

When you output a report to a Completed Report object or report log, the report can then be archived to a removable media for permanent storage.

You can also configure web access for reports so that you may open and view the reports using a web browser.

This section describes any set-up that may be required for reports to access data in the 800xA System, and provides instructions for scheduling, using, and managing reports. For further description refer to System 800xA Information Management Data Access and Reports (3BUF001094*) and System 800xA Maintenance (3BSE046784*).

Report Building Applications

Excel Data Access (Data Direct) is an add-in program for Microsoft Excel. It lets you integrate into a Microsoft Excel spreadsheet real-time and historical data from the 800xA System.
Implementing Reports

The architecture for reporting in the 800xA System is illustrated in Figure 180.

Reports are created as templates which may be stored as Windows files (.xls for Excel) or as a file attached to a File Viewer aspect. Reports may be configured to access real-time data, trend data and alarm and events.

Reports are scheduled via the Application Scheduler. The scheduling instructions are specified in a Job Description object which is created in the Scheduling structure. This triggers a Report Action which specifies how the report will be executed. The Report Action identifies the report template, specifies one or more output destinations, and lets you pass in parameters to the report at execution time. The Report Action is added as an aspect to the Job Description object.

Report building may be performed locally on the node where the scheduling server runs.
Most Excel Data Access add-in tools access data in the 800xA System without requiring any set-ups other than the standard post-installation set-up.

**Example Reports**

The Scheduler Installation includes example reports, which are intended as examples only. You can modify them or simply use them for reference. It is recommended that you copy and rename a report template before modifying them. The templates for Information Management reports are attached to file viewer aspects on objects located under the Reports branch in the Scheduling Structure. The other report files are stored as Windows files.
Example Information Management Reports

The example Information Management Reports are described in Table 10.

Table 10. Information Management Reports

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Parameters&lt;sup&gt;(1)&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly Log</td>
<td>1 hour log of 60 x 1 minute values</td>
<td>• Tag01 - Tag20 - List of tag names&lt;br&gt;• Tag01Algorithm - Tag20Algorithm - list of algorithms to be used for interpolation. Defaults to TimeAverage.&lt;br&gt;• Start - Time of first value to be displayed. Can be any valid Excel time format, for example: 8:30:00.&lt;br&gt;• DescriptionAtom - Tag atom of the description, for example: Description&lt;br&gt;• EUAtom - Tag atom of the engineering units, for example: Unit&lt;br&gt;Note: if Start = 23:30:15 and the report is run on 2003/10/22, the values will start at 2003/10/21 23:30:15 and extend to 2003/10/22 00:29:15. For times &lt; 23:00:00 the report retrieves data for the current day.</td>
</tr>
</tbody>
</table>
| Shift Log | 8 hour log of 32 x 15 minute values               | • Tag01 - Tag20 - List of tag names<br>• Tag01Algorithm - Tag20Algorithm - list of algorithms to be used for interpolation. Defaults to TimeAverage.<br>• Start - Time of first value to be displayed. Can be any valid Excel time format, for example: 8:30:00.<br>• DescriptionAtom - Tag atom of the description, for example: Description<br>• EUAtom - Tag atom of the engineering units, for example: Unit<br>Note: if Start = 23:30:15 and the report is run on 2003/10/22, the values will start at 2003/10/21 23:30:15 and extend to 2003/10/22 00:29:15. For times < 23:00:00 the report retrieves data for the current day.
### Table 10. Information Management Reports (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily Log</td>
<td>1 day log of 24 x 1 hour values</td>
<td>• Tag01 - Tag20 - List of tag names&lt;br&gt;• Tag01Algorithm - Tag20Algorithm - list of algorithms to be used for interpolation. Defaults to TimeAverage.&lt;br&gt;• Start - Time of first value to be displayed. Can be any valid Excel time format, for example: 8:30:00.&lt;br&gt;• DescriptionAtom - Tag atom of the description, for example: Description&lt;br&gt;• EUAtom - Tag atom of the engineering units, for example: Unit&lt;br&gt;Note: if Start = 23:30:15 and the report is run on 2003/10/22, the values will start at 2003/10/21 23:30:15 and extend to 2003/10/22 00:29:15. For times &lt; 23:00:00 the report retrieves data for the current day.</td>
</tr>
<tr>
<td>Monthly Log</td>
<td>31 day log of 31 x 1 day values</td>
<td>• Tag01 - Tag20 - List of tag names&lt;br&gt;• Tag01Algorithm - Tag20Algorithm - list of algorithms to be used for interpolation. Defaults to TimeAverage.&lt;br&gt;• DescriptionAtom - Tag atom of the description, for example: Description&lt;br&gt;• EUAtom - Tag atom of the engineering units, for example: Unit&lt;br&gt;Note: if the report is run on 2003/10/22, the values will start at 2003/09/01 00:00:00 and extend to 2003/10/01 00:00:00. The report always starts on the first day of the month before the current day.</td>
</tr>
</tbody>
</table>
Table 10. Information Management Reports (Continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Parameters&lt;sup&gt;(1)&lt;/sup&gt;</th>
</tr>
</thead>
</table>
| Trip Log            | 31 values, 20 before the trip time, 10 after the trip time and 1 at the trip time. | • Tag01 - Tag20 - List of tag names  
• Tag01Algorithm - Tag20Algorithm - list of algorithms to be used for interpolation. Defaults to TimeAverage.  
• TripTime - Trip time. Can be any valid Excel time format. e.g. 8:30:00.  
• DescriptionAtom - Tag atom of the description, for example: Description  
• EUAtom - Tag atom of the engineering units, for example: Unit |
| Snapshot-Historical | Single values for 20 tags at the specified time                              | • Tag01 - Tag20 - List of tag names  
• ReportTime - Date and time of values. Can be any valid Excel date/time format. e.g. 10/28/2003 12:00:00 PM.  
• DescriptionAtom - Tag atom of the description, for example: Description  
• EUAtom - Tag atom of the engineering units, for example: Unit |
| Snapshot-Current    | Current values for 20 tags                                                   | • Tag01 - Tag20 - List of tag names  
• DescriptionAtom - Tag atom of the description, for example: Description  
• EUAtom - Tag atom of the engineering units, for example: Unit  
• ValueAtom - Tag atom of value  
• AlarmAtom - Tag atom of alarm state  
• QualityAtom - Tag atom of quality state |
| Alarm and Event     | List of alarms and events between two times for a particular alarm and event object | • AreaObject – Alarm and/or Event object  
• End Time - Report end date and time, defaults to current time.  
• Start Time - Report start date and time, defaults to 1 day prior to the end time. |

(1) All parameters are optional
Basic Steps for Building and Executing a Report

Follow these basic steps to build and run a report. Details are provided in the *System 800xA Information Management Data Access and Reports (3BUF001094*) instruction.

1. Create the report using Excel Data Access. All data access connections should already be established, and the report should access the requested data transparently. You may be required to make adjustments to the connected data providers. Detailed instructions for using Excel Data Access are provided in *System 800xA Information Management Data Access and Reports (3BUF001094*).

To create a user defined report, use the Excel Add-ins for browsing to objects providing real-time data, trend data or alarm and event data.

2. Use the Application Scheduler to create the Job Description object. Then create an Action aspect on that object.

3. Configure the Action aspect to specify how the report will be executed. This includes:
   b. Selecting the report template.
   c. Specifying one or more output destinations for the report result.
   d. Specifying parameters to pass in to the report when it executes.

Login parameters must be specified like follows:

For Excel Data Access, you must define the DataServerLogin parameter in the Report action to connect the report to the applicable data server:

4. Configure the Job Description object to specify the scheduling instructions for the report.

5. Before you run a report, read the guidelines.
If you intend to schedule and execute reports using the Application Scheduler, the report file MUST be saved in Manual calculation mode; otherwise, they will run twice when run through the Scheduler.

The Excel calculation mode is set to the mode of the first file opened (or calculated, if no previously saved file has been opened). All workbooks that are opened in that Excel session will be set to that same calculation mode, despite any previous settings. The calculation mode is always Automatic when Excel is first opened. To check the mode and change it if necessary, see System 800xA Information Management Data Access and Reports (3BUF001094*).
Section 6  Process Graphics

Process Graphics in 800xA, including graphic displays, display elements and faceplates are used to view process information and interact with a process.

For more information about process graphics, refer to the *System 800xA Engineering Process Graphics (3BSE049230)*.
Section 7  Plant Explorer

Plant Explorer is the 800xA System main tool for exploring and building hierarchically structured models of a plant or a system. It is also used to create and configure the objects and aspects of these structures. Plant Explorer Workplace is suitable for application engineers who wants to configure an Operator Workplace.

In order to do the configuration, you need to know how to handle objects, aspects and structures. Read about the concepts in System 800xA, Engineering Concepts (3BDS100972*).

This section includes configuration recommendations and examples.

To start the Plant Explorer Workplace, double-click the **Plant Explorer** icon.

The appearance of the user interface depends on the security settings and User Roles. See System 800xA Maintenance (3BSE046784*).

General User Interface

800xA System workplaces use the window system provided by Microsoft Windows. They are designed so as to retain a familiar environment. Plant Explorer works in a similar way as Windows Explorer regarding for example the following functions.

- cut, paste, copy
- shortcut tools
- drag-and-drop operations within and between the Workplace panes, see also Using Drag-and Drop on page 242.
- context menu (by performing a right-click), see Object Context Menu on page 243 and Aspect Context Menu on page 260.
The Plant Explorer Workplace Window

The Plant Explorer Workplace window is the tool you use when you work with aspect objects, aspects and structures. Figure 181 shows an example of the Plant Explorer window.

Figure 181. The Plant Explorer Workplace User Interface
In Plant Explorer you can use pop-up windows to get a better view of the various aspects of the objects. You can choose to view an aspect in a overlap window, in the preview area, or have it displayed in a full-screen window.

One user interface feature of Plant Explorer that is not consistent with the Windows Explorer interface is the presentation of child objects. In Windows Explorer, sub-folders in a folder structure are displayed in the right hand area of the window. In Plant Explorer, child objects are shown only in the object tree structure; the right hand area shows the aspect list.

**Change User**

Right-click the user tool in the Status Bar to temporarily change the user. A context menu will be displayed with two options; **Change User** and **Revert User**. See the figure below:

![Figure 182. Log Over Function](image)

1. Select **Change User** to open the Change User dialog box.

![Figure 183. Change User dialog](image)

2. Enter the new **User ID** and **Password** and click **OK**.

To change user again, select **Revert** in the context menu and enter the previous User ID and password. Read more about Change User in *System 800xA Maintenance (3BSE046784)*.
Structures

The structures you normally use when working with Plant Explorer is the Control Structure, the Object Type Structure, Library Structure, the Functional Structure, the User Structure and the Workplace Structure.

Basic Navigation

Below the four most common ways to navigate are listed:

- Shortcuts make it easy to navigate to the most important and/or most frequently used aspects of different aspect objects. You can find different shortcuts in the Application Bar.
- You can move back to the previous display by clicking the Back to Previous Display button. If the button is disabled, it is not possible to go backward.
- Click the Aspect Menu icon in the Tool Bar to present the Aspect Menu. From the Aspect Menu you can navigate to different displays by clicking the Aspect Favorites.
- From the context menu you can, for example, select an aspect, action or a referenced display for the object or aspect. The contents of the context menu may differ depending on which object or aspect you have selected.

Using the Context Menu

Right-click an object or aspect to open the context menu. The menu contains a number of actions which are related to the object or aspect. See Figure 181.

As the name Context Menu says, the content of the menu depends on in which context you are. Read about the Object Context Menu on page 243 and Aspect Context Menu on page 260.

Using Drag-and Drop

You can carry out a number of tasks using drag-and-drop operations. They are used to cut, copy and move objects and aspects, according to the following:
Move is the default action carried out for a drag-and-drop operation. See Moving an Aspect Object on page 258.

If you press <Ctrl> while performing drag-and-drop, a copy operation is performed. See also Copy/Paste an Aspect Object on page 258.

Pressing <Shift+Ctrl> while performing drag-and-drop inserts an object. See also Inserting an Aspect Object on page 256.

**Search Function**

The structures you have built can be very complex, and might be difficult to find only by browsing the structures. Click the **Find Tool** in the Plant Explorer to access a search feature. See Find Tool on page 270 for more information.

**Working with Aspect Objects**

The aspect objects are the basic building blocks you use for composing your plant model. The following section describes how to work with aspect objects when configuring your Operator Workplace.

**Object Context Menu**

Right-click on an object to open the object context menu. The menu contains both items that are specific for the object context (but are the same for all different objects), called context specific items, and items that are specific for each object.

In Figure 184 the object context specific items and the object specific items are pointed out.

Note that user roles affect the contents of the context menu.
Context specific items are explained below:

**New Object...**

Select **New Object...** in the context menu to create a new aspect object in the New Object dialog. For further information, see *Creating an Aspect Object* on page 254.

**New Aspect...**

Select **New Aspect...** in the context menu to create a new aspect in the New Aspect dialog. For further information, see *Adding an Aspect* on page 268.
Insert Object...
Select Insert Object... in the context menu to bring up the Insert Object dialog. The aspect object selected in the Insert Object dialog will become a child to the selected aspect object. For further information see Inserting an Aspect Object on page 256.

Set Temporary Root. This operation makes the selected aspect object the root object.

Cut. Saves a reference to the selected aspect object and all its children in the current structure on the clipboard, and marks that this is a Cut. The aspect object will become grey colour. Later, when a Paste operation is made, the effect will be the same as if the aspect object had been moved using drag and drop.

Copy. Saves a reference to the selected aspect object and all its children in the current structure on the clipboard. No structure aspects are copied in the Copy operation. Only the internal structures of the aspect objects are saved.

Paste. Pastes the tree structure referenced from the clipboard to the selected aspect object. The tree structure is copied and then linked in as a new child to the selected aspect object (unless a Cut operation is previously done; in this case the existing structure aspect will just be changed to get a new parent).

Paste Special:
- Paste object - Pastes only the root aspect object in clipboard, not its children.
- Paste aspect - Pastes the aspect(s) on the clipboard to the selected aspect object.

Delete. Deletes the selected aspect object and all its children in the current structure. If an aspect object, which is part of a Delete operation, is no longer part of any structure, the aspect object and all its aspects are deleted. To be able to delete an aspect object, you must have the user role required to delete the specific aspect object and its aspects. When an aspect object is deleted, the aspect object above in the structure will be selected.
**Show Type.** The Show Type selection enables you to browse in the Object Type Structure, to find the Object Type object which you can edit. See also Show Type Function on page 260.

**Acknowledge.** Acknowledge is shown in the context menu only if the aspect object has an alarm list. In an alarm state the Acknowledge button is to enabled, otherwise disabled. Click the Acknowledge button, to show that you have noticed the alarm status.

**References.** If the object for example is included in a graphic display, the display’s name is shown when you click the Reference button. If the aspect is referred from another aspect, these aspects are listed in a submenu.

**Add Note.** Adds an Operator Note aspect in the aspect list. Read about the Operator Note in *System 800xA Operations (3BSE036904)*.

**Details.** Through the Details dialog you can view and change data for the aspect object, for example change the object’s name, if it is not unique.

There are seven tabs in the object Details dialog, which are described below:

- Identification Tab
The **Identification** tab displays information about when the object was created and last modified. If an object description exists, it will be displayed in the **Description** text box.

**Figure 185. Identification Tab**

- Property View tab

  The **Property View** tab shows the properties for all aspects on the object, including global properties.
### Figure 186. Property View Tab

### Table 11. Property View tab

<table>
<thead>
<tr>
<th>Aspect</th>
<th>Name of the aspect to which the property belongs to.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Property name in the system</td>
</tr>
<tr>
<td>Data Type</td>
<td>The data type of the property</td>
</tr>
<tr>
<td>Access</td>
<td>The setting of the property, (readable and/or writable)</td>
</tr>
<tr>
<td>Update Rate</td>
<td>The default update rate for the property in milliseconds</td>
</tr>
<tr>
<td>Value</td>
<td>The collected value of the property</td>
</tr>
<tr>
<td>Quality</td>
<td>The quality of the property value</td>
</tr>
<tr>
<td>Timestamp</td>
<td>The time when the property got its value</td>
</tr>
</tbody>
</table>
Table 11. Property View tab (Continued)

<table>
<thead>
<tr>
<th>Flags</th>
<th>See information about the Property Info Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Permission</td>
<td>Security setting for reading.</td>
</tr>
<tr>
<td>Write Permission</td>
<td>Security setting for writing</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the property</td>
</tr>
<tr>
<td>Subscribe for live data</td>
<td>Activate subscription on property for data</td>
</tr>
</tbody>
</table>

- **Name Tool Tab**

  The System supports objects with equal names. Under the **Name Tool** tab, you can check whether the object name is unique or not.

  All collisions are displayed in the **Collisions** text box. To check for collisions, select an object in the **Name** drop-down menu.

  If there is a collision, the name of the object will be displayed in the text field next to the drop-down menu. Enter a new name and click **Change**.
Figure 187. Name Tool Tab
• Names & Paths Tab

The **Names & Paths** tab displays all the currently existing names of the chosen object. It also displays the path to the object (see Figure 188).

![Names & Paths Tab](image)

*Figure 188. Names & Paths Tab*

• Permissions Tab

This tab shows your permissions for an object, what is allowed and denied. If you have permission, you can see the security settings for this object for other persons, by using the **Change User** button.

Read more about permissions and security in the *System 800xA Maintenance (3BSE046784)*.
The Lock Status tab displays all locks currently taken on the selected object. The dialog contains information about the lock type, path, user and so on. Several locks can be listed here.

Depending on your user role, a Break Lock button is visible in the dialog. Select a Lock in the list and click the button to break the lock. If you want more information about a specific lock, select it and right click. Select View Details from the context menu.
Figure 190. Lock Status Tab
• References Tab

The **References** tab lists the target objects and target aspects that aspects on the select object have references to.

![Figure 191. References Tab](image)

**Creating an Aspect Object**

An aspect object can be created in a number of ways. You can for example use the context menu, copy/paste, and drag-and-drop features to create an aspect object. This makes it possible for you to work with the Plant Explorer in the way that you feel most comfortable with.

When you create a new aspect object, you can choose from a range of object types. Which object types that are available depends on in which structure the new aspect object is to be created.

It also depends on which aspect object is the parent object of the child object you are going to create, and also on your user authority. Thus, which aspect objects you are allowed to create depend on your user role.

To create a new aspect object, do as follows:
1. Open the context menu from the object you want to add a new child object.
2. Select New Object and the New Object dialog appears.

![New Object Dialog without Hierarchical Ordering](image)

*Figure 192. New Object Dialog without Hierarchical Ordering*

In this dialog, select the object type for the new object, and enter a name and a description (optional) for the new object.

The list of object types displayed in this dialog is not filtered, meaning that it shows all valid object types. The object types can be filtered to show only the object types that correspond to the parent object of your new aspect object, the structure in which it is placed, and your user authority. The list will then display all aspect objects suggested for creation. If you want to see all valid aspect objects, check the Show All text box.

In the New Object dialog, the available object types are displayed in a structure similar to the Object Type Structure presented in Plant Explorer. If you want to see the object types listed without any hierarchical ordering, select List Presentation. This will display the available object types in a plain list.

3. Click on the Create button. The new aspect object is created as a child object to the object you selected. The parent-child relationship is represented by the
+/− signs in the Object tree, showing that an object has one or more children attached to it.

4. Click the **Advanced** button, to specify where to place the new object. The Object Position dialog box is displayed.

![Object Position Dialog Box](image)

*Figure 193. Object Position Dialog Box*

5. In this dialog, you can select the position where you want to place your newly created object.

   If you select **before**, your object will be placed before the object you are pointing at, on the same hierarchical level. If you select **after**, the object will be placed after the object you are pointing at, on the same level.

   This is relevant only when you not have selected alphabetical order (through User Profiles) between the objects. See configuring **User Profiles**.

   When the aspect object has been created, the right-hand panel will show the default aspects set to the object. You can add more aspects in order to further specify your new object. This is described in **Working with Aspects** on page 260.

### Inserting an Aspect Object

You can place the same aspect object in different structures, in order to make it easier to navigate in the System. Inserting an aspect object, means that a new structure aspect is added to it.
The **Insert Object** operation is similar to the **Create Shortcut** operation in Windows. The **Insert Object** operation can be performed by using the context menu for the Object tree, or by using drag and drop.

To perform an **Insert Object** operation on an aspect object, follow these steps:

1. Select the aspect object to which you want to insert an aspect object.
2. Select **Insert Object** from the context menu.
3. In the Insert Object dialog that pops up, browse to the aspect object you want to insert and select it. See Figure 194.
4. Click on the **Insert** button.

![Insert Object dialog](image)

*Figure 194. Select Object to Insert*

The inserted aspect object must be valid for the structure in which it is to be inserted for the Insert Object operation to be performed.
To **Insert** an aspect object, you can also do as follows:

1. Click on the aspect object you want to insert.
2. Drag it to its new position, while pressing `<Shift+Ctrl>`, and drop it.

Only the object selected in the Insert dialog will be inserted. Its children will not be included, they must be inserted separately.

**Copy/Paste an Aspect Object**

A Copy operation will save a reference to the aspect object and all its children on the clipboard. The actual copying will not be done until the Paste operation.

To perform a **Copy** operation, do as follows:

1. Click on the aspect object you want to copy.
2. Select **Copy** in the Object context menu.
3. Click on the aspect object to which you want to copy your aspect object.
4. Select **Paste** in the context menu.

All Copy/Paste operations can also be carried out using the standard Windows features: `<Ctrl+C>` to Copy and `<Ctrl+V>` to paste the contents on the clipboard.

A Copy operation can also be done by pressing `<Ctrl>` and performing a drag and drop.

**Moving an Aspect Object**

You can move an aspect object by using the drag-and-drop method:

1. Select the aspect object.
2. Move the aspect object by dragging and dropping it to another aspect object in the structure.

   The moved aspect object will become a child to that aspect object.

You can also move an aspect object using the Cut and Paste operations (or `<Ctrl+X>` and `<Ctrl+V>`).

The paste operation can only be done once.
**Rename an Aspect Object**

It is easy to rename an aspect object. The name is stored in the Name aspect of the object. There are two ways to change the name. The first one is like this:

1. Go to the aspect object in Plant Explorer and select its Name aspect.
2. In the **preview** area or overlap window, change the name in the **Name** area.
3. Click on the **Apply** button.

The other way is as described below:

1. Right-click on the aspect object.
2. Select **Name** in the context menu.
3. Change the name in the **Name** area of the overlap window that opens.
4. Click on the **Apply** button.

**Deleting Aspect Objects**

**Delete** removes the aspect object from the current structure. It also removes all the children of the deleted aspect object. If any of the deleted aspect objects is no longer part of any structure, the aspect object and all its aspects will be deleted. To be able to delete an aspect object, you must have the user role specified for the current aspect object. To remove an aspect object and all its children, do as follows:

1. Right-click on the aspect object to open the context menu.
2. Select **Delete** in the context menu. If the aspect object and its children has more than one structure aspect, that is, if it occurs in more than one structure, then the aspect object will be removed from the structure in which you are working. If the aspect object has only one structure aspect (occurs in only one structure), the aspect object and all its aspects are deleted entirely.

or

1. Select the aspect object to be deleted.
2. Press <Delete>.
3. On the confirmation dialog that is displayed, click on **OK** to delete the aspect object.
Show Type Function

You have to search for the Object Type object to edit an instance of an object. To see the Object Type of an object, you select **Show Type** in the object’s context menu. Another window with object type information will be displayed.

![Object Type Structure](image)

*Figure 195. Display for Object Types*

The object type and its aspects can be edited in the same way as objects in Plant Explorer Workplace, but changes to the object type will affect all objects of this object type.

Working with Aspects

Each aspect object is specified by a number of aspects. The aspects contain information on all characteristics of the aspect object, such as the name of the aspect object, its geographical location, its place in the Functional Structure, user’s rights, and so on. Aspects are used to inform the System how the aspect objects shall be treated by the different parts of the system.

Aspect Context Menu

The aspect context menu is opened when you right-click on an aspect (for example in the aspect list). The context menu contains items that are specific for the aspect.
context (but are the same for all different aspects) called aspect specific items, together with items that are specific for each aspect.

The menu items specific for the aspect context, and common for all the aspects are explained below and seen in Figure 196.

![Figure 196. Aspect Context Menu](image)

**New Aspect...** Brings up the New Aspect dialog. See Figure 203 and Adding an Aspect on page 268.

**Cut.** Cuts the selected aspect and places it on the clipboard. The aspect will be greyed and deleted from its current place when pasted at the new place. The result will be a new aspect that is a copy of the original. It is not possible to move an aspect.

**Copy.** Copies the selected aspect to the clipboard. See also the section about Copying an Aspect on page 269.

**Paste.** Pastes the cut/copied aspect to the aspect list. This operation can only be carried out when the clipboard contents has a valid format. See also the section about Copying an Aspect on page 269.

**Delete.** Deletes the selected aspect.
**Rename.** Select Rename to put the aspect in an edit mode and rename it.

**Override.** If the aspect is inherited, this operation makes a local copy of the aspect. See also *Overriding an Aspect* on page 270.

**Add to Aspect Menu.** This function is included in the Favorites Aspect System. Select **Add to Aspect Menu** to open the Aspect Favorites dialog. In this dialog you can add the selected aspect to the Favorites list.

Read more about the Favorites Aspect System in *Favorites* on page 131.

**Details....** Through the dialog, you can change data for the aspect, for example set the aspect to be the default aspect, change its name and enter in a description of the aspect.

The seven tabs in the Details dialog are described below:

- **Identification Tab**
  
  Under the **Identification** tab you can change the name of the aspect and you can add a description of the aspect. Enter a new Name and a Description. Click **Apply** to activate the changes. You can also find information about when the aspect was created and last modified.
Aspect Info Tab

Under the Aspect Info tab you can find information about aspect keys, inheritance mode, and internal data blobs for the aspect. You can customize the aspect by adding Keys to the aspect. Keys attached to the aspect are displayed in the Aspect Keys text box. Add new Keys by clicking the Add button. This will open the Add Keys dialog. Select suitable Keys in the list displayed.

Selecting the Default Aspect check box adds the Default Aspect key to the aspect. For more information, refer to Default Aspect on page 142.

When you have selected the Keys, click OK.
If you select a key in the list under the Aspect Info tab and then press the <Delete>, the selected Key will be removed from the aspect.

By clicking the New button, you can add new Keys in the same way as you added new Priorities, see Figure 198.

In the Inheritance part of the Aspect Info tab, you can see if the aspect is inherited, and from the source where it is inherited. It also indicates if the aspect was overridden.

If the aspect is placed on an aspect category or an object type, you can here enable inheritance (if the aspect supports inheritance).

- Property View tab
  This tab shows all properties for the aspect.

- User Role Mapping Tab
  The User Role Mapping tab displays the required roles to view, modify, create and look at the configuration view of the aspect. Default user roles are
displayed in this dialog. The User Roles can be changed and added on the Aspect Category.

![User Role Mapping Tab]

**Figure 199. User Role Mapping Tab**

User roles affect the contents of the context menu. The roles help to customize the environment to suit the needs of each user. This means that the operations which the user needs to act on are visible for him/her.

- Permissions Tab
The **Permissions** tab shows the operations that requires a permission and what is granted or not.

![Permissions tab](image)

**Figure 200. Permissions tab**

If you have permission you can use the **Change user** button to see the security settings for this aspect for other users. For more information about permissions and security, read the *System 800xA Maintenance (3BSE046784)*.
• **Lock Status Tab**

![Lock Status Tab](image)

*Figure 201. Lock Status Tab*

The **Lock Status** tab displays all locks currently taken on the selected aspect. The dialog contains information about the lock type, Path, User and so on. Several locks can be listed here.

Depending on your user role, a **Break Lock** button is visible the dialog. Select a Lock and click the button to break the lock. If you want more information about a specific lock, select it and right-click. Select **View Details** from the context menu.

• **References Tab**

The **References** tab lists the objects and aspects that the selected aspect has references to.
Adding an Aspect

To add an aspect to an aspect object, do as follows:

1. Right-click on the aspect object for which you want to add a new aspect.
2. Select **New Aspect** from the context menu that appears. A list of available aspect categories is displayed.

The aspect list is filtered according to the aspect object you have selected and the structure you are working in. The aspects are listed according to the existing aspect categories.

*Figure 202. References Tab*
Section 7  Plant Explorer

Working with Aspects

3. Select an aspect category. The aspects listed are those suggested for the object type you are creating it for, but you can view all valid aspects for the object type by checking the Show all box. Uncheck the List Presentation box to show the Aspect System Structure instead of a plain list of the aspects.

4. You can also add a description of the aspect and a name for it. If you do not set a name, the aspect category name will be used and displayed in the aspect list.

5. Click on the Create button. The aspect you have just created will then be presented as the topmost aspect in the list.

Copying an Aspect

To copy an aspect, do as follows:

1. Right-click on the aspect you want to copy to open the context menu.
2. Select Copy (CTRL+C) in the context menu.
3. Right-click on the aspect object to which you want to copy the aspect.
4. Select **Paste** (CTRL+V) in the context menu.

   It is not possible to move an aspect.
   Cut and Paste is the same thing as Copy, Paste, and Delete of the original.

**Configuring an Aspect**

Most aspects can be edited when you open the **Config View** of the aspect. Right-click on the aspect and select **Config View** in the context menu. The aspect may also have a verb defined in the context menu to open the aspect for configuration. See as an example **Edit** for graphic aspects.

**Overriding an Aspect**

The override function is very useful when an object has an inherited aspect and you want to modify that aspect only for a specific object instance.

Right-click on the inherited aspect and select **Override** in the context menu to create a local copy of the aspect.

   The override function breaks the inheritance for the selected aspect. To remove override, delete the overridden aspect.

**Find Tool**

The Find Tool provides functionality to search for objects and aspects.

At start up a default Find Tool configuration is displayed. It is possible to extend the tool and search features with attributes, columns and additional operations.

In the Find Tool, enter the name of an object or the path to an object as a search criteria and then search for the object that you are looking for. It is also possible to search for aspects.

You can run the search globally or in a specific structure. In the Find tool you can also use *wild card* searches, if you are uncertain of the exact name of the object you are searching for. Use the “*” character as a substitution for zero, or one or more characters, and the “?” sign to substitute exactly one character.
User Interface

The Find Tool dialog provides the main user interface for the Find Tool. It contains two areas; the **Find Query Definition** area, where the search request is defined, and the **Result List** area, where the search result is presented. See Figure 204.

![Figure 204. Main View of the Find Tool Dialog](image)

**Find Query Definition Area**

Find queries are defined in the Find Query Definition area in the Find Tool. This is the main input and user interface area of the Find dialog. In the **Name** area the search expression is entered. Use the Find Attributes to define the query.

Tasks related to a Find query, e.g. printing, saving or loading Find queries, can also be accessed from here. The Search Tasks item is collapsed in Figure 204, but is described later on.
Enter a Search Expression. Enter a search expression and press <Enter> or click the Search button to start the search. Clicking the Stop button will interrupt the search request. It is possible to use search wild cards in the search expression, for example A1* or A?. See Figure 205.

Search Expression History. All entered search expressions are added to the Expression History list. The expression is added to the list in order to be easily reused.
Search for Objects

When the Objects radio button is checked, the object search will be activated. The name of the object to search for can either be an object id {objectId}, or a search expression. The result will be filtered according to included Find attributes.

Search for Aspects

Aspects can be searched by name, for example Group Display, or by entering the object id and aspect id on format {objectId}:{aspectId}. When the Aspects radio button is checked the aspect search is activated.

Add Attribute

This operation adds an attribute to the Attribute drop-down menu, see (Figure 204). The attribute item is expanded and included (the attribute box is checked) by default, in order to simplify a selection in the Find Attribute editor.

Find Attribute Item

The Find Attribute item is a container control for Find attribute editors. When a Find attribute is added, it is displayed as the figure below shows.

![Find Attribute Item](image)

*Figure 206. Find Attribute Item*

The following Attribute options are available in the Attribute item.

- The Include Attribute check box indicates if the Find attribute is included in the Search Request.
- The Attribute name shows the name of the attribute.
Search Tasks Area

Search Tasks are related to a search request or a result from a search.

- Click the **Expand/Collapse** arrow to toggle the expand and collapse state of the Attribute item.

- An **Attribute selection** shows the current selection in the Find editor. This label is enabled when the **Attribute selection** box is checked.

- Click the **Remove attribute** link to remove the attribute from the Find query definition.

**Search Tasks Area**

Search Tasks are related to a search request or a result from a search.
Use Saved Find Query

Saved queries can be opened from the Use a saved search query drop-down menu. There are two sections in the list; My personal queries and Shared search queries. The personal queries are saved on the current user object, see also Save Query. Personal queries are available only for the current user of the Find Tool.

Shared queries are located on the Everyone object in the User Structure and are available for all users.
Save Query

The Save option opens the Save or Save as dialog. The name and description for a query can be entered in the Find Query Name area.

![Save Search Query Dialog](image)

Figure 209. Save Search Query dialog

The query is saved in a Find Query aspect which automatically gets the same name as the query. The aspect is created and added to the current user object in the User Structure. To place query aspects in other locations, they have to be copied or moved manually. Such queries can be opened in Plant Explorer via for example the context menu.

Run Query Aspect Verb

The Find dialog can be opened from the context menu of a Find Query aspect. Right-click the aspect and select Run Query from the context menu, see Figure 210. This will open the Find tool dialog which will be initialized from the Find Query aspect.
Print

The search requests and Results can be printed. Click **Print** in the **Tasks** area in the **Find Tool** to open the Print Preview (see **Figure 211**).

Click **Print** button to proceed the job.

*Figure 210. Context Menu of a Find Query Aspect*
Configuration of Columns

Columns in the Result List can be configured either in the Choose columns dialog, see the figure below, or from the context menu in the Result List header.

Select **Choose columns** in the **Tasks** area in the **Find Tool** (see Figure 212) or select **More** in the context menu of the Fins Tool header (see Figure 213).

---

*Figure 211. Print Preview Dialog Box*
### Figure 212. Choose Columns Dialog Box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the object/aspect</td>
<td>100</td>
</tr>
<tr>
<td>Object type</td>
<td>The object type</td>
<td>120</td>
</tr>
<tr>
<td>Aspect category</td>
<td>The aspect category of an aspect</td>
<td>120</td>
</tr>
<tr>
<td>Aspect type</td>
<td>The aspect type of an aspect</td>
<td>120</td>
</tr>
<tr>
<td>Description</td>
<td>The description of an object</td>
<td>150</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user that last modified the object</td>
<td>80</td>
</tr>
<tr>
<td>Created by</td>
<td>The user that created the object</td>
<td>80</td>
</tr>
<tr>
<td>Reserved by</td>
<td>The user that reserved the object</td>
<td>80</td>
</tr>
<tr>
<td>Modification date</td>
<td>The time that the object/asset was modified</td>
<td>60</td>
</tr>
<tr>
<td>Creation date</td>
<td>The time the object/asset was created</td>
<td>60</td>
</tr>
<tr>
<td>GUID</td>
<td>The guid of the object/asset</td>
<td>100</td>
</tr>
<tr>
<td>Inherited</td>
<td>Shows if the object is inherited</td>
<td>60</td>
</tr>
<tr>
<td>Reserve comment</td>
<td>A comment added from another program or document</td>
<td>150</td>
</tr>
<tr>
<td>Part of</td>
<td>Part of description</td>
<td>150</td>
</tr>
</tbody>
</table>
Figure 213. Context Menu in the Find Tool Header
Configuration of Operations

Click Choose Operations in Task area in the Find Tool to configure the operations (Figure 214).

Figure 214. Choose Operation Dialog open from the Search Tasks Area
The selected operations will then appear in the Result List context menu (Figure 215).

**Figure 215. Context Menu in the Result List with the Delete Operation enabled**

**Export Result.** Objects and aspects found in a search request can be exported by using the Export function in the Search Tasks area.

Click **Export** to start the Import/Export application. All items in the result list are exported to the new Import/Export document. Read about the Import/Export Tool in *System 800xA Maintenance (3BSE046784*)*.

**Help.** The Help for the Find Tool dialog is opened by clicking the **Help** label in the Search Tasks area. A related help topic will be opened in a significant help file.
Result List

The Result List displays items found in the last performed search request. The list displays objects or aspects depending on the type of search. It is configured with a set of columns and operations, which preferable is relevant to the type of displayed items.

![Result List Table]

*Figure 216. Result List*

Context Menu

The Result List provides a context menu for the currently selected item, see Figure 217. Depending on whether the item is an object or an aspect, the object- or aspect context menu is displayed. There is a section in the menu which is dedicated to configured operations in the Find Tool. All included operations appears as items in the menu.
The figure below shows the **Delete** operation.

![Object Context Menu in the Result List](image)

*Figure 217. Object Context Menu in the Result List*

### Drag and Drop

The Result List supports the drag and drop operation, i.e. items in the result list can be selected and dragged to an area in a Workplace. Aspects might be dragged from the result list to a drop target tool and objects might be dragged to the Plant Explorer aspect browser.

### Find Attributes

With Find Attributes it is possible to filter the search queries. This to decrease the number of found items. A number of standard Find Attributes are available in the Find Tool. These attributes are described in this section.
Structures. Searches will go through all structures by default. The search can be delimited to one structure by using the Structure Selector in the Structure Attribute area.

Figure 218. Structure Attribute

Check the Attribute check box to include the structure attribute and select a structure. The Selection label is updated with the current selection. This attribute is valid for object search.

Object Type. It is possible to filter out objects of a certain object type in an object search. Multiple selections of object types are allowed.

Aspect Category. Aspect Category filtering is valid for both object- and aspect search. When objects with aspects of a selected aspect category are searched, the objects are filtered out. When aspects of a selected aspect category are searched, the aspects are filtered out.

Modification Date. The Modification Date attribute filters objects or aspects according to a specified modification date interval.

Creation Date. The Creation Date attribute filters objects or aspects according to specified creation date interval. It is valid for both object- and aspect searches.
Modified By. Filters out items modified by the selected user. This attribute is valid for searching for both objects and aspects.

Created By. This Find attribute is similar to the Modified by attribute, although the filtering regards which user created the item.

Reserved By. This find attribute filters out the items reserved by the selected user. When searching for aspects, explicitly reserved aspects are searched, i.e. not aspects that are reserved as part of an entity. When searching for objects, reserved entities are searched. To see the aspects in the entity you either go to the entity object or use the Part of find attribute selecting the entity to be searched. It is also possible to reserve and release aspects and entities from the Find Tool via the context menu in the Result Pane.

Part of. This find attribute makes it possible to search for aspects and objects that are part of an entity.

Version Support. This find attribute makes it possible to find all aspect types, all aspect categories or all aspect instances that supports version handling or are environment aware.
**OPC Property.** The OPC Property attribute is targeting object search requests.

![OPC Properties Attribute](image)

*Figure 219. OPC Properties Attribute*

The user interface of OPC Find attribute, is displayed in the figure above. It is composed by an object type- and an OPC Property list for selecting the property and an editable drop-down menu for defining the conditional value of the property.

The **OPC Properties** list is depending on the selection made in the Object type list. For example, if the selection in the Object Type list = AI, then the list will contain all available OPC Properties for the AI objects.

For all selected OPC Properties a condition, e.g. IS; IS NOT, LESS THAN, and a value can be specified.
For example: an OPC property named IS_BLOCKED may have a typical condition of IS NOT and a value BLOCKED. The search result will be filtered according to the conditions specified in the OPC Properties item.

**Name Category.** The Name Category attribute is valid when searching for objects. The attribute is filtering out objects with aspects of the selected Name Category.

---

**Quick Find Tool**

**General**

Navigating to items in Plant Explorer is performed by browsing the structures and trees. Another way is to use the Quick Find tool to get quick access to an object.

**User Interface and Functionality**

Type an object name or a part of it as a search word in the text field. If you press <Enter>, the tool searches for the exact typed in word.

Otherwise, the tool searches for all objects starting with the letters typed in. Also, the search will take a few seconds, starting with a 3 seconds delay that the Quick Find tool needs to be able to recognize that the user has stopped entering new characters to the search string. Found objects will be presented in the drop-down list, if no matching objects are found the search word will be grayed.

*Figure 220. Quick Find Tool*
**Quick Find History.** The list contains the latest chosen objects for the current user. The Quick Find History should not be confused with the Auto fill functionality.

**Auto Fill.** There is an Auto fill (an auto completion) functionality provided by the QuickFind tool. Each time characters are typed a search request is invoked to lookup objects matching the string entered so far. The search expression sent to the Find logic component is the string with a '*' wildcard appended, i.e. find all objects with names starting with the string entered.

An example; the user enters A1 and the search expression is A1*. Hence all objects starting with A1 will be displayed in the drop-down menu. When the search is done all objects found are added to the list. If no items are found nothing happens. As soon as a new character is entered a new search request is started and any pending search tasks are terminated.

**Workplace Selection.** When a quick find search request is completed, the Workplace selection is updated depending on the result from the search.
Appendix A  Property Translation Aspect

Purpose

You can use the Property Translation aspect to create object properties presenting the result of an evaluation or calculation of one or several object properties. The result is available as an object property on the Property Translation aspect itself. The result can also be translated to a text string describing the result. Displays and reports can access this information as an ordinary object properties.

The data collection can be done from any public object property (including the properties from aspects such as the General Properties aspect). This means that object properties in controllers, are accessible as data sources.

There are two Property Translation aspects with different functionality regarding translation to strings:

- Property Translation
  In this aspect you use a literal translation for the string translation expression. It is useful to describe states in for example sequence objects, multiple values etc.

- Property Translation Extended
  In the extended aspect you can also use expressions when translating to strings. You can set strings both for the result True and False (of the expression). Property Translation Extended can evaluate expressions, and as an example evaluate and describe intervals as text strings.

Properties which depend on each other, e.g. property $a = b$, $b = c$ and $c = a$ etc. may cause the Property Translation to loop recursively.
Property Translations Aspect

The Property Translations aspect is placed on the object, for which you want to provide translated properties.

![Property Translations Aspect](image)

**Figure 221. Property Translations Aspect**

- In the **Name** area, enter the name you selected for the translated value.
- In the **Description** area, write a description of the purpose with the translation.
- In the **Expression** field, enter the formula for the translation. See *System 800xA Configuration (3BDS011222*) for valid operators.

In the **Expression** text field you can use the Property name, as a short reference, if the property is defined on the same aspect object as the property translation aspect. In other cases you have to enter a syntax according to Item Syntax in *System 800xA Configuration (3BDS011222*)*.
• In the **Data Type** list, select the data type for the expression result. The data type is only applicable when the string translation table is not used.

• In the **String Translation Table** enter the mapping between expression result and strings. The value in the **Value** area must be integer, * or Bad. The value (integer) should be equal to the output value from the **Expression** area. The wildcard (*) will be used when the expression result is not equal to any of the specified values and Bad will be used when the expression result is of bad quality.
Property Translation Extended Aspect

The Property Translation Extended aspect works in the same way as the Property Translation aspect, but gives you the opportunity to use expressions when translating to strings.

Figure 222. Property Translation Extended Aspect

- In the **Name** area, enter the name you selected for the translated value.
- In the **Description** area, write a description of the purpose with the translation.
- In the **Expression** field, enter the formula for the translation. See *System 800xA Configuration (3BDS011222*)* for valid operators.
In the **Expression** text field you can use the Property name, as a short reference, if the property is defined on the same aspect object as the property translation aspect.

- In the **Expression** area of the **String Translation Table**, give each expression an output string when true and/or when false. These output strings are concatenated to a result string. Use the variable “result” as a reference to the translation expression result, the third field from the top.
- In the **Separator** field, you set the delimiter for the concatenated strings.
Appendix B  Alarm and Event List Attributes

This appendix describes the predefined and standard attributes of the alarm and event list.

Table 12 describes the standard attributes which are added to events by the OPC Alarm and Event server from which the event originates.

Table 13 describes the predefined attributes which are added to condition specific events by the Alarm Manager. The attributes SourceName and PriorityLevel are added to all events.

Table 14 describes the predefined attributes which are relevant for alarm hiding.

Table 15 describes the predefined attributes which are relevant for alarm shelving.

Table 16 describes the predefined attributes which are relevant for section responsibility.

Table 17 describes the predefined attributes which are relevant for alarm grouping.

Table 12. Standard Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActorID</td>
<td>String</td>
<td>The name of the user who performed the previous operation on the alarm (for example, acknowledge or shelve).</td>
</tr>
<tr>
<td>ActiveTime</td>
<td>FILETIME</td>
<td>The time at which the condition turns active (for single-state conditions), or the time of the transition into the current sub-condition (for multistate conditions). This is not available for attribute filtering.</td>
</tr>
</tbody>
</table>
## Table 12. Standard Attributes (Continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>String</td>
<td>The event category to which this event belongs.</td>
</tr>
<tr>
<td>Condition</td>
<td>String</td>
<td>The condition related to this event notification.</td>
</tr>
<tr>
<td>EventTime</td>
<td>FILETIME</td>
<td>The time at which this event occurred. For condition events, this is the time at which the condition is transitioned into the new state.</td>
</tr>
<tr>
<td>Message</td>
<td>String</td>
<td>The event notification message describing the event.</td>
</tr>
<tr>
<td>Quality</td>
<td>String</td>
<td>The textual representation of the quality code associated with the condition state.</td>
</tr>
<tr>
<td>Severity</td>
<td>Int32</td>
<td>The event severity (1.1000) set by the OPC server from which the event originates. This indicates the severity of the sub-condition. Event severities from different sources are mapped to priorities. The <strong>PriorityLevel</strong> attribute indicates the priority of a specific event in the system. This is used for filtering.</td>
</tr>
<tr>
<td>SubCondition</td>
<td>String</td>
<td>The name of the current sub-condition (for multi-state conditions). For single state conditions, this includes condition name.</td>
</tr>
</tbody>
</table>
### Table 13. Predefined Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceName</td>
<td>String</td>
<td>The source name provided by the event source. This might be same as the Object Name.</td>
</tr>
<tr>
<td>AckLowTime</td>
<td>Int32</td>
<td>Internal representation of the lower part of the acknowledge time. This is not displayed to the user as a column. It is presented in a readable format in the Event Details dialog.</td>
</tr>
<tr>
<td>AckHighTime</td>
<td>Int32</td>
<td>Internal representation of the higher part of the acknowledge time. This is not displayed to the user as a column. It is presented in a readable format in the Event Details dialog.</td>
</tr>
<tr>
<td>Comment</td>
<td>String</td>
<td>A comment specified for the alarm by the operator.</td>
</tr>
<tr>
<td>AlarmState</td>
<td>String</td>
<td>A description of the alarm state.</td>
</tr>
<tr>
<td>PriorityLevel</td>
<td>Int32</td>
<td>Priority level of the event.</td>
</tr>
<tr>
<td>ServiceGroupId</td>
<td>String</td>
<td>Identifies the Event Collector service group from which the event origins.</td>
</tr>
<tr>
<td>AlarmChange</td>
<td>String</td>
<td>Indicates the change which causes the event to be sent.</td>
</tr>
<tr>
<td>ObjectName</td>
<td>String</td>
<td>The localized name of the associated object.</td>
</tr>
<tr>
<td>ObjectDescription</td>
<td>String</td>
<td>The localized description of the associated object.</td>
</tr>
<tr>
<td>ActiveChangeTime</td>
<td>DateTime</td>
<td>The latest time at which the active state was modified.</td>
</tr>
</tbody>
</table>
### Table 14. Predefined Attributes for Alarm Hiding

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HidingRuleId</td>
<td>String</td>
<td>Identifies the hiding rule that hides the alarm (GUID).</td>
</tr>
<tr>
<td>HidingMaskId</td>
<td>String</td>
<td>Identifies the hiding mask that hides the alarm (GUID).</td>
</tr>
<tr>
<td>HidingRuleCondition</td>
<td>String</td>
<td>The condition to activate the hiding rule.</td>
</tr>
<tr>
<td>HidingMaskCondition</td>
<td>String</td>
<td>The condition to activate the hiding mask.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Boolean</td>
<td>Indicates whether the alarm is hidden.</td>
</tr>
<tr>
<td>HidingMaskName</td>
<td>String</td>
<td>Indicates the name of the hiding mask.</td>
</tr>
</tbody>
</table>

### Table 15. Predefined Attributes for Alarm Shelving

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shelved</td>
<td>Boolean</td>
<td>Indicates if an alarm is shelved.</td>
</tr>
<tr>
<td>ShelvingMode</td>
<td>String</td>
<td>The type of mode used to shelve the alarm (normal/one-shot).</td>
</tr>
<tr>
<td>ShelvingReason</td>
<td>String</td>
<td>The reason for which the alarm was shelved.</td>
</tr>
<tr>
<td>ShelvingTime</td>
<td>DateTime</td>
<td>The time at which the alarmed was shelved.</td>
</tr>
<tr>
<td>ShelveExpireTime</td>
<td>DateTime</td>
<td>The time at which the alarm will no longer be shelved.</td>
</tr>
</tbody>
</table>
### Table 16. Predefined Attributes for Section Responsibility

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResponsibilitySection</td>
<td>String</td>
<td>The responsibility section to which the object associated with the event belongs.</td>
</tr>
<tr>
<td>ResponsibilityType</td>
<td>String</td>
<td>The type of responsibility to which the alarm belongs (for example, production, and technical).</td>
</tr>
<tr>
<td>ResponsibilityTypeId</td>
<td>String</td>
<td>The identifier of the type of responsibility (GUID) to which the alarm belongs.</td>
</tr>
<tr>
<td>ResponsibleNode</td>
<td>String</td>
<td>The node that is currently responsible for the object (section).</td>
</tr>
<tr>
<td>ResponsibleUser</td>
<td>String</td>
<td>The user who is currently responsible for the object (section).</td>
</tr>
<tr>
<td>ResponsibleUserId</td>
<td>String</td>
<td>The identifier of the user that is currently responsible for the object (section) (GUID).</td>
</tr>
</tbody>
</table>

### Table 17. Predefined Attributes for Alarm Grouping

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupAlarm</td>
<td>Boolean</td>
<td>Identifies whether the alarm is a group alarm or not. The value can be True or False.</td>
</tr>
</tbody>
</table>
### Table 17. Predefined Attributes for Alarm Grouping (Continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupAlarmIds</td>
<td>StringArray</td>
<td>An array of aspect references in the format <code>&lt;GUID&gt;:&lt;GUID&gt;</code>. This identifies the alarm groups in which the alarm condition is included. The presentation of an array in the event details dialog is a comma separated list of entries. The group alarm ID is also set for the group alarm. It is a single element in the array.</td>
</tr>
<tr>
<td>GroupAlarmNames</td>
<td>StringArray</td>
<td>An array of group names for the alarm groups in which the alarm condition is included. The presentation of an array in the event details dialog is a comma separated list of entries. The group alarm name is also set for the group alarm. It is a single element in the array.</td>
</tr>
</tbody>
</table>
## Appendix C  Toolbar in the Workplace

Table 18 describes the details of the toolbar available in the Plant Explorer Workplace and the Operator Workplace.

### Table 18. Available Tools

<table>
<thead>
<tr>
<th>Tools</th>
<th>Plant Explorer Workplace</th>
<th>Operator Workplace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Workplace</td>
<td>Available</td>
<td>Available</td>
<td>To close the workplace. This is generally used when the workplace is in the Operator Mode.</td>
</tr>
<tr>
<td>Find</td>
<td>Available</td>
<td>Available</td>
<td>To find the object or aspect in the workplace.</td>
</tr>
<tr>
<td>Toggle Preview</td>
<td>Available</td>
<td>Not available</td>
<td>To show or hide the aspect preview area.</td>
</tr>
<tr>
<td>QuickFind</td>
<td>Available</td>
<td>Available</td>
<td>To Navigate to the objects of the workplace. This is also used in an Object Shortcut toolbar.</td>
</tr>
<tr>
<td>Filter</td>
<td>Available</td>
<td>Available</td>
<td>To filter the aspects in the Aspect List based on the Filter configuration.</td>
</tr>
<tr>
<td>Replacement Strategy</td>
<td>Available</td>
<td>Available</td>
<td><em>Replace</em> allows the current aspect to be replaced with the newly opened aspect. <em>Preserve</em> allows the aspect to be opened as an overlap, instead of replacing the current aspect.</td>
</tr>
</tbody>
</table>
### Table 18. Available Tools (Continued)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Plant Explorer Workplace</th>
<th>Operator Workplace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Export</td>
<td>Available</td>
<td>Available</td>
<td>To import or export the required aspects and aspect objects to and from the 800xA System.</td>
</tr>
<tr>
<td>Help</td>
<td>Available</td>
<td>Available</td>
<td>To open the online help.</td>
</tr>
<tr>
<td>Current User and LogOver</td>
<td>Available</td>
<td>Available</td>
<td>If you select <em>Enable LogOver</em>, the Change User and Revert User options appear. <em>Change User</em> allows to switch to another user and <em>Revert User</em> allows to revert back to the previous user. <em>Current User Tool</em> displays the current user name. <em>Multiple LogOver</em> can be used with <em>Enable LogOver</em> to log over to another user if the computer is not in an active state for a specific time interval.</td>
</tr>
<tr>
<td>Security Indicator</td>
<td>Available</td>
<td>Available</td>
<td>Indicates if the security is enabled or disabled for the user. The security status is “Disabled” for the administrator user. The security status is “Enabled” for the non-administrator user.</td>
</tr>
<tr>
<td>Print</td>
<td>Available</td>
<td>Available</td>
<td>To print any content.</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Available</td>
<td>Available</td>
<td>Prints the screen of the workplace.</td>
</tr>
<tr>
<td>Toggle Browser</td>
<td>Not available</td>
<td>Available</td>
<td>Used in the Application Bar of the Operator Workplace to open or close the Aspect Browser.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Available (only in Windows mode)</td>
<td>Available (only in Windows mode)</td>
<td>To change the Workplace view from Windows mode to Full Screen mode.</td>
</tr>
</tbody>
</table>
### Table 18. Available Tools (Continued)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Plant Explorer Workplace</th>
<th>Operator Workplace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Shortcut</td>
<td>Available</td>
<td>Available</td>
<td>To quickly access the Graphic Display, Trend Display, and Alarm and Event List aspects of the object specified in QuickFind tool.</td>
</tr>
<tr>
<td>Workplace Clock</td>
<td>Available</td>
<td>Available</td>
<td>To display the current date and time in any configurable format.</td>
</tr>
<tr>
<td>System Events</td>
<td>Available</td>
<td>Available</td>
<td>To display the system event list.</td>
</tr>
<tr>
<td>User Control</td>
<td>Available</td>
<td>Available</td>
<td>To display the user who is currently logged in.</td>
</tr>
<tr>
<td>Toggle Remote Access</td>
<td>Available</td>
<td>Available</td>
<td>Enables or Disables remote access to the workplace.</td>
</tr>
<tr>
<td>Address Field</td>
<td>Available</td>
<td>Available</td>
<td>Helps navigate to an URL on format ao://&quot;object name&quot;:&quot;aspect name&quot; or a native URL for example, <a href="http://www.abb.com">www.abb.com</a>.</td>
</tr>
<tr>
<td>Process Alarm and Event</td>
<td>Available</td>
<td>Available</td>
<td>To display the alarm and event list.</td>
</tr>
<tr>
<td>Logger Manager</td>
<td>Available</td>
<td>Available</td>
<td>Used to launch the 'Alarm Logger Manager' Aspect of the 'Alarm Logger' Service.</td>
</tr>
<tr>
<td>Aspect Menu</td>
<td>Available</td>
<td>Available</td>
<td>To add or configure the favorite aspects for the current user in the Workplace.</td>
</tr>
<tr>
<td>External Alarm</td>
<td>Available</td>
<td>Available</td>
<td>To open the <strong>External Alarm Silence</strong> dialog.</td>
</tr>
<tr>
<td>External Alarm Direct Silence</td>
<td>Available</td>
<td>Available</td>
<td>To silence all external alarms in a single click.</td>
</tr>
<tr>
<td>System Alarm</td>
<td>Available</td>
<td>Available</td>
<td>To display the system alarm list.</td>
</tr>
<tr>
<td>System Status - Service Structure</td>
<td>Available</td>
<td>Available</td>
<td>To open the <strong>System Status</strong> aspect from the <strong>Service Structure</strong>.</td>
</tr>
</tbody>
</table>
### Table 18. Available Tools (Continued)

<table>
<thead>
<tr>
<th>Tools</th>
<th>Plant Explorer Workplace</th>
<th>Operator Workplace</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Status - Control Structure</td>
<td>Available</td>
<td>Available</td>
<td>To open the <strong>System Status</strong> aspect from the <strong>Control Structure</strong>.</td>
</tr>
<tr>
<td>Operator Help</td>
<td>Not Available</td>
<td>Available</td>
<td>To display the online help for the operator.</td>
</tr>
<tr>
<td>Close All Overlaps</td>
<td>Available</td>
<td>Available</td>
<td>To close all aspects opened as overlaps in the Workplace.</td>
</tr>
<tr>
<td>Distributed Engineering</td>
<td>Available</td>
<td>Not Available</td>
<td>To provide a set of Load Evaluate and Go tools, and Engineering Repository tools.</td>
</tr>
<tr>
<td>Audible Alarms</td>
<td>Available</td>
<td>Available</td>
<td>To silence the audible alarms function.</td>
</tr>
<tr>
<td>Primary Target</td>
<td>Not Available</td>
<td>Available</td>
<td>To configure the launch of overlaps to a specific screen in a Multiscreen Workplace.</td>
</tr>
</tbody>
</table>
Revision History

This section provides information on the revision history of this User Manual.

The revision index of this User Manual is not related to the 800xA 6.0 System Revision.

The following table lists the revision history of this User Manual.

<table>
<thead>
<tr>
<th>Revision Index</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Published for 800xA System Version 6.0</td>
<td>December 2014</td>
</tr>
<tr>
<td>C</td>
<td>Published for 800xA System Version 6.0.3</td>
<td>September 2016</td>
</tr>
</tbody>
</table>
Index

A
Alarm and Event List 175
Alarm Response Navigation 189
Alarm Response Navigation-Override Settings 194
Alarm Status Format 185
Application Bar
  Configure 30
  Create 30
  Shortcuts 45
Aspect 260
  Configure 270
  Context Menu 260
  New 268
  Override 270
  Properties 262
Aspect Filter 152
Aspect Type Mapping 192
Aspect View 93
  Configure 93

B
Breadcrumb list 112

C
Color
  Trace 216
Colors tab 212
Column
  Aspect 221
  Extrapolate 225
  Filter 223
  Header Names 177
  High Range 222
  Log Name 221
  Max Value 225
  Mean Value 224
  Min Value 225
  Object Description 220
  Object Icon 220
  Object Name 220
  Order 177
  Pair Property 225
  Property 221
  Ruler Time 224
  Ruler Value 224
  Size 178
  Status 220
  Time Offset 222
  Trace Color 220
  Treatment 224
Column tab 176
Columns tab 218
  Name 219
Configuration
  Application Bar 30
  Workplace Mode 24
Configuring Alarm Response Navigation 189
Context Menu
  Aspect 260
  Object 243
  Submenus 154
  Use 242
Creating Reports 229

D
DataDirect 229
Date Format 185
Default Aspect 142
Display
  Fixed 31
Index

Display Bar
  Display Shortcuts
    Create 48
    Edit/Delete 49
Display Parameters-PG 75
Display Shortcuts in the Display Bar
  Create 48
  Edit/Delete 49

E
EOW System Extension 85
Example Reports 231
Excel Data Access 229
Extended Operator Workplace 83

F
Favorite Aspect 131
Filter 152
Find Tool 270
Fixed Display 31
Format tab 185

G
General List Colors tab 180
Grid Lines
  Major Ticks 212
  Minor Ticks 212
Group Displays 103

H
Hot Keys Aspect
  Changing and Removing 137
  Global Operations 135
  Operations on Highlighted Object 136

I
Implementing Reports 230

J
Layout 176

M
Message Fields 177
Mode of Operation
  Operator 24
  Windows 24
Multiple Monitors
  Configure View Classes 102
Multiple Screens 55
  Large Workplace 64
  Multi-Screen Workplace 56

N
Navigation entries 191
New Aspect pop-up dialog 202
New Object pop-up dialog 199
Node Setup 84
Number of Traces 214

O
Object 243
  Copy 258
  Create 254
  Cut 258
  Delete 259
  Insert 256
  Move 258
  New 254
  Paste 258
Operator Mode 24
Order of Columns 177

P
Panels 42
Plant Explorer Workplace 239
Property Translation 291
  aspect 292
Index

Property Translation Extended  294

Q
Quad Display  106
QuickFind Tool  288

R
Report Building Applications  229

S
Shortcuts in the Application Bar
Create  45
Sort  179
Sort order  179
Startup Display  35
Status Bar
  Configure  35
Status Indication  124

T
Tabbed Workplace  112
TabGrouping aspect  118
Table Font  211
Time Format  185
Time Scope  211
Trace
  Area  216
  Axis  216
Trace Areas
  Count  210
  Sizes  210
Trace Properties  214
Translation  237
Trend Display  197, 201, 225
Trend Display Aspect  202
Trend Template  198

U
User Interface

Context Menu  242
User Interface  271

V
View Class  93
  Link to Aspect Type or Category  96
View Class Mapping  108
View Class Values  97

W
Windows Mode  24
Workplace Configuration for EOW  87

X
XY-Plot  206
  Background Image  208
  End Marker  207